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Topic 1: Reviewing the Spreadsheet 
Topic 2: Formatting and Printing Spreadsheets 
Topic 3: Formula  
Topic 4: Graphical Representation of Data 

 

INTRODUCTION TO UNIT 3 
 

 
Unit 3 is Spreadsheet 2 where you will learn about the basic concepts concerning the 
understanding of what is a computer. The Unit consists of the following Topics: 

 

 

 

 

 

By the end of this Unit you will have gained the skills and proficiency in the use of the 
Spreadsheet programs, able to demonstrate skills and techniques to produce 
Spreadsheet, to be able to design, create and evaluate appropriate Spreadsheet 
solutions to a range of problems and be able to use ethical practices when dealing 
with information and computer technology. 
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CHECK YOUR ANSYOURS AT THE END OF TOPIC 1. 

STUDY GUIDE 
 
Below are steps to guide you in your course of study.  

Step 1: Read each lesson in the Unit Book carefully. In most cases, reading 
through a lesson once is not enough. It helps to read something 
over several times until you understand it. You are not expected to 
memorise the information in the Unit Book. You should use it as a 
reference and to learn from the examples given to illustrate 
important points.  

Step 2: After reading the summary of the lesson, start doing the Practice 
Exercise. You must do only one practice exercise at a time. Then 
mark it according to the following instruction.  

 

 

Step 3: After marking your Answers, go back to the lesson and correct any 
mistakes you may have made. Then move on to the next lesson.  

Step 4: After completing all the Practice Exercises, do Assignment 1. 

Step 5: Now send the completed Assignment booklet to FODE for marking.  

Follow all these steps 1 - 5 when completing all Unit Books.   
Be honest with yourself when you are doing and marking your Practice Exercises as 
well as completing your Assignment Booklets. 

This Unit has a separate assignment booklet for you to use. The information at the end of 
the last lesson in every Topic will let you know what to do with the assignment exercises. 
 
Whenever you need help and advice, contact your tutor or your Provincial Coordinator 
for assistance. If you are in the NCD or Central Province, you are available on Mondays 
to Fridays. You can call in anytime between 8 a.m. and 4 p.m. You would be glad to help 
you. 
 
The following icons are used in each Lesson in this Unit. Icons are the symbols used in 
this book to indicate the parts of your lessons. The following are the meanings of these 
icons. 
 

 

 

 

 

 

You hope you enjoy learning this course. All the best! 
 

Your Tutor 
Information Technology Department 

FODE

 

 -        Lesson Introduction                      -      All other Activities 

 

-        Lesson Objectives            -      Summary 

 -        Reading Activities               -        Additional Information 
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REVIEWING THE SPREADSHEET  
 
 
 
 

LESSON 1: Exploring the Excel Window 

LESSON 2: Moving Around in the Workbook 

LESSON 3: Setting Up Rows and Columns 

LESSON 4: Adding and Deleting Rows and 
Columns 

LESSON 5: Editing Data 
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TOPIC 1: REVIEWING THE SPREADSHEET 

___________________________________________________________________ 

In this topic you will learn about the concepts of a Spreadsheet. The Topic is 
designed to be more familiarised to you about Spreadsheet. It aims for you to gain 
understanding of facts and concepts necessary to have a start in the study of 
Spreadsheet. 

It also provides an overview of the Excel 2010 user interface and covers how to 
perform basic tasks such as creating a new workbook, moving around a worksheet, 
selecting cells, setting up rows and columns, adding and deleting rows and columns, 
entering and editing data, and sorting data. 

In this topic you will study the following: 

Lesson 1 explores the Excel Window. You will learn the definition of Microsoft Excel, 
identify the use of Excel, locate the parts of an Excel window and determine the 
importance of using the Microsoft Excel. 

Lesson 2 is about moving around in the workbook. You will learn the definition of a 
Workbook, identify the parts of the workbook and use certain keys to move around in 
the workbook. 

Lesson 3 is about setting up rows and columns. You will learn the difference of rows 
and columns and identify the steps in setting them up. 

Lesson 4 is about adding and deleting rows and columns. You will learn the steps in 
adding and deleting rows and columns and the importance of adding and deleting 
them. 

Lesson 5 is about editing data. You will learn the definition of editing data; identify 
the steps in editing and changing data and their importance. 

Lesson 6 is about sorting data. You will learn the definition of sorting data, identify 
the steps in sorting data and determine its importance. 
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Lesson 1:   Exploring the Excel Windows 

___________________________________________________________________ 
 

 
 

 
 

 
 
 
 
 
_______________________________________________________________ 

The Microsoft Excel    
The Microsoft Excel is a Spreadsheet Program which is an application program 
commonly used for budgets, forecasting, and other finance-related tasks. In a 
Spreadsheet program, data and formulas to calculate those data are entered into 
ledger like forms (spread sheets or worksheets) for analysis, tracking, planning, or 
―what-if‖ evaluations of the impacts of real or proposed changes on an economic 
strategy. Spreadsheet programs use rows and columns of cells; each cell can hold 
text or numeric data or a formula that uses values in other cells to calculate a desired 
result. Grade 9 Design and Technology Spreadsheet 1 Lesson 1 had mentioned that 
Spreadsheet has a wide range of uses. They can be used as a simple way to store 
numerical data or as an analytical tool making use of complex mathematical 
formulas.  

 

 

          The Excel icon. 

When personal computers first began appearing, one of the first applications was a 
program released in 1979 called VisiCalc. It was used as a tool for performing 
spreadsheet style calculations that would have been difficult to do on a calculator. 
The program quickly became so popular that people began buying personal 
computers for their businesses just so they could use VisiCalc. Since then, many 
other spreadsheet programs have been popular over the years, such as Quattro Pro 
and Lotus 123. Microsoft Excel was first released in 1985 with newer versions being 
released every couple of years. The most recent version is Excel 2010.  

 

 

 

 

Welcome to Lesson 1 of Unit 3. Unit 3 starts with the brief 
history and introduction of Spreadsheet. 
 
In this lesson, you shall learn about the definition and uses of 
Microsoft Excel. 
     Your Aims: 

 define Microsoft Excel 
 identify the uses of Excel 

 identify the parts of an Excel window 

 determine the importance of using the 
Microsoft Excel 
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The VisiCalc. 

It handles much larger sets of numerical data at much greater speeds and has a 
richer set of functions and general calculating and data visualization tools. For 
example, the computer could be told to automatically work out the summary amounts 
such as total, average, minimum and maximum. A spreadsheet program can also 
create graphs and other types of charts, based on information in your tables.  

The Purposes of Spreadsheet 
Spreadsheet has evolved to be very useful to man. Study the following items below 
as these are the different purposes of Spreadsheet. 
 Spreadsheet is to hold and store data. 

 Commonly used in the business and scientific fields, a Spreadsheet can be set 
up in a thousand ways using rows and columns. 

 A Spreadsheet provides structure and organization for data and often makes 
calculations.  

 Anything you might need to graph, since all Spreadsheet have a graphing 
program built into them. 

 Any problem where you need to play with numbers in order to find a solution.  

In some industries, Spreadsheet programs are used heavily in the financial sector 
where keeping track of numerical data is extremely important.  

The Uses of Excel 
In Grade 9 Design and Technology Spreadsheet 1 Lesson 2 had mentioned the uses 
of Excel in businesses and it is for: 

 budget preparation  - using a Spreadsheet to help you plan your budget can 
be useful because it helps with complex calculations and you can see at 
glance the incoming and outgoing. It also means that any changes to figures 
can be automatically updated in calculations by Spreadsheet so that it does all 
the hard work.  
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 working trial balances – the trial balance is a report listing the ending debit and 
credit balances in all accounts at the end of reporting period. 
 

Sample of budget preparation 

Sample of trial balances 
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 business modelling – The primary focus is on using personal computers as 
platforms for asking, combining, and giving information (data, assumptions 
and relationships) to build exploratory models for business problems. 
Thereafter, using the models to drive understanding and consensus towards 
generating possible actions, and the selection of a final course of action and 
the assurance of execution success. 

 
 

 

Samples of a Business Modelling. 

 sales forecasting –  the sales forecasting  in excel is the process of making 
predictions of the future based on past and present data and analysis of 
trends. It uses the method of at least squares to find a line that best fits the 
points.  

                  Sample of sales forecasting. 

Sample of Business Modelling 
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 investment analysis – defined as the process of evaluating an investment for 
profitability and risk, ultimately has the purpose of measuring how the given 
investment is good for a portfolio. 

  Omega ratio is an example of investment analysis. 

 payroll – a list of employees receiving wages or salaries with the amounts due 
to each. 

  
     Sample of payroll. 

 real estate management - there are a lot of Excel users in the property 
management community. An outstanding Spreadsheet program, Excel 
frequently plugs in the gaps commonly found in accounting programs.  
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                                 Sample of real estate management. 

 Taxes - A tax (from the Latin taxo; "rate") is a financial charge or other levy 
imposed upon a taxpayer (an individual or legal entity) by a state or the 
functional equivalent of a state to fund various public expenditures.  

                                            
Using Excel in calculating Tax - Formula 
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                                        Using Excel in calculating Tax – Answer. 

 investment proposals – Investment proposal is a document prepared by the 
sponsor of a new investment project, or of the management of an existing firm, 
for prospective investors and or lenders. It details the 

1. Nature of project or business, 

2. It‘s history (if any), 

3. The growth potential,  

4. Objective and the amount of finance required to realise them, 

5. Promised collateral or security and 

6. A plan for timely repayment of interest and principal.  
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Example of an Invoice. 

 

Now, let us start to identify the parts of an Excel Window: 
 
 
 
 
 

 
 

Spreadsheets are often used for business documents such as invoices where 
numbers and totals are important. A program such as Excel can automatically add up 
totals for a document such as the invoice shown below. A document like this could be 
given a customer to provide details of how much money they owe to the business. 

 

 
The Spreadsheet Contents  
The cells in a Spreadsheet can contain 3 types of information. Excel will treat cells 
differently depending on the cell contents.  
 

• Text – Any names or labels that are required on the spreadsheet  

Active Cell 

Minimize Button 

Maximize 
Button 

Close 
Button 

Sheet Tabs 

Status Bar 

Name Box 

Formula Bar 

Rows 

 

Columns 

 

Scroll Bars 

Quick Access 
Toolbar 

Workbook Window 

Tabs 
Title Bar 

Zoom Slider 

View Shortcuts Toolbar 

Ribbon 

 

The Excel Window. 
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• Number – All numerical values including dates/times, percentages and dollar                  
    values  

• Formula – different mathematical operations are written in a cell to automatically    
   calculate an Answer.  

 
The Spreadsheet Content. 

 

Activity 1:  Define the following words: 

1.  Microsoft Excel 
______________________________________________________________ 

______________________________________________________________ 

2.  Spreadsheet 
______________________________________________________________ 

______________________________________________________________ 

3.  Text 
______________________________________________________________

______________________________________________________________ 

4.  Numbers 
______________________________________________________________

______________________________________________________________ 

5.   Formula 
______________________________________________________________

______________________________________________________________ 

 

 
 

Formula 

Text Numbers 
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Activity 2:  Label the Parts of the Excel Window. 
 

 
 

1. ______________________________________________________________ 
2. ______________________________________________________________ 
3. ______________________________________________________________ 
4. ______________________________________________________________ 
5. ______________________________________________________________ 
6. ______________________________________________________________ 
7. ______________________________________________________________ 
8. ______________________________________________________________ 
9. ______________________________________________________________ 
10. ______________________________________________________________ 
Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your Answers. Make sure you do the necessary corrections before moving on 
to the next part of this lesson. 
___________________________________________________________________ 

 
Summary 
You have come to the end of Lesson 1. In this lesson you learned 
the definition of Microsoft Excel, identified the uses and the parts of 
an Excel Window and the importance of using the Spreadsheet. 

___________________________________________________________________ 
 
  
 

NOW DO PRACTICE EXERCISE 1 ON THE NEXT PAGE. 

 

6 

9 

8 

4 

5 

7 

1 

10

0 

2 

3 



GR10 D & T- COMPUTING U3                                19            TOPIC 1 LESSON 1 
 

Practice Exercise  1 

 

A. Write at least five uses of Excel in Businesses (in any order) 

1.  ______________________________________________________________ 

2.  ______________________________________________________________ 

3.  ______________________________________________________________ 

4.  ______________________________________________________________ 

5.  ______________________________________________________________ 

___________________________________________________________________ 

B. In your own words write four importance of Microsoft Excel. 

1.  ______________________________________________________________ 

______________________________________________________________ 

2.  ______________________________________________________________ 

______________________________________________________________ 

3.  ______________________________________________________________ 

______________________________________________________________ 

4.  ______________________________________________________________ 

______________________________________________________________ 

 
 

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 1. 

Answers to Activities 

 Activity 1 

1.  Microsoft Excel is a program that is used for creating spreadsheets.  

2.  Spreadsheet referred to large sheets of lined paper, which were used by 
people in various businesses to record facts and figures in rows and columns, 
and then make calculations based on the information. 

3.  Text – any names or labels that are required on the spreadsheet.  
     
4. Number – all numerical values including dates/times, percentages and dollar   

values.  
     
5. Formula – formulas are written in a cell to automatically calculate an Answer. 
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Activity 2 

1. title bar 

2. minimize button 

3. maximize button 

4. rows 

5. sheet tabs 

6. workbook window 

7. columns 

8. scroll bar 

9. view shortcuts toolbar 

10. zoom slider 



GR10 D&T- COMPUTING U3                      21       TOPIC 1 LESSON 2 
 

Lesson 2:  Moving Around in the Workbook 

___________________________________________________________________ 

 
 
 
 

 
 

 
 

 

___________________________________________________________________ 

The Excel Workbook 
From your Grade 9 Design and Technology Spreadsheet 1 Lesson 5 had mentioned 
that a blank workbook is displayed when you open a new Excel document and is 
named Book 1. Technically, the workbook looks like a notebook and contains 
sheets, called worksheets. Worksheets contain numerical information presented in 
tabular row and column format with text that labels the data. They can also contain 
graphics and charts. A new workbook contains three worksheets and it can also be 
added. Each sheet has a name displayed on a sheet tab at the bottom of the 
workbook. 

 

  

 

 

 

Welcome to Lesson 2 of Unit 3. In Lesson 1, you learned 
about the definition of Excel and identified its uses and its 
parts and identified its importance. 
 
In this lesson, you shall learn to identify the parts of 
workbook and use of certain keys to move around in the 
workbook. 
 

      Your Aims: 
 define  a workbook 
 identify the parts of the workbook 

 use certain keyboard keys to move in the 
workbook 

 

 

 Title 

A sample of workbook. 

 This workbook contains 
three worksheet and 
worksheet 3 is open 
because it is highlighted. 
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An array of cells is called a sheet or worksheet.The box formed by the intersection of 
a row and a column is called cell. Each cell is identified by its address which consists 
of its column letter and row number (e.g. cell A1 is the cell in the first column and first 
row). A group of cell is called a range. A range is identified by the addresses of the 
cells in the upper-left and lower-right corners of the selected block of cells, separated 
by a colon ( : ) e.g. A1:C10. Only one cell can be active at a time. The active cell has 
a thick black border around it and its address appears in the Name Box on the left 
end of the Formula Bar. 

 
The Active Cell and the Name Box. 

 
The default new workbook in Excel 2010 has three worksheets. You can add more 
worksheets or delete existing worksheets as needed. Each worksheet consists of 
1,048,576 rows (numbered 1 through 1,048,576) and 16,384 columns (labelled A 
through XFD). That means there are well over 17 billion cells in which you can store 
data.  

 
    Active Cell here is XFD1048567.  
 
If you printed out a full spreadsheet on paper and laid it out on the ground, you would 
need an area the size of close to 350 football fields. That should be enough for any 
spreadsheet applications you might have in mind. Usually, you will use the mouse to 
select the cell you want to work in by clicking on the cell, once you have entered data 
into a particular cell.  

 

Name Box 

Active Cell 
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Now, let us recall from our Lesson 1 the parts of a workbook. 
 
 
 
 
 

 
 

The Excel Window. 

The Excel 2010 Window Elements 

 Title Bar – displays the name of the workbook and the program. 

 Minimize Button – to hide the window. 

 Maximize Button – to adjust the size of the window. 

 Close Button – to exit Excel. 

 Quick Access Toolbar – contains frequently used commands that are 
independent of the tab displayed on the Ribbon. 

 Ribbon – contains all the commands related to managing workbooks and 
working with the workbook content. 

 Formula Bar – displays the data or formula stored in the active cell. It can also 
be used to enter or edit a formula, a function, or data in a cell. 

 Name Box – displays the active cell address or the name of the selected cell, 
range, or object. 

 Workbook Window – displays a portion of the worksheet. 

Active Cell 

Minimize Button 

Maximize 
Button 

Close 
Button 

Sheet Tabs 

Status Bar 

Name Box 

Formula Bar 

Rows 

 

Columns 

 

Scroll Bars 

Quick Access 
Toolbar 

Workbook Window 

Tabs 
Title Bar 

Zoom Slider 

View Shortcuts Toolbar 

Ribbon 
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 Sheet Tabs – each tab represents a different worksheet in the workbook. A 
workbook can have any number of sheets, and each sheet has its name 
displayed on its sheet tab. 

 Scroll Bars – used to scroll through the worksheet. 

 Status Bar – displays various messages as well as the status of the Num 
Lock, Caps Lock and Scroll Lock keys on the keyboard. 

 View Shortcuts Toolbar – used to display the worksheet in a variety of views, 
each suited to a specific purpose. 

 Zoom Slider – used to change the magnification of the worksheet. 

Moving around the Worksheet 
There are various ways to navigate a Worksheet. You can use the mouse or 
keyboard, you can move from cell to cell, move up or down a page at a time, or move 
to the first or last used cell in the worksheet. You can also navigate to a specific cell 
in the worksheet by entering its address in the Name Box.  

A. Navigating with the Mouse 
The mouse can be used to change the active cell. If the cell you want to select is not 
visible in the workbook window, you can use the scroll bars to scroll through the 
worksheet in any direction. 

 

 Note: Scrolling with the mouse does not change the location of the active cell. To 
change the active cell, you must click a new cell after scrolling. 
 

The sheet in front of you will be made up of numerous cells. You can select a 
particular cell by clicking on it with your mouse. Each cell is referred to by its column 
letter and then its row number. In the example shown below, the cell in column D and 
row 10 is selected. Follow the steps on how to select a particular cell using the 
mouse. 

This cell would be referred to as cell D10. 
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1.    Click on cell C7. You will see that the column and row headings are both 
highlighted to let you know which cell you have selected.  

2. Look at the area to the left of the Formula Bar. This area is taken up with the 
Name Box (surrounded by a circle in the example below). It shows the 
address of cell(s) that you have selected.  

 

3. You can use the scrollbars to the right and bottom of your Spreadsheet to 
move around. 

 

 
 
Note: The scrollbar will change the part of the sheet that you can see. It will not 
change the part of the sheet you have selected. 
 

  
B. Navigating with the Keyboard  
 Now try these on your keyboard. 

1. Press any of the arrow keys on your keyboard to move one cell in that 
direction.  

2. Hold down the [Ctrl] key and press [Home]. This will move you to cell A1.  

3. Press the down arrow ↓ 5 times and press the right arrow → 3 times. You 
should have cell D6 selected.  

4. Press [Home]. This will move you to column A.  

Drag the Scroll boxes 
to move quickly. 

Click the blank area on the scroll 
bar to move one screen at a time. 

Click the arrows to move 
one row/column at a time. 
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5.       Hold down [Ctrl] and press the down arrow ↓ to move to the last non-empty cell 
in that direction.  

6. Hold down [Ctrl] and press the right arrow → to move to the last non-empty 
cell in that direction. You should now be on cell D103 (if there are no more non 
empty cells in that direction then it will go all the way to the bottom of the 
sheet). 

7. Press [Ctrl] [Home] again and then practice the additional shortcuts listed 
below.  

Useful Shortcuts Keys when moving around the Excel 
Excel offers a number of options or methods to perform a given task. One way to 
speed up certain tasks is to use the Short – cut keys. Short-cut keys are key 
combinations that allow you to quickly execute a task or function, without having to 
use Excel‘s menus or repeat other keystrokes at length. Knowing these keys will 
ensure a more efficient use of the Spreadsheet. Study the following shortcut keys 

Shortcut Icon  Description  

Ctrl O  Open a spreadsheet.  

Ctrl S  Save a spreadsheet.  

Ctrl N  Create a new blank spreadsheet.  

Ctrl X  Cut the selection to the Office Clipboard.  

Ctrl C  Copy the selection to the Office Clipboard.  

Ctrl V  Paste the selection from the Office Clipboard.  

Ctrl P  
Print the current spreadsheet. Note that the icon 
will not give you any printing options. The shortcut 
will.  

F2  Enter edit mode for a cell.  

F4  

Change formula references between absolute, 
relative and mixed references.  
E.g. Absolute - $A$1, Relative A1, Mixed $A1 or 
A$1.  

Merge cells and center text. Useful for table headings. 

Change the cell border. Click the arrow for more border options. 

Change cell background color. Click the arrow for more colors. 

Change cell text color. Click the arrow for more colors. 

Ctrl Enter Fill several cells with what you type.  

Ctrl ; Insert the current date.  

Ctrl Shift ; Insert the current time.  

Editing a cell’s contents 

Select the cell you want to edit and then click in the Excel formula bar. 
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Double click the cell you want to edit. 

Select the cell you want to edit and press F2. 

Format Painter      

The format painter can be used to copy formatting from one part of your 
spreadsheet to another. 
To copy formatting once – click in the cell that has the formatting you want 
to copy. Click the format painter icon. Drag over the cells you want to 
format. 
To copy formatting more than once - click in the cell that has the formatting 
you want to copy. Double-click the format painter icon. Drag over the first 
cells you want to format. Drag over all the other cells you want to format. 
Click the format painter icon to turn it off. 

Page Down Move down one screen 

Page Up     Move up one screen  

Alt Page Down    Move right one screen 

Alt Page Up    Move left one screen 

 

 

Activity 1: Using the pool of words below, fill-in the blanks with the 
  correct word or words. Write your Answers on the space 
  provided. 
 

 
  
  
  
   

 
1.  It is used to exit Excel.     _______________ 

2.  It displays the active cell address or the name of the selected cell, range, or 
 object.        _______________ 

3.  It is used to scroll through the worksheet.  _______________ 

4.  It is used to change the magnification of the worksheet. ______________ 

5.  It is used to hide the window.    _______________ 

6.  It is used to adjust the size of the window.  _______________ 

7.  It displays the name of the workbook and the program.   
         _______________

      Name Box  Close Button 
        Ribbon                       Workbook Window 
        Scroll Bars  View Shortcuts Toolbar 
        Zoom Slider  Title Bar 
       Maximize Button Minimize Button 
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8.       It contains all the commands related to managing workbooks and working  with 
 the workbook content.     _________________ 

9.  It displays a portion of the worksheet.   _________________ 

10.  It is used to display the worksheet in a variety of views, each suited to a 
 specific purpose.      _________________ 

 
Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your Answers. Make sure you do the necessary corrections before moving on 
to the next part of this lesson. 

 
Summary 
You have come to the end of Lesson 2. In this lesson you learned 
the definition of a workbook, identified the parts of a workbook and 
used certain keys to move around the workbook. 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NOW DO PRACTICE EXERCISE 2 ON THE NEXT PAGE. 
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Practice Exercise  2 

___________________________________________________________________ 
 A.  Match the items found under column A with commands in column B. 
 A      B 

1.    ________  a. Format Painter 

2.    ________  b. Insert the current date 

3.    ________  c. Enter edit mode for a cell 

4.    ________  d. Open a Spreadsheet 

5.   ________  e. Insert the current time 

6. Ctrl Shift ; ________  f. Move right one screen 

7. Ctrl ;  ________  g. Print the current Spreadsheet 

8. Ctrl Enter       ________ h. Fill several cells with what you type 

9. F2           ________ i. Save a Spreadsheet 

10. Alt Page Down ________ j.  Create a new blank sheet 

 

B.  Fill-in the correct words. 
1. The default new workbook in Excel 2010 has __________ and can add more 

worksheets or delete existing worksheets as needed.  

2. Each worksheet consists of __________ . 

3.  Each worksheet consists of __________ (labelled A through XDF). 

4.  The box formed by the intersection of a row and a column is called a 
__________. 

5. A __________ is identified by the addresses of the cells in the upper-left and 
lower-right corners of the selected block of cells, separated by a colon (:). 

6. The active cell has a thick black border around it and its address appears in 
the __________ on the left end of the Formula Bar. 

7. The __________ looks like a notebook and contains sheets, called 
worksheets. 
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8.     Worksheets contain numerical information presented in tabular __________ and 
__________ format with text that labels the data. They can also contain 
graphics and charts. 

9. The __________ can be used to copy formatting from one part of your 
spreadsheet to another. 

10. The __________ is used to scroll through the worksheet. 

___________________________________________________________________ 
 

 

Answers to Activity 1 

1. Close Button 

2. Name Box  

3. Scroll Bars 

4. Zoom Slider 

5. Minimize Button 

6. Maximize Button 

7. Title Bar 

8. Ribbon 

9. Workbook Window 

10. View Shortcuts Toolbar 

 

 

 

 

 

 

 

 

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 1. 
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Lesson 3:  Setting Up Rows and Columns 

___________________________________________________________________ 

 
 
 
 

 
 

 
 

 

 
___________________________________________________________________ 

Working with Rows and Columns 
You have learned in the Grade 9 Design and Technology Spreadsheet 1 Lesson 7 
that rows are the horizontal lines of cells that run from side to side and the vertical 
lines of cells that runs up and down are called columns. Each row is numbered 
down the left hand side and to identify the columns. There are letters running along 
the top. Each cell is referenced by intersection of a row and a column so cell A1 is 
the cell at the intersection of column A with row 1.  

   
     Rows and column. 

Although the number of rows and columns in a worksheet is fixed, you can still insert 
rows and columns if you need to make room for additional data, or delete rows and 
columns if the data they contain is no longer needed. These operations do not 
change the total number of rows or columns. You can also change the width of 
columns or the height of rows. The cells group on the Home Tab contains commands 
that can be used to easily insert, delete, or format rows and columns. 

 

 

Welcome to Lesson 3 of Unit 3. In Lesson 2, you learned 
about the definition of a workbook, identified the parts of a 
workbook and manipulated certain keys in Excel. 
 
In this lesson, you shall learn the definition of rows and 
columns and identify the steps in setting up rows and 
columns. 
 

     Your Aims: 
 define rows and columns 
 identify the menu for setting up rows and 

columns 

 draw diagram to illustrate rows and columns 

 set up rows and columns 
 

 

Row  

Columns  

Row  

Columns  Cell Intersection 
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Cells Group on the Home Tab. 

Selecting Rows and Columns 
You must select rows and columns in order to perform operations such as applying 
the same formatting to an entire row or column, changing the height of more than 
one or the width of more than one column at a time, and inserting or deleting rows 
and columns. When a row or column is selected, every cell in the row or column is 
highlighted, except for the active cell. Following are the steps for selecting.  

1. To Select the Entire Worksheet 
Follow this step on how to select a worksheet. 

Click the Select All button or press Ctrl + A. 

 
Row and Column Headers. 

 

 

2. To Select a Single Row or Column 
Follow this step on how to select a column header. 

 Click the row or column header. 

 
Selected Row. 

 

Select All 
button 

Row header 

Column header 
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Selected Column. 

 
3. To Select Multiple Adjacent Rows and Columns 

Follow this step on how to select multiple rows and columns. 

 Drag across the row or column headers or click the header of the first row or 
column you want to select, hold down the Shift key, and then click the header 
of the last row or column you want to select. 

 
After clicking the Row header 

 
After clicking the Column header. 

 
4. To Select Multiple Non-Adjacent Rows or Columns 

Follow this step on how to select a multiple non-adjacent rows or columns. 

 Hold down the Ctrl key, and then click the headers of the rows or columns you 
want to select. 

Changing Column Width 
The default worksheet columns are wide enough to display about eight characters. If 
your data is too long and does not fit in a cell, you can widen the column to display 
the entire contents of the cell. You can also make columns narrower to save 
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worksheet space. The default column width is 8.34 characters. You can specify a 
column width of 0 (zero) to 255 characters. If a column has a width of 0 (zero), then 
the column is hidden. 

 
 

A. To Change the Width of a Column 
Follow these steps on how to change the width of a column. 
1. Position the mouse pointer over the right border of the column header until the 

pointer turns into a two-headed arrow. 

2. Drag the border right to increase or left to decrease the column width. 

 

Note: Double-clicking the right border of a column header sets the column width to the 
widest entry in the column. 

 

 
After adjusting the column width 

 
B. To Set a Specific Column Width 

Follow these steps on how to a specific column width. 

1.  Select the column. 

2. On the Home tab, go to the Cells group. 

3. Click the Format button and select Column Width or right-click the column 
header and select Column Width from the shortcut menu. The Column 
Width dialog box opens. 
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Column Width Dialog Box. 
 

4. Enter a value in the Column width box. 

5. Click the OK button. 

To Change Row Height 
Excel automatically adjusts row heights to accommodate the tallest font in the row. 
You can, however, manually increase or decrease row heights as needed. The 
default row height is 14.25 points. You can specify a row height of 0 (zero) to 409 
points. If a row has a height of 0 (zero), then the row is hidden. 

A. To change the Height of a Row 
 Follow these steps on how to change a specific column width. 
1. Position the mouse pointer over the bottom border of the row header until the 

pointer turns into a two-headed arrow. 

2. Drag the border down to increase or up to decrease the row height. 

1 

2 

3 
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                    Changing Row Height Using the Row Header. 

 

 Note: Double clicking the bottom border of a row header sets the row height to the 
tallest entry in the row. 

 

 
Row Height Dialog Box. 

 
B. To Set a Specific Row Height 

 Follow these steps on how to set a specific row height. 
1. Select the row. 
2. On the Home tab, in the Cells group, click the Format button and select Row 

Height from the shortcut menu. The Row Height dialog box opens. 
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3.  Enter a value in the Row height box. 

4. Click the OK button. 

Re-size several columns at the same time 
Follow these steps on how to resize several columns at the same time. 
1. Select column B through to column F by dragging across the column 

headings.  
 

 
To re-size several columns at the same time. 

 
2. Move your mouse in between columns B to F, wait for the double arrow to 

appear     , drag the mouse to your right or according to the size you want. All 
of the selected columns will have the same width.  

 
To Re-Size Several Rows at the Same Time 
Follow these steps on how to resize several columns at the same time. 
1. Select row 1 to row 6 by dragging the row headings down ward. 

 

Click Row Height. 
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To re-size several rows at the same time. 

 
2. Move your mouse in between rows 1 to 6, wait for the double arrow to appear        

 drag the mouse down ward or according to the size you want. All of the 
selected rows will have the same height.  

 
To Fit a Selection of Cells in Columns 
If you have a heading in the top of the column that is very wide then you may not 
want the whole column to be that wide. You can choose if you want a column width 
to fit a selection of cells instead of the entire column. Follow the steps on how to fit a 
selection of cells in columns. 
 
1. Type and enter My Favorite Hobby in cell A2. 

 
The text in cell A2 is too wide for the normal cell, adjust cell A2 to fit in the text. 

  
2. On the Home tab, in the Cells group, click the Format button and select Auto 

Fit Column Width from the shortcut menu. The Auto Fit Column Width 
dialog box opens. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

                                                      The Auto Fit Column Width. 
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Click the Auto Fit Column Width, cell A1 will adjust according to the length of the 
text. 

 
 
To Fit a Selection of Cells in Rows 
If you have a heading in the side of the row that has larger text size than the standard 
size, then you may change it using the Auto Fit Row Height. Follow these steps on 
how to fit a selection of cells in rows. 
1. Try to re-size the cell A1 from size 12 to size 18.  
 

 
 
2. Click Enter. 
 

 
Activity 1:  Write the steps on how to select rows and columns. 
 
 

1. To select the entire worksheet. 
______________________________________________________________

______________________________________________________________ 

______________________________________________________________

______________________________________________________________ 

2. To select a single row or column. 
______________________________________________________________

______________________________________________________________

______________________________________________________________

______________________________________________________________ 

3. To select multiple rows or columns. 
______________________________________________________________

______________________________________________________________

1 



GR10 D&T- COMPUTING U3                          40         TOPIC 1 LESSON 3 
 

______________________________________________________________

______________________________________________________________ 

4. To select multiple non adjacent rows or columns. 
______________________________________________________________

______________________________________________________________

______________________________________________________________

______________________________________________________________ 

Thank you for completing this activity. Make sure you do the necessary corrections 
before moving on to the next part of this lesson. 
 

                      
SUMMARY 
 
You have come to the end of Lesson 3. In this lesson, you have 
learned the definition of rows and columns, identified the menu for 
setting up rows and columns and to set up rows and columns. 

___________________________________________________________________ 
 
 
 

 
 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

NOW DO PRACTICE EXERCISE 3 ON THE NEXT PAGE. 
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Practice Exercise  3 
 

A. Type the data into your new worksheet and follow the instructions. 
 

 
 
1. Change the column width for cells A3 and A4 from 8.38 (72 pixels) to 13.38 

(112 pixels). 

2. Change the column width for cells C3 and C4 from 8.38 (72 pixels) to 17.25 
(143 pixels). 

3.  Change the row height for cells A3 and C3 from 14.25 (19 pixels) to 21.00 (28 
pixels). 

4. Change the row height for cells A4 and C4 from 14.25 (19 pixels) to 27.75 (37 
pixels). 

 

 
B. Number the correct sequences for changing the column width or row 

height. 
 

 
 

___________________________________________________________________ 
 
 

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 1. 
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Answers to Activity 
 
1. Click the Select All button or press Ctrl + A. 
 
2. Click the row or column header. 
 
3. Drag across the row or column headers or click the header of the first row or 

column you want to select, hold down the Shift key, and then click the header 
of the last row or column you want to select. 

4. Hold down the Ctrl key, and then click the headers of the rows or columns you 
want to select. 
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Lesson 4:  Adding and Deleting Rows and Columns 

___________________________________________________________________ 

 

 
 
 

 
 

 
 

 

  

___________________________________________________________________ 
 
Adding Rows and Columns 
You can insert rows and columns into an existing worksheet to add additional data. 
Rows are inserted above the selected row. Columns are selected to the left of the 
selected column. If you selected multiple rows or columns, Excel inserts the same 
number of rows or columns into the worksheet. 

By adding rows and columns in your worksheet, you can insert data into your 
worksheets. When you need to add a particular information or data into a particular 
worksheet then adding rows and columns is your solution. 

To add a Row 
Follow the steps below in adding a row. 

1. Select the row which you want to insert the new row. 

2. On the Home tab, in the Cells group, click the arrow on the Insert button and 
select Insert Sheet Rows. 

 

 

 

 

 

 
 
 
 

Insert Menu from Home Tab. 
 

 

 

Welcome to Lesson 4 of Unit 3. In Lesson 3, you learned 
about the definition of rows and columns and identified the 
steps in setting up rows and columns. 
 
In this lesson, you shall learn to identify the steps in adding 
and deleting rows and columns and identify the importance of 
adding and deleting rows and columns. 

     Your Aims: 
 identify the steps in adding and deleting rows 

and columns 
 add and delete rows and columns 

 importance of adding and deleting rows and 
columns 

 set up rows and columns 
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Note: You can also right click the row header and select Insert from the Shortcut menu. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Insert Menu. 
 
 
 

 

 
From the Insert shortcut menu. 

 
After clicking the Insert shortcut menu. 

1. Try to type the data into your blank worksheet. 
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2. Position your active cell in A4 and drag your mouse to your right until you are 
at D4. 

 
Row Header. 

3. Right click the row header and select Insert from the shortcut menu. 

4. Select shift cells down to move one step down and click OK. 

 
 
 
 
 
 
 
 
 

The data from cell A4 was moved down to A5. 
 
5.  Try it again to A6, and follow steps 2 to 4. 

 

 
After using the Insert from the shortcut menu a new row was left blank. 

 
To add a column 
Follow the steps below in adding a column. 

1. Select the column to the left of which you want to insert the new column. 

2. On the Home tab, in the Cells group, click the arrow on the Insert button and 
select Insert Sheet Columns. 
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The following steps can also be done. 

Right click the column header and select Insert from the shortcut menu. 

1. Position your active cell to D1 and drag your mouse downward up to D7. 

 

2. Right click the row header and select Insert from the shortcut menu. 

3. Select shift cells right to move one step to the right and click OK. 

 
 
4. If you see this ######## appearing, it means that the data in the cell is more 

than eight characters.  Adjust the cell to your right to show the numbers that 
were written under Profit, since the maximum characters for one cell is eight 
characters. 

 

 
After using the Insert from the shortcut menu and adjusting the cell. 

 
Deleting Rows and Columns 
You can easily delete unwanted rows and columns from the worksheet. Before 
deleting a row or column, you should make sure that it does not contain any data you 
want to keep. 

The beauty of an electronic spreadsheet such as Excel is that, even when you add or 
delete rows or columns, the system automatically updates the formulas where 
appropriate to match the new state of the data. If you make changes like this that you 
want to keep, you must save your work once again.  
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To delete a Row 
Follow the steps below in deleting a row. Using the same Spreadsheet: 

1. Select the row that you want to delete. 

2. On the Home tab, in the Cells group, click the arrow on the Delete button and 
select Delete Sheet Rows. 

 
Delete Menu. 

 

Note: You can also right-click the column header and select Delete from the shortcut 
menu. 

 
To delete a Column 
Follow the steps below in deleting a column. 

1. Select the column that you want to delete. 
 

 
 

2. On the Home tab, in the Cells group, click the arrow on the Delete button and 
select Delete Sheet Rows. 
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To delete sheet rows. 

3. Click the delete sheet rows with your mouse. The cell will move upward. 

 
After clicking the delete sheet rows. 

4. Now, do the same thing with cells A3 and A5, delete the spaces in between, 
and follow steps 2 and 3. 

 
After deleting the spaces in between. 

  Note: You can also right-click the column header and select Delete from the shortcut 
menu. 

 
 
To delete Cells 
Follow the steps below in deleting cells. 

1. Highlight the cells that need to be deleted. 
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2.  Right click the row header and select Delete from the shortcut menu. 

 
Delete from the Shortcut Menu. 

 
3. Select shift cells left to move one step to the right and click OK. 
 

 
 

3 
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After selecting the shift cells left. 
 

4. Save your work with the filename Movie. 
 
 
 

 
Activity 1: Answer the following. 
 

A. Write the steps on how to add row in the Home tab menu. 

1. ___________________________________________________________

___________________________________________________________

________________________________________________________ 

2. ___________________________________________________________

________________________________________________________ 

3. ___________________________________________________________

             __

 _________________________________________________________ 

 
 
B. Write the steps on how to delete column using the Shortcut menu. 

1. ______________________________________________________________

______________________________________________________________ 

2. ______________________________________________________________

______________________________________________________________ 

3. ______________________________________________________________

______________________________________________________________ 

4. ______________________________________________________________

______________________________________________________________ 

Thank you for completing this activity. Make sure you do the necessary corrections 
before moving on to the next part of this lesson. 
___________________________________________________________________ 
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SUMMARY 
 
You have come to the end of Lesson 4. In this lesson, you have 
learned the steps in adding and deleting rows and columns and the 
importance of adding and deleting rows and columns. 

___________________________________________________________________ 
 
 
 NOW DO PRACTICAL EXERCISE 4 ON THE NEXT PAGE 
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Practical Exercise  4 

___________________________________________________________________ 
Type the following data into your blank worksheet and follow the instructions. 
 

 
 

1.  Add cells in between A1 and A2. 

2. Delete cells A3 and A9. 

3. Add cells in between Law and Art. Type the following data. 

 Engineering  6,889     7,001  7,521    6,699      7,001    6,885 

4. Compute for the Total and the Total Graduates. (Please refer to Grade 9 
Design and Technology – Spreadsheet 1 Lesson 13) for your guide in 
computing the Totals. 

5. Save your work with the filename Graduates. 
___________________________________________________________________ 

 
 

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 1. 

 
Answers to Activity 

 
A. 

1. Highlight the cells that you want to add your rows. 

2. Click the Insert button on the Home tab in the Cells group. 

3. Select the Insert Sheet rows. 

B. 

1. Highlight the cells that need to be deleted. 

2. Right click the mouse and choose delete. 

3. Select shift cells left. 

4. Click OK.
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Lesson 5:  Editing Data 

___________________________________________________________________ 
 

 
 
 

 
 

 
 

  

 

 

________________________________________________________________ 
 
Data in a Cell 
Open a new Spreadsheet. Select or go to any cell. You can enter text, numeric data, 
or a formula into the cell. In this practice, you will enter some text and numbers into 
some cells.  

Editing Data in a Cell 
When you want to enter some data in a cell, you simply click on an individual cell and 
started typing. But you cannot edit the data in a cell using that method. If there is 
already something in a cell, and you try to type something else, the old contents 
would be entirely erased. Here are the steps in typing data in a cell. 

 To directly type in values use text and numeric data. 

 To enter Formulas, you can use the formula bar and/or the built-in functions. 

 To format the data in a cell or a group of cells, you can use the functions 
under the Format menu. 

 You can edit and change the data in a cell either directly in the cell or through 
the formula bar. 

 To edit directly in the cell, double click the cell and then edit. 

 To edit using the formula bar, first select that cell and then click the 
formula bar. The data in the cell will be displayed in the formula bar and 
you can edit the data. 

Usually, you will use the mouse to select the cell you want to work in by clicking on 
the cell. Once you have entered data into a particular cell, you can use the 
commands to proceed to other related cells. You can also use the key to select the 
cell. You call this key pressed effect for cell selection commands. 

 

 

Welcome to Lesson 5 of Unit 3. In Lesson 4, you learned 
about adding and deleting rows and columns and the 
importance of adding and deleting them. 
 
In this lesson, you shall learn to define editing data, identify 
the steps in editing and changing data and identify the 
importance of editing data. 
 

     Your Aims: 
 explain what its meant to edit data in Excel. 
 list down the steps in editing data in an Excel 

workbook sheet. 

 edit entered data in cells. 

 discuss the importance of editing data. 
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Cell A1 is the cell’s coordinates of the  active cell. 

Key Pressed Effect for Cell Selection Commands 
The following are the keys used for cell selection commands. 

 Tab moves selection to the right, to the left cell in the same row. 

 Shift-Tab moves selection to the left, to the previous cell in the same row. 

 Arrow keys move selection one cell in any direction. 

 Shift-Enter moves selection up to the previous cell in the same column. 

 Enter  moves selection down to the next cell in the same column. 

 Scroll bars scroll vertically and horizontally through the spreadsheet. 

 Accept button ( ) accepts data in a cell but does not move to another cell. 

 Cancel button ( ) cancels entry in a cell. 

Try out each option now before proceeding.  This will help you follow later directions. 

Practice by moving around the spreadsheet after you have visited several cells, end 
up by clicking on cell A1 to make it the current or active cell. Be sure your 
spreadsheet is open.  

Activity Action 

To select a block of cells Drag from the first cell to the last cell in the 
block  

To select an entire row of cells  
(horizontally from left to right)  

Click on the number (the row label)  on the 
left edge of the Spreadsheet 

To select an entire column of cells 
(vertically, from top to bottom) 

Click in the letter(s) of the alphabet (the 
column label) at the top of the column 

To select several rows Drag the row numbers on the left edge of 
the spreadsheet 

To select several columns Drag across the column labels at the top of 
the columns 

 

 
 

Cell A1 is in column A and in Row 1 
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For example, A1 identifies the cell at the intersection of column A, row 1. Click on 
cell A1 now and look at the cell's coordinates in the top left corner of the 
spreadsheet window.  
 
Location of the Active (Selected) Cell after Entering Data into a Cell 
When you type the data for a cell, the data appears both in the cell you have 
selected and in the Entry bar at the top of the spreadsheet. 

 

 
The Spreadsheet Entry Bar. 

 
See how this works for yourself now. 
 
1. Click on Cell A1 and type the number 1234, then look at the Entry bar above 
 the spreadsheet cells. 

2. The data are again in both places at once, but they are not yet permanently 
accepted into the cell. 

3. The number 1234 awaits your acceptance of it into the spreadsheet. The data 
are displayed in the cell to give you the opportunity to: 

 check that they are correct before accepting them into the active 
(selected) cell; 

 make up your mind whether they should be entered into the spreadsheet 
at all; 

 decide which cell you would like to be the active cell next after the data 
have been copied to the currently active cell. 

Accept the 
data () 

Cancel the 
data ( ) 

As you type data into a cell, the data 
appears both in the cell and in the Entry 
bar. 

Entry Bar 
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You accept the data by either: 

 Moving to another cell in the spreadsheet by clicking on the Enter key or Tab 
key on the keyboard.  

 Or by using the mouse to click on some other cell. 

 Or clicking on the Accept () icon to the left of the Entry bar. 

You may decide not to enter the data into the spreadsheet. In this case, you would 
click on the Cancel box ( ) in the Entry bar and start over. If, on the other hand, the 
data are correct, you would click the Accept button (), which also keeps the cell 
you are working in as the active cell. 
 

 
    The accept and cancel commands. 

4. Click the Accept button () now. 
 
Notice that the number 1234 in cell A1 is immediately right aligned, aligned on the 
right edge of the cell, which is the correct justification for numbers in mathematics.  

Alternatively, you may want to proceed to the cell immediately to the right of the 
active cell into which the number you just typed will go. Or you may want to proceed 
to the cell just below the active cell. 

Blanking out a cell or cells in the spreadsheet 
The quickest way to blank out a selected cell or cells is to hit the Del (delete key) on 
the keyboard. 

To accept 

To cancel 
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Let us try this now. 

1. Using the same spreadsheet. 

2. Type Excel 2010 in cell A1. 

3. Click on the cell holding the data Excel2010 in cell A1and hit the Del (delete 
key) 

Now, cell A1 is empty. The Delete key saves you having to use the mouse and 
menus. 

Undo what you just did by pressing Ctrl-z (to put back Excel2010 in cell A1). 
 
To delete the data in a group of cells, you would drag across the cells to select them 
then they will become highlighted.  

 

 
 

Then you select Clear from the Edit menu or hit the Del (delete key) as before.  
 

 
The Edit Menu. 

 
 
 Note: You can undo the Delete operation (or any other Edit operation) by 

immediately pressing Ctrl-z on the keyboard. 
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Editing the Data in the Entry Bar 
While you are typing in data in the Entry bar, you can edit them as if you are using 
Word.  
 
Editing Data After They Have Been Entered Into a Cell 
If you are past the cell where you have an error and want to make a correction or 
change, move back to the cell in question by selecting (clicking on) it. The data in 
that cell will be displayed in the Entry bar at the top of the spreadsheet. Click in the 
Entry bar (the cursor will show where you clicked on the text) and then just go ahead 
and make any changes you want. Replace the old entry by clicking the Accept button 
() or by selecting another cell in the spreadsheet. 
___________________________________________________________________ 

 
Activity 1: Answer the following questions. 
 
 

A.  Fill in the correct Answers. Choose from the pool of words below. 
 

  

 

1.       Moves selection one cell in any direction.   _______________ 

2. Moves selection in one cell in any direction.   _______________ 

3. Scroll vertically and horizontally through the spreadsheet. ____________ 

4. Accepts data in cell but does not move to another cell. _______________ 

5. Cancels entry in cell.      _______________ 

6. Moves selection to the left, to the previous cell in the same row.  

         _______________ 

7. Moves selection to the right, to the next cell in the same row.   
        _______________ 

8. Moves selection up to the previous cell in the same column.    
        _______________ 

 

B. Write TRUE if the statement is correct and write the CORRECT WORD if 
the statement is false. 
 

1. You can edit and change the data in a cell either directly in the cell or through 
the formula bar. ____________ 

2. To edit using the formula bar, first select that cell and then click the formula 
bar. The data in the cell will be displayed in the formula bar and you can edit 
the data. ____________ 

Tab   Shift-Tab   Arrow keys   Shift-Enter 

Enter   Scroll bars    Accept button  Cancel button 
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3.       To edit directly in the cell, triple click the cell and then edit. ____________ 

4. To edit directly in the cell, double click the cell and then edit. ____________ 

5. Text and numeric data can be entered by directly typing in the values.  
         ____________ 

6. You can enter text, numeric data, or a formula into the cell. ____________ 

7.  You can undo the Delete operation (or any other Edit operation) by 
immediately pressing Ctrl-Y on the keyboard.    ____________ 

8. Moving to another cell in the spreadsheet by clicking on the Caps Lock key or 
Tab key on the keyboard.       ____________ 

9. When you type the data for a cell, the data appear both in the cell you have 
selected and in the Entry bar at the top of the spreadsheet. ____________ 

10. While you are typing in data in the Entry bar, you can edit them as if you are 
using Word.         ____________ 

Thank you for completing this activity. Make sure you do the necessary corrections 
before moving on to the next part of this lesson. 
___________________________________________________________________ 

                               
SUMMARY 
 
You have come to the end of Lesson 5. In this lesson, you have 
learned to edit data in Excel, edit entered data in cells and the 
importance of editing data. 

___________________________________________________________________ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NOW DO PRACTICAL EXERCISE 5 ON THE NEXT PAGE 
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Practical Exercise  5 

___________________________________________________________________ 
Type the following data in your blank worksheet: 
 

 
 

1. Edit September by replacing it with October in cell A5. 

2. Edit October by replacing it with November in cell A6. 

3. Edit November by replacing it with December in cell A7. 

4. Edit Kilograms with Wt. in Kg. in columns B, C, D. 

5. Edit Total for the Month by replacing it with Month‘s Total in column E. 

6.  Arrange the columns by adjusting it according from the given data to fit in the 
cell. 

7.  Finally, edit the title from First Year – Narra Recycling Efforts to Second Year 
– Narra Recycling Effort. 

8. Compute for the Month‘s Total by referring to Grade 9 Design and Technology 
–Spreadsheet 1, Lesson 13 for adding numbers in Excel. 

___________________________________________________________________ 
 

 
CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 1. 

 
Answers to Activity 
 
A. 
1. Arrow Keys 

2. Enter 

3. Scroll Bars 

4. Accept Button 

5. Cancel Button 
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6.        Shift-Tab 

7. Tab 

8. Shift Enter 

B. 

1. TRUE 

2. TRUE 

3. False, double 

4. TRUE 

5. TRUE 

6. TRUE 

7. False, Control-z 

8. False, Enter Key 

9. TRUE 

10. TRUE 
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Lesson 6:  Sorting Data 

___________________________________________________________________ 

 
 
 
 

 
 

 
 

 

_________________________________________________________________ 
  
Sorting Data 
Excel 2010 includes a number of features that can be used to easily sort a 
worksheet. Sorting Data means to arrange data in alphabetical order, to arrange 
data in ascending order or in descending order. By sorting, it enhances the 
appearance of the worksheet and makes it look professional.  
Sort a List Using Toolbar Icons  
Follow the steps below on how to sort a list using toolbar icons. 
 

1. Type the following data into your blank worksheet. 

 
  

2. Save it as Expense. 

This list contains five columns. Each column contains a heading.  

 Excel will assume that the first row in the list contains column headings and 
 will not move them during the sorting process. 

3. In sorting the list, click on a cell inside the column you want to sort by. In this 
instance, you want to sort the list alphabetically. 

4. Click on a cell in column A.  

 

 

Welcome to Lesson 6 of Unit 3. In Lesson 5, you learned 
about editing data, identified the steps in editing and 
changing data and the importance of editing data. 
 
In this lesson, you shall learn to identify the steps in sorting 
data properly and its importance. 
 

     Your Aims: 
 define sorting data 
 identify the steps in sorting data 

 identify the importance of sorting data 
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5. On the Excel standard toolbar, (from the upper right hand corner of your 

screen) there are two icons for sorting a list.  
 

 
 

6. Click the Sort Ascending icon . The list will be sorted in alphabetical 
order on the Item. 

 
 

 
 
7.  The Sort warning will on your screen, select Continue with current selection, 

click Sort. 

Sort Ascending 

Sort Descending 
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8. The Item (Cable) is now in A3. And the data from columns B, C, D did not 
change at all. 

9. Now, try the other sorting by using the descending order.  

 Click the Sort Descending icon to sort the list in the other direction.  

 This time, try the Expand the selection from the Sort Warning. 

 
 
10. Click Sort. 
 

 
 

As you can see, even your $ sign is re arranged when you sort in descending order. 
You can just apply the Copy and Paste commands and refer to the Grade 9 Design 
and Technology – Spreadsheet 1 Lesson 18. 
  

 
 Note: You select Expand the selection when you want to change the data in the 
row of the selected column. Otherwise, you can select the column and sort with 
continue with the current selection command. 
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After arranging it in descending order. 

___________________________________________________________________ 
 
Activity 1: Answer the following. 
 

 
 

 
 

A. Name the following for Sort Menu 
  

1. _______________ 

2. _______________ 

3. _______________ 

4. _______________ 

5. _______________ 

4 

5 

1 

2 

3 
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B. Write the steps in sorting by ascending order using the command 
Expand the selection from the sort warning. 

1.             

2.              

3.             

4.             

Thank you for completing this activity. Make sure you do the necessary corrections 
before moving on to the next part of this lesson. 

___________________________________________________________________ 

                               
SUMMARY 
 
You have come to the end of Lesson 6. In this lesson, you have 
learned to sort data in Excel and the importance of sorting data. 

___________________________________________________________________ 
 
 
 

 
 

NOW DO PRACTICAL EXERCISE 6 ON THE NEXT PAGE 
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Practical Exercise  6 

___________________________________________________________________ 
Type the data into your blank worksheet. 
 

 
 

1. Sort in Ascending Order. Use the whole worksheet from columns A to F.  

2. Compute for the Total. 

3. Write the steps on how to sort it in Ascending Order. 

 ______________________________________________________________

 ______________________________________________________________

 ______________________________________________________________

 ______________________________________________________________

 ______________________________________________________________

 ______________________________________________________________ 

___________________________________________________________________ 
 
 

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 1. 

 
Answers to Activity 

 
A. 
1. Sort A to Z 

2. Sort Z to A 

3. Custom Sort 

4. Sort & Filter 

5. Editing 

 

B. 

1. Open an Existing Spreadsheet 

2. Click the Sort Ascending icon 
to sort the list in the other 
direction.  

3. Click the Expand the selection 
from the Sort Warning. 

4. Click Sort. 
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Answers to Practice Exercise in Topic 1 
___________________________________________________________________ 

Practical Exercise  1 
 
A.  The uses of Microsoft Excel in businesses (any from the nine Answers) 
 

1.  budget preparation 

2. working trial balances 

3.  business modelling 

4.  sales forecasting 

5. investment analysis 

6.  payroll 

7.  real estate management 

8.  taxes 

9.  investment proposals 

B. 

1. It can be used as a simple way to store numerical data or as an analytical tool 
making use of complex mathematical formulas. 

2. It can be used as a tool for performing spreadsheet style calculations that 
would have been difficult to do on a calculator.  

3 It handles much larger sets of numerical data at much greater speeds and has 
a richer set of functions and general calculating and data visualization tools. 

4.  A spreadsheet program can create graphs and other types of charts, based on 
information in your tables.  

 
 
Practical Exercise  2 
A.  Match column A to column B 

1. d   6. e 

2. g   7. b 

3. j   8. h 

4. a   9. c 

5. I   10. F 
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B.  Fill-in the blanks 

1. three worksheets   6. Name Box 

2. 1,048,576 rows   7. Workbook 

3. 16,384 columns   8. row/column 

4. cell     9. Format Painter 

5. range     10. Scroll bar 

Practical Exercise  3 

A. 

 

B. 
 
 

 
 

 

1 2 

3 

4 

1 

2
3 

3
4 

4 

5 
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Practical Exercise   4 

 

 

 
Practice Exercise 5 
 
 

 
 
 

Practice Exercise  6 
1. 

 

 
 
 
3. Steps on how to sort in Ascending Order. 
 
a. Highlight the cells that need to be sort. 
 
b. Click the Edit Menu. 
 

2 
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c.       Choose Sort and Filter and click the drop down arrow. 
 
d. Click Sort A to Z from the Sort and Filter command. 
 
e. Choose either Expand the selection or Choose from the current selection. 
 
f. Click Sort. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

End of Topic 1. 

Now Do Exercise 1 in Assignment Book 1 Then Go to Topic 2. 
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TOPIC 2 
 
 
 
 
 

FORMATTING AND PRINTING SPREADSHEETS 
 
 
 
 
 

LESSON 7: Formatting Font and Alignment 

LESSON 8: Formatting Headers and Footers 

LESSON 9: Formatting Cells 

LESSON 10: Editing Cells 

LESSON 11: Using the Page Set Up Dialogue Box 

LESSON 12: Using the Print Dialogue Box 
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TOPIC 2:  FORMATTING AND PRINTING SPREADSHEETS 
 

In this topic, you will learn about the basic concepts of formatting and printing of 
Spreadsheet. The topic is designed to assist you acquire the necessary skills in 
formatting. Your aim is to gain basic skills that will guide you to make your 
Spreadsheet neater and attractive. 

In this topic, you will study about the following: 

Lesson 7 is all about formatting font and alignment in Spreadsheet. You will identify 
the steps in formatting font and alignment and its importance.  

Lesson 8 focuses on headers and footers. You will identify the steps involved in 
formatting Headers and Footers. 

Lesson 9 focuses on the steps on how to format cells. 

Lesson 10 presents the steps in editing cell data entry. 

Lesson 11 explains the steps in using the Page Set Up dialogue box. 

Lesson 12 highlights on the process of using Print dialogue box. 
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Lesson 7:   Formatting Font and Alignment  
 

Welcome to Lesson 7 of Topic 2. In lesson 6, you learned about 
sorting data, identified the steps in sorting data and its importance. 
 
In this lesson, you will learn how to format font and do alignment   
whilst using MS Excel Spreadsheet.  

     Your Aims: 

 identify the steps in formatting fonts and alignment 

 determine the importance of formatting fonts and 
alignment 

 
Formatting 
Let us define formatting. Formatting a spreadsheet means changing the way it looks 
to make it neater and attractive. Spreadsheets that have not been formatted can be 
difficult to read. Thus, it is important to format as well as to align characters in the 
cell before printing. In Topic 1, you have explored the Excel Window, moved around 
in the Workbook, set up rows and columns, done adding and deleting of rows and 
columns   as well as editing and sorting data into the spreadsheet. You are now 
going to adjust the spreadsheet.  
One way of Formatting is changing the font. You will find the font group in the Home 
tab. There are seven commands found in the font group.  

a. The font style 

b. The font size 

c. The grow and shrink command 

d. The font color 

e. The fill color command 

f. The Bold, Italic and Underline command 

g. The border 

 
 
 
 
 
 

     Seven commands in the font group.    

f 

c 
b 

a 

d 
e g 



GR10 D&T- COMPUTING U3          75         TOPIC 2 LESSON 7   
  

Firstly, type a Weekend budget from cell A1 – E9 before you use the font group.   
The Weekend budget should contain  

1. A title 

2.  Sub – title and 

3.  The list  

 

 
 
 
 

 You are going to use this Weekend budget to format it. 
A. To Change The Font Style 

 To format font style in a spreadsheet, you use the font group in the Home tab 
 of the ribbon.  

1. Select the cells A1 – D1.  

2. While the cells are highlighted, click the drop- down arrow next to the font 
command on the Home tab. The drop- down menu will appear. 

 
         
 
3. Once the drop down menu appears, move your mouse over the various fonts. 

A live preview of the font will appear in the worksheet which will allow you to 
see the changes occurring.  

 

Drop-down arrow 

3 

2 

1 
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4. Looking at the live preview in the window, you may now select the font you 

want to use, for this example, you may select Arial black for the title. If Arial 
Black is your default, then click another font style.  

B. To Change The Font Size 
 To change font size in a spreadsheet, you use the font group in the Home tab 
 of the ribbon. 

1. Select the cells from A1 – D1.  

2. Click the drop- down arrow next to the font size command on the Home tab. 
The drop- down menu will appear. 

 

 

 

 

 

3. Move your mouse over the various font sizes. A live preview of the font will 
appear in the worksheet. 

4. Select the font size 16 for the title. You can also use the Grow Font and 
Shrink Font command to change the size. The Grow font will increase the 
font size and shrink font will decrease size. You may click there to increase or 
decrease font size instead of using the font size. While clicking from the Grow 
and Shrink icon, the changes can be seen in the font size. 

Live preview 

Different font styles to select 

Different font sizes to 
select 
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C. To Change The Font Color 
 To change font color, you use the font group in the Home tab of the ribbon. 
 The font color is the icon beside a spill bucket.  
 
1. Select the cells A3 – E3, which is the sub – title. 

2. Click the drop- down arrow next to the font color command on the Home tab. 
The drop- down menu will appear. 

 
3. Move your mouse over the various font colors. A live preview of the font will 

appear in the worksheet. 
4. Select red as your font color. 
  
D. To Add A Fill Color 
 To fill color, you use the font group in the Home tab of the ribbon. The fill color 
 is the icon with a spill bucket.  
 
1. Select the cells A4 – E7 which is the list. 

2. Click the drop- down arrow next to the fill color command on the Home tab. 
The drop- down menu will appear. 

 
 

The Grow Font and Shrink Font commands 

 

2 

Different font colours to select 
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3. Move your mouse over the various colors. A live preview of the font will 
appear in the worksheet. 

4. Select the color green for the cells 

E.   To Use the Bold, Italic, and Underline Commands 
 Follow the steps below on how to use the Bold, Italic and Underline 
 commands. 
1.  Select the cells D9 – E9. 
2.  Click the Bold (B), to make fonts bolded, click Italic (I), to make text or 
 characters italics or Underline (U) command on the Home tab to underlined 
 fonts. 
 
 
 
 
 
  
3. In this example you are going to perform the three commands to the total. 

Excel will bold, italicize and underline the total. 
 
F. To Add A Border 
 To add a border, you use the font group in the Home tab of the ribbon.   
1. Now, Select the cells from the sub- topic to the total (A3- E9) 

 
2. Click the drop- down arrow next to the Border command on the Home tab. 

The drop- down menu will appear. 
 

 
 
 
 
 

Border Drop- down Menu 

1 
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3. Move your mouse over the various borders. A live preview of the border will 
appear in the worksheet. 

4. Select ‗All Borders‘ from the list. 

 
You have now completed the font group, you will notice that your table now is much 
neater than before.  
 Now, you are going to align the text in the boarded table. 

To Change Horizontal Text Alignment 
To change the alignments, you select from the alignment group in the Home tab of 
the ribbon.  

 
1. Select the cells from C4 – E7. 

2.  Select one of the three horizontal Alignment commands on the Home tab. 

a.  Align Text Left: aligns text to the left of the cell. 
b.  Center: aligns text to the center of the cell. 
c. Align Text Right: aligns text to the right of the cell. 

 
 
 
 
 
 
 
 
You are going to align your figures to the right. By selecting right align; you will notice 
that the figures will move to the right side of the cell.  
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Note: You may practice with left and the center alignment by selecting the figures for cost, 
frequency and total.    

To Change Vertical Text Alignment 
Follow the steps below on how to change vertical text alignment. 
 

 
1. Select the cells you want to change. 

2. Select one of the three vertical Alignment commands on the Home tab. 

a. Top Align: this Aligns text to the top of the cell. 

b.  Middle Align: Aligns text to the middle of the cell. 

c.  Bottom Align: Aligns text to the bottom of the cell. 

Orientation 
The orientation is used to rotate the cells. You can rotate the selected cells to the 
angle that you want. 
Select cells A4 – A7 

1. Go to the            orientation command in the alignment group from Home tab. 

2.  Select the drop –down arrow, a list of angles will appear. 

 

 

 

 

 

 

2 

3 
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3. Select rotate text up from the drop down menu. Using the orientation will 
make your table neater and clearer. 

 
 
 
 
 
 
 
 
 
You can practice the different angles and observe the changes made to the cell.  
Merge and Center  
In this part of alignment you are going to use the cell C1, Saturday Game. This is the 
icon used for Merge and Center. 
 
1. Click the cell C1. 

2. Using the mouse, select the arrow in the merge command. 

3. A drop- down menu will appear.  

4. Select Merge and Center. Notice that the cell will hide behind Weekend 
Game, if the characters are behind the Weekend Budget. Then select the left 
alignment and align it to the left. 

 

 

 

 

 

 

 

 

 

 Your new table should look like this. 

 

4 
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Formatting alignment is important as it bring texts or characters into line. It also 
allows the cells to rotate and unnecessary line to be merged. 
 

 
Activity 1:  Answer the following.             
 
 

A. List the four (4) different kinds of fonts and alignment.   
 
1. Fonts  

          

               

      

      

      

 

 
B. List the different steps involved in formatting font size. 
            

            

            

   ________________     _______________________________ 

Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your answers. Make sure you do the necessary corrections before moving 
onto next part of this lesson. 
  

Summary  
You have come to the end of Lesson 7. In this lesson, you 
learned the importance of formatting and identified the steps 
involved in formatting font and alignment. 
 

 

 
 

2. Alignment  

          

          

          

          

          

 

NOW DO PRACTICE EXERCISE 7 ON THE NEXT PAGE. 
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Practice Exercise  7 
 

Follow the given instruction and format a spreadsheet. 
1. Open a Workbook, and type ―Shopping List‖ in cell A1. 

2. In cell A3 and B3 type in Item and Cost respectively as your Sub- Title.  

3. Then, type in your shopping list. 

4. Go back to cell A1 and do the following:  

a. Change the font style to Monotype Corsiva. 

b. Change the font size to 18,  

c. Modify font color to green. 

5. Select a portion of the items in one cell and make only that part bold. For 
example, if the words ―Hottest pot‖ is in the cell, make only the word ―Hottest‖ 
bold. (Select one word from the cell above). 

 
6. Merge and center the title. 

7. Align the content of all the cost to the right. 

 
 
 
Answers to Activities 
A 
1. Any order of the four below is correct respectively. 

a. Font:  font style, font size, font color, fill color and border 

b. Alignment:   horizontal alignment, vertical alignment, orientation and  

    merging      

B Steps involved in formatting font size. 

1. Using the Font size command: 

a. Select the cells that you want to modify 

b. Move mouse to the font size drop- down arrow in the font group of the 
Home tab 

c. Select the size that you want from the drop – down menu 

CHECK YOUR WORK. ANSYOURS ARE AT THE END OF TOPIC 2. 
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Another way is to use the Grow and Shrink font command  
a. Select cell 
b. Click Grow command to increase font and Shrink to reduce font size  
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Lesson 8:   Formatting Headers and Footers 
 

Welcome to Lesson 8. In lesson 7, you learned the steps in 
formatting fonts and alignment its importance. 
 
In this lesson, you will learn to format Headers and Footers whilst 
using MS Excel Spreadsheet.  

 
       
 
 
 
 

Headers and Footers 
Headers and footers are commonly used for inserting information such as page 
numbers, date, or title. Before you begin, decide if you want the information in the 
Header or Footer. Header means that the information will appear in every page at 
the top. Footer means that the information will appear at the bottom of every page.  

Create Headers and Footers 
Follow the steps below to create headers and footers. 
 
1. Choose the insert tab. 
 
 
 
 
 
Click the header and footer in the Text group. Your worksheet changes to page 
layout view and the design context tab appears. Note that your cursor is located in 
the center section of the header area.  

2. From the Headers and Footers tools in the design, select the command, go to 
Header. Here you are going to use the Header but you can select Footer and 
follow the same procedures. 

 

Your Aims: 

 identify the steps in formatting Headers and 
Footers. 

 determine the importance of formatting Headers 
and Footers. 

2 
1 

5 3 
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3. Click the right side of the Header area. 

4. Click Page number in the Header and Footer Elements group. The page 
number will appear in the right side of the header area. 

5. Click the left side of the header area. 

6. Type your name. Your name will appear on the right side of the header area.  

              Header and Footer area.  

Note: When you print, your name and page number will appear at the top of every 
page with page number on the top right corner and your name on the top left corner. 
You may select other commands such as number of pages, date, time, file path or file 
name in the Header and Footer Element group to include into the Header area 
instead of name and page number. 

 
Return to Normal View 
Follow the steps below to return to the normal view: 

1. Click outside of the header area. 

2. Choose the view. 

3. Click the normal button in the Workbook View group.  

Headers and Footers are important when you want to add page numbers, titles 
location or author to the Workbook that you create.  

 

 

 

 

Footer area 

Header area 
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Activity 1:  State the main difference between the Header and the 
Footer commands.         
 

            

             

             

Thank you for completing this activity. Now, you may go to the end of this lesson to 

check your Answers. Make sure you do the necessary corrections before moving 

onto next part of this lesson. 

 

Summary  
You have come to the end of Lesson 8. In this lesson, you learned the 
steps involved in formatting headers and footers as well as the 
importance of using these commands. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NOW DO PRACTICE EXERCISE 8 ON THE NEXT PAGE. 
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Practice Exercise  8 
 

List down the steps involved in formatting headers & footers. Begin with confidential 
in the right side, date in the center and pages in the left side of the footer area. 
            

            

            

            

            

     _______________________________________ 

 

 
 

 

Answers to Activity 1 
The main difference between Headers and Footers; 

When creating Headers and Footers; Headers are located at the top of the page and 
footers are located at the bottom of the page in the Workbook.   

CHECK YOUR WORK. ANSYOURS ARE AT THE END OF TOPIC 2. 
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Note: Remember: the cells are identified with letters for columns and numbers for the rows.    

 

Lesson 9:   Formatting Cells 
  

Welcome to Lesson 9. In lesson 8, you learned the steps in formatting 
Headers and Footers and its importance. 

In this lesson, you will learn to format cells whilst using MS Excel 
Spreadsheet.  

         Your Aims: 
 
 
 

Formatting Cells 
There are a lot of ways that you can format cells. Here in this lesson you are going to 
look at three commands in the cell group, the two commands had been discussed in 
Topic 1 when you want to add and delete Rows and Columns. In this lesson you are 
going to format the cells thus the third command in the cell group will be our focus. 
Formatting cells depend on how you want our cells to look like. You will look at the 
steps involved in formatting the cell size, visibility, organizing sheet and 
protection. These are commands found in the format.  

Formatting the cell size  
Follow the steps below on how to format cell size. 

1. Select the cell you want to modify. 

2. Choose Home Tab. 

3. Click the arrow next to format in the cell group, a drop – down menu will 
appear. 

 

 

 

 

 

 

 
4. Click the Row Height, type in 25 in the pop up dialogue box. 

5. Click OK, notice that row 1 will increase in height to 25.  

 identify the steps in formatting cells 

 determine the importance of formatting cells 

 

 

3 
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6. Repeat steps 1 -3, then select column width from the drop- down menu 

7. Type in 45 in the Column width field from the dialogue box 

8. Click OK. Column A is set to width 45. These actions will allow you to see all 
the text when you type in cell A1. 

9. If you want to go back to the original width and height of the cell: 

a. Select cell that you want to change back to original. 

b. Go to Format in the cell group in the Home tab. 

c. Click the drop down arrow next to word format. 

d. Select AutoFit Row Height and AutoFit Column Width in the cell 
size command. 

e. Notice that the cell will return to original size. 

 
 
 
 
 
 
Hide Cells  
Follow the steps below to hide cells. 
 
1. To hide cell A1, go to the cell group in the Home tab. 

2. Select the drop down arrow from the Format. 

 

 

 

 

 

3. Move mouse to the Visibility. 

4. Click hide & unhide, a pop - up menu will appear. 

5. Click Hide Rows to hide row. 

 

2 
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6. Notice that the row 1 will hide.  

Note: If you click Hide column in Step 5, Column A will hide. Hide cell is not deleted. The 
cell content and the cell are hidden. This command is important when it comes to Printing, 
especially when you do not want to print cell content or discuss it, you can hide the cell.      

 

Organizing Sheet 
Here you are going to organize the spreadsheet by naming the sheet, move or copy 
the sheet and tab color.  
A. Rename the sheet 
 Follow the steps below to rename sheets. 
 
1. To rename Sheet1, go to the cell group in the Home tab. 

 

2. Select the drop down arrow from the Format. 

3. Move mouse to the Organize Sheet. 

4. Select Rename, Sheet 1 will be highlighted. 

5. Type ‗Practice’ in place of Sheet1. 
 
 
 
 
 
 
 

5 
4 
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B. Copy Sheet 
Before you move or make a copy of the spreadsheet, decide carefully the 
location so you know where to find your spreadsheet. In this example, you are 
going to make a copy of sheet1 and place it between sheet2 and sheet3 

1. To make a copy of Sheet1, go to the cell group in the Home tab. 

2. Select the drop down arrow from the Format. 

3. Move mouse to the Organize Sheet. 

4. Select Move or Copy Sheet command. 
 
 
 
 
 
 
 
 
 
5. A dialogue box will appear. 
6.  Book1 is the workbook you are in and sheet1 is the spreadsheet you are 

working in. 
 
 
 
 
 
 
 
7. Select Sheet3, under Before Sheet command. 

8. Then move mouse to ‗create a copy‘ and click it the square. 

 
 
 
 

3 
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9. Click OK. 

10. Notice the difference below from the action taken. You have made a copy and 
move Sheet1 to be between Sheet2 and Sheet3. The new sheet is known as 
Sheet1 (2).  

 
 

Before       After 
C. Worksheet Color Tab 
 Tab color will color the spreadsheet Tab. Since you had renamed and make a 
 copy of spreadsheet, you will now color the copied spreadsheet. 

1. To color Sheet1, go to the cell group in the Home tab. 

2. Select the drop down arrow from the Format. 

3. Move mouse to the Organize Sheet. 

4. Select Tab Color command. A drop down menu will appear. 

 

 

 

 

 

 

 
5. Select Green, to color tab. Notice that the tab will be in green color. 
 

          Tabs  
 
 

 
 
          
 
 
 
 

4 
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Cell Protection 
Security is vital for information protection. When working with data, you also have to 
think about protecting the data or file from other people to see. In Microsoft Excel 
there is a way of protecting it. The steps are: 

1. When finished typing click MS Office button.  

2. Scroll down Save As and left click mouse. This generates Save As window. 

3.  Click on Tools on the bottom left of the Save As Window. 

4. On the drop- down window click on General option. 

 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

5. A security dialogue box will appear. 

6. Type in password in Password to open. 

7. Type in Password to modify. 

8. Click OK. 

9. Confirm Password to open. 

10. Confirm Password to modify. 

2 

3 

4 

5 
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A password is case sensitive. If the password Typed is in Upper case, then you have 
to type exactly that when opening the file. A password can be all letters, all numbers 
or a mixture of both.  
 
 
 
 
 
 
 
Another way of Protecting Excel Workbook is to use the ‘Protection’ command in 
the cell group under the format drop down menu.  
Follow these steps: 
1. Go to format in the cell group from Home tab. 

2. Click the drop-down arrow beside Format. 

3. Move mouse to the protect sheet under Protection.  

 

 

 

 

 

 

 

 

 

 

4. A pop up dialogue box will appear.  

5. Type the Password then click OK. 

6. Another pop up dialogue box will appear to confirm password. 

7. Retype password to confirm password. 

8. Click OK. 

4 

5 

7 

8 



GR10 D&T-COMPUTING U3  96         TOPIC 2 LESSON 9   
  

There are many ways you can format cells depending on how you want your cells to 
look like. Here in this lesson, you have looked at the steps involved in formatting the 
cell size, visibility, organizing sheet and protection. Using these commands, you 
are able to hide cells that you do not want to use, rename sheet and even protect the 
worksheet so that others cannot have access to.  
 

 
Activity 1:  List the steps involved in format command to format a  

    worksheet. 
  

1. To increase the row height of D2 to 35 
___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________ 

2. To Hide column E 
___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________ 

3. To rename sheet3 as Accounts 

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________ 

Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your answers. Make sure you do the necessary corrections before moving 
onto next part of this lesson. 
 

Summary  
You have come to the end of Lesson 9. In this lesson, you learned the 
steps involve in formatting cells as well as the importance of using these 
commands. 

 

 
NOW DO PRACTICE EXERCISE 9 ON THE NEXT PAGE. 
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Practice Exercise  9 
 
A. Write letter of instruction next to the Commands. 
 
A (Instruction)      B (Command) 

a. Move a worksheet    Format      
  

b. Change the name of a worksheet  Confirm Password  
  

c. Delete a worksheet    Protect sheet       

  

d. Select from format in the cell group        Move or Copy sheet      

 
e. Enter password to unprotect sheet Delete       

  

f. Format cell     Rename       
  

g. Retype Password    Drop down Arrow      
  

   

B. Organize a new Workbook. Re-arrange the jumbled steps in their correct 
order.  

Color each tab with different red from dark to light color  

Hide the original sheet2     

Make a copy of sheet2 next to itself  

Open up a new Microsoft Excel  

Rename sheet1 as Business  

Rename sheet2 as Family   

Rename sheet3 as Personal  

 

 
 

CHECK YOUR WORK. ANSYOURS ARE AT THE END OF TOPIC 2. 
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Answers to Activity 1 
A. To increase the row height of D2 to 35 

1. Bring cursor to column D, row 2 

2. Go to cell group in the Home Tab 

3. Select the drop- down arrow next to Format in the cell group 

4. Scroll to row height and click 

5. Type in 35 the dialogue box 

6. Click OK  

B. To Hide column E 

a. To hide column E, take cursor to column E 

b. Go to cell group in the Home Tab 

c. Select the drop- down arrow next to Format in the cell group 

d. Scroll to hide and unhide command, a drop- down menu will appear 

e. Select hide column 

f. Column E will not appear on the Worksheet 

C. To rename sheet3 as Accounts  

a. To rename sheet3, take cursor to sheet3 

b. Go to cell group in the Home Tab 

c. Select the drop- down arrow next to Format in the cell group 

d. Scroll to rename sheet and click the command 

e. Sheet3 will be highlighted by a black box 

f. Type Accounts  

g. Click anywhere outside the sheet had been renamed 
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Lesson 10:  Editing Cells  
 

Welcome to Lesson 10. In Lesson 9, you had done formatting 
using the format in the cell group.  
In Lesson 10, you are going to do formatting but this time 
manipulating the data. You will learn to format cells using the edit 
group in the Home Tab whilst using MS Excel Spreadsheet.  

                  Your Aim: 

   identify the steps in editing cell data entry 
 

 
Editing Cells 
Excel has a lot of features that make it perfect for working with large lists and 
manipulating columns of data. Using Excel, you can sort lists, filter lists and subtotal 
lists. You can also import lists from other sources and have the information 
converted in to Excel rows and columns. Here you will work with the editing group in 
the Home Tab. 

AutoSum 
Auto Sum is one of the editing commands that are used to do calculations in Excel. It 
contains the predefined formulas or functions that perform calculations using specific 
values in a particular order. Let us begin with these statistical functions: 

Sum  summation adds a range of cells together 

Average  average calculates the average of a range of cells 

Count  counts the number of chosen data in a range of cells 

Max   identifies the largest number in a range of cells 

Min  identifies the smallest number in a range of cells 

These Functions appear in the AutoSum command. (It is found on the Home and 
Formulas tabs).  

 

To begin, you must open an existing Workbook or type in some data into the 
Workbook. You may use the example. Here in the example you are going to use the 
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Grade 10 marks of a Computer Studies class to work out the year total, class 
average, the high and the low scores. See table below; 

 
A. To Calculate the sum of a range of Data Using AutoSum 
 Since the Sum function is used so often, this special tool has been provided to 
 make it easy to use.  

1.  Click in cell F6.  

2.  Click the AutoSum icon on the Ribbon bar.  

 

 

 

 

 Excel will create a Sum function referring to the cells left. Excel will assume 
 the cells on left are the ones to be added together. These cells will remain 
 selected in case you would rather select a different group of cells. Otherwise 
 the nearest group of cells will be selected.  
3. Press [Enter] to confirm that the correct cells are selected and complete the 

function.  
 This formula, =SUM(E2:E8) is called a function.   
 
 
 
 
 
 
 
 

 You can also use the AutoSum tool by selecting the cells to be added first.  

2 



GR10 D&T-COMPUTING U3  101          TOPIC 2 LESSON 10   
  

Select cells B6 to E6.  

5.  Click the AutoSum icon.  

 A Sum function will be automatically created based on the cells you selected.  

B. To Calculate the Average of a Range of Data 
 The AutoSum icon can also be used to create other common functions such 
 as Average and Count.  
1. Click in cell B13 from the example. 

2. Click the arrow next to the AutoSum icon. 

3. A list of common functions will be displayed.  

4. Click on Average. 

 
 
 
 
 
 An Average function will be created in the selected cell. Notice that it is written 
 the same as a Sum function.  

5. Check that the function reads =AVERAGE(B6:B12)  

 Press [Enter] to complete the function.  

6. Save the changes to the workbook and then close it.  

 
 
 
 
 
 
 
 
 
 
 
 
 

3 
4 
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Note:  You can also find the maximum value, the minimum value and 
count numbers in a spreadsheet using the AutoSum. The AutoSum will 
give us specific Function to the command that you select. 

C. To Access Other Functions in Excel 

1. Select a cell range to be included in the formula, for example A3 

2. On the Edit group click the drop-down part of AutoSum icon 

3. Move the mouse to the more function, the last option from the list 

4. The Insert Function dialogue box opens 

5. There are three ways to locate a function in the Insert Function dialogue box 

6. You can type a question in the Search for a function box and click GO, or  

7. You can scroll through the alphabetical list of functions in the Select a 
Function field or 

You can select a function category in the Select a category drop-down list and 
review the corresponding function names in the Select a Function field. Select the 
function you want to use and then click the OK button. 

Sorting  
Sorting lists is a common spreadsheet task that allows you to easily reorder your 
data. The most common type of sorting is alphabetical ordering, which you can do 
descending or ascending order.  
In this example you are going to sort the previous example, Grade 10 Computer 
Studies Marks. 
A. To Sort in Alphabetical Order 
 Follow the steps below on how to sort in an alphabetical order. 

1. Select a cell in the column you want to sort (here you are going to choose 
column A6 – E12, from your previous example) 

2. Click the Sort & Filter command in the editing group on the Home Tab. 
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3. Select Sort A – Z, from the drop – down menu. 
4. Now, the information in the Category column is organized in alphabetical 

order. (From Ben to Kate) 
 
 
 
 
 
 
 
 
 
 
 

. i 

2 

3 

1 
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Note: If Excel cannot determine the range of your table, you may need to select it first and 
then press [Tab] until a cell in the sorting column is highlighted.  

 

B. To Sort from Smallest to Largest 
 Follow the steps below on how to sort from smallest to largest. 

1. Select a cell in the column you want to sort (here you are going to choose 
column F6 – F12). 

2. Click the Sort & Filter command in the editing group on the Home Tab. 

3. Select Sort from Smallest to Largest, in the drop – down menu. 

 
Filtering Cells 
Filtering, or temporarily hiding, data in a spreadsheet, allows you to focus on specific 
spreadsheet entries. Follow the steps below to filter data. 

1. Select the Sort & Filter command on the Home Tab in the Editing group. 
Click on the arrow beside the Sort & Filter command, a drop down menu will 
appear. 

2. Move mouse to Filter command.  

 
 
 
 
 
 

 

2 

3 

1 



GR10 D&T-COMPUTING U3  105          TOPIC 2 LESSON 10   
  

3. Select the command: Notice that drop- down arrow will appear besides each 
column heading. (In this example, you are going to use the Computer Studies 
marks.) 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

4. Click the drop- down arrow next to Term 1.    

5. Uncheck Select All.     

6. Now click 7 and 8 under Select All. 

7. Then click OK command. 

 
 
 
 
 
 
 
 
 

3 
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8. Notice that Chris‘ marks and the Lowest and number of students will appear. 
 
 
 
 
 
 
 

To Clear One Filter 
Follow the steps below on how to clear one filter. 
 
1. Select the drop down arrow next to Term 1 column. 

2. Choose Clear Filter From Term1. 

 

 

 

 

 

3. Clicking the command will remove all Filter. 

 
 
 
 
 
 
 
 
 
 
 
Find and Select Data 
Follow the steps below on how to find and select data. 
 
1. Click the Find & Select button on the Editing group of the Home Tab. 

1 

2 
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2. Click Find command. 

 
 
 
 
 
 
 
 
 
 
 
 
3. A dialogue box will pop up. 
 
 
 
 
 
 
4. Type in name of cell you want to Find. 

5. Click Find All and the command will give you reference. 
 
 
 
 
 
 
 
 
 
By sorting and filtering information in a worksheet, you can find values quickly. You 
can sort and filter on one or more columns of data. With filtering, you can control not 
only what you want to see, but what you want to exclude. You can filter based on 
choices you make from a list, or you can create specific filters to focus on exactly the 
data that you want to see. 

2 
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You can search for text and numbers when you filter by using the Search box in the 
filter interface. 

When you filter data, entire rows are hidden if values in one or more columns don't 
meet the filtering criteria. You can filter on numeric or text values, or filter by color for 
cells that have color formatting applied to their background or text. 

   

Activity 1:   Answer the following. 
 
 

A. Give the main features of the following commands in the editing group. 
1. Sorting           
             

2. Filtering 

             

 

 
B. List the steps involved in Sorting out data from smallest to largest           
 values. 
___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________ 

Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your answers. Make sure you do the necessary corrections before moving 
onto next part of this lesson. 
 

Summary  
You have come to the end of Lesson 10. In this lesson, you learned the 
steps involve in editing cells as well as the importance of using these 
commands. 

 
NOW DO PRACTICE EXERCISE 10 ON THE NEXT PAGE. 

 



GR10 D&T-COMPUTING U3  109         TOPIC 2 LESSON 10   
  

Practice Exercise  10  

 

A. Filtering cells. Re-arranged the jumbled steps to its correct order. 
Uncheck Select All 

Then click OK command. 

Then click the appropriated number under Select All. 

 Select the Sort and Filter command. 

Select the command Filter. 

Open an existing Workbook. 

Move mouse to the Filter command. 

Click the drop down arrow next to the column you want to filter. 

 
 
Answers to Activity 1 
A. 
1. Sorting is a spreadsheet task that allows you to easily reorder your data. 
 2. Filtering, or temporarily hiding, data in a spreadsheet, allows you to focus on 
 specific spreadsheet entries. 
B.  

a) Select a cell in the column you want to sort  
b) Click the Sort & Filter command in the editing group on the Home Tab 
c) Select Sort from Smallest to Largest, in the drop – down menu

CHECK YOUR WORK. ANSYOURS ARE AT THE END OF TOPIC 2. 
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Lesson 11:  Using the Page Setup Dialogue Box 

  

Welcome to Lesson 11 of Topic 2.  In Lesson 10, you learned the 
steps in editing data entry and formatted cells using edit group in the 
Home Tab whist using Excel Spreadsheet.  
In this lesson, you will learn to use the Page Setup dialogue Box. 

                 Your Aims: 
 
 
 
 

Using the Page Set Up Dialogue Box  
The page setup box is found in the Page Layout Tab. There are four (4) Tabs in the 
Page Setup box (page, margin, Header/Footer and Sheet). You are going to look at 
each one of them in relation to setting up the page of a Worksheet. You may find 
some of their commands in the Print Preview. For the purpose of this lesson, you are 
going to focus on the Page Setup group.  
To locate the page setup dialogue box, follow the steps below. 

1. Go to the Page Layout Tab. 

2. Select the arrow next to the Page Setup group. 

   
  
 
 
 
 
 

 identify the steps involved in using the page Set up 
dialogue box. 

 determine the importance of page set up dialogue 
box. 

 

2 
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Page setup is important as it prepares the worksheet for printing. 
A. To Modify the Page  
To Change Page Orientation 
Change the page orientation to Portrait to orient the page vertically or Landscape to 
orient the page horizontally. Portrait is useful for worksheets needing to fit more 
rows on one page, and Landscape is useful for worksheets needing to fit more 
columns on one page. 
1. Go to the Page Layout Tab. 

2. Select the arrow next to the page setup group 

3. In the Page Setup Dialogue Box, select the Page Tab. 

4. From Orientation, you can select Portrait to orient the page vertically, while 
Landscape orients the page horizontally.   

To Use Scale to Fit 
Follow the steps below on how to use scale to fit. 
 
1. Go to the Page Layout Tab. 

2. Select the arrow next to the Page Setup group. 

3. In the Page Setup Dialogue Box, select the Page Tab. 

4. Use the percentage field to decrease the spreadsheet by a specific 
percentage. 

5. Select Fit to 1 Page to have the worksheet on one page. 

 Scale to fit is a useful feature that can help you format spreadsheets to 
 fit on a page. Be careful with how small you scale the information – it 
 can become difficult to read. 

To Change the Paper Size 
Follow the steps below on how to use scale to fit. 
 
1. Go to the Page Layout Tab. 

2. Select the arrow next to the Page Setup group. 

3. In the Page Setup Dialogue Box, select the Page Tab. 
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                  Page Setup Dialogue Box. 

4. Select a size option from the drop down arrow list. 

A. To Modify Page Margin 
 The margins of your worksheet may need to be adjusted to make data fit 
 more comfortably on the printed page. Follow the steps below to adjust the 
 margins. 

1. Go to the Page Layout Tab. 

2. Select the arrow next to the Page Setup group. 
3. In the Page Setup Dialogue Box, select the Margin Tab. 

3 
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4. You can adjust the margins by typing in the size that you want.  

B. To Modify the Header/ Footer 
 Follow the steps below on how to modify the header or footer. 
 
1. Go to the Page Layout Tab. 

2. Select the arrow next to the Page Setup group. 

3. In the Page Setup Dialogue Box, select Header/Footer Tab. 

4. Select either Header or Footer drop - down arrow and select or type in your 
option. 

 
 

 
C.  
D.  

2.  
A.  

D. To Modify Sheet  
 Modifying the sheet can be done in many ways to ensure the proper 
 presentation of the Excel Sheet.  
To Define a Print Area 
Follow the steps below on how to define a print area. 

1. Go to the Page Layout Tab. 

2. Select the arrow next to the Page Setup group. 

3. In the Page Setup Dialogue Box, select Sheet Tab. 

4. Left – click and drag your mouse to select the cells you wish to print. 

5. Now, only the selected area will be printed. You can confirm this by viewing 
the spreadsheet in the Print Preview. 

 
 
 
 

Selecting the cells will 
appear in the print area.  
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6. To return to the default setting, which is the entire worksheet, click the Print 
Area command and select Clear Print Area. 

To use Print Titles Command 
Imagine how difficult it would be to read a worksheet if the column and row headings 
only appeared on the first page. The Print Titles command allows you to select 
specific rows and columns to appear on each page. Follow the steps below on how 
to use the Print Tiles command. 

1.  Click the Page Layout tab. 

2.  Select the Print Titles command. 

 
 
 
 
 
3.  The Page Setup dialog box appears. Click the icon at the end of the Rows to 
 repeat at top field. 
4.  Your mouse becomes the small selection arrow. Click on the rows you want 
 to appear on each printed page. The Rows to repeat at top dialog box will 
 record your selection. 

 

 

 

 

 

 

 
 

 

5.  Click the icon at the end of the Rows to repeat at top field. 

6.  Repeat for Columns to repeat at left, if necessary. 

7.  Click OK. You can go to Print Preview to see how each page will look when 
 printed. 

 
 

2 
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Activity 1:   List the needed steps below. 
 
1. Change the page orientation from Portrait to Landscape. 

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________ 

Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your answers. Make sure you do the necessary corrections before moving 
onto next part of this lesson. 
 

Summary  
You have come to the end of Lesson 11. In this lesson, you learned the 
steps involved in Page Setup Dialogue Box as well as the importance of 
using these commands. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NOW DO PRACTICE EXERCISE 11 ON THE NEXT PAGE. 
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Practice Exercise  11 
 

Using the example from the Computer Studies Students marks, identify the 
steps you are going to apply Print Titles command to make row 1 and column 
A appear on every page. 
            

            

            

            

            

            

            

            

            

            

            

            

            

            

             

 

 
 
 
Answers to Activity 1 
1. To change the page orientation to Landscape. 

a. Go to the Page Layout Tab 

b. Select the arrow next to the page setup group 

c. In the Page Setup Dialogue Box, select the Page Tab 

d. From orientation select Landscape 

e. The page will orient horizontally.   

CHECK YOUR WORK. ANSYOURS ARE AT THE END OF TOPIC 2. 
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Lesson 12:  Using the Print Dialogue Box 
  

Welcome to Lesson 12 of Topic 2. In Lesson 11 you have learned 
to use the Page Setup dialogue Box. You are now going to study 
the Print Dialogue box so that you can use it to print the 
Workbook. 
         Your Aims:   

 identify the steps in using the print dialogue box 

 determine the importance of print dialogue box 
 

 
Using the Print Dialogue Box 
If you have multiple worksheets in your workbook, you will need to decide if you want 
to print the whole workbook or specific worksheets. Follow these steps: 

1. Go to File, left click the mouse.  

2.  Select Print → Print. The Print Dialogue box will appear. 

Selecting Print command from File.    Print Dialogue Box. 

3. Select the printer if you want to use a printer other than the default setting. 

4. Click Properties to change any necessary setting. 

5. Choose whether you want to print specific pages, all the worksheet, a 
selected area, the active sheet or the entire workbook. 

6. Select the number of copies you would like to print. 

7. Click OK 

2 
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Activity 1:   List the steps on how to go to the print dialogue box. 
 
 

            

            

            

             

Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your Answers. Make sure you do the necessary corrections before moving 
onto next part of this lesson. 
 

Summary  
You have come to the end of Lesson 12. In this lesson, you learned 
the steps involved in using the Print Dialogue box as well as the 
importance of using these commands. 
 

 

 
 

NOW DO PRACTICE EXERCISE 12 ON THE NEXT PAGE. 
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Practice Exercise  12 
 

Print a Workbook. Re -arrange the jumbled steps below into their correct 
order.  

Select printer that is connected to your computer.   

Select print in the pop- up menu.    

Select All, number of copies one.      

Pick up your print out of Grade 10 marks.    

Open the Workbook containing the Grade 10 Computer Studies student‘s marks.   

Left Click, move mouse to the Print.  

Go to File.         

Click OK command.     

 

 
 
 
Answers to Activity 1 
1. Go to File, left click the mouse. 

2.  Select Print → Print.  

3. The Print Dialogue box will appear. 

 

CHECK YOUR WORK. ANSYOURS ARE AT THE END OF TOPIC 2. 
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Answers to Practice Exercises 
 

Practical Exercise 7 
Follow the given instruction and format a spreadsheet. 

1. Open a Workbook, and type ―Shopping List‖ in cell A1. 

2. In cell A3 and B3, type in Item and Cost respectively as your Sub- Title;  

3. Type in your shopping list. 

Before         After  

 

 

 

     

 

 

 

 

4. Go back to cell A1 and do the following  

5. Change the font style to Monotype Corsiva 

6. Change the font size to 18 and  

7. Modify font color to green 

8. Select a portion of the items in one cell and make only that part bold. For 
example, if the words ―Hottest pot‖ is in the cell, make only the word ―Hottest‖ 
bold. (Select one word from the cell above) 

9. Merge and center the title 

10. Align the content of all the cost to the right. 

 

 

10 

5 
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Practice Exercise 8 
 

List down the steps involved in formatting footers. Begin with confidential in the right 
side, date in the center and pages in the left side of the footer area. 

1. Choose the insert tab. 

 

2. Click the header and footer in the Text group. Your worksheet changes to 
page layout view and the design context tab appears. Note that your cursor is 
located in the center section of the header area.  

3. From the Headers and Footers tools in the design, select the command go to 
Footer.  

 

 

 

 

 

 

 

4. Click the down arrow, and move to option four (4) on the list. 

 

 
 
 
 

3

 
4

 

1 

2 

3 

4 
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Practice Exercise 9 
A. Matching – match the following instruction to Commands. Write the letter of 

command next to the instruction. 
  Instruction     Command 

a.  Move a worksheet.    Format            d  

b. Change the name of a worksheet.  Confirm Password          g 

c. Delete a worksheet.    Protect sheet                   e 

d. Select from format in the cell group  Move or Copy sheet         a 

e. Enter password to unprotect sheet  Delete            c 

f. Format cell     Rename             b 

g. Retype password    Drop down Arrow               f 

B. Organize a new Workbook 
1. Open up a new Microsoft Excel 

2. Rename sheet1 as Business 

3. Rename sheet2 as Family 

4. Rename sheet3 as Personal 

5. Color each tab with different red from dark to light color 

6. Make a copy of sheet2 next to itself 

7. Hide the original sheet2  

 

Practice Exercise 10 
A. Filtering Cells 

1. Open an existing Workbook. 

2. Select the Sort and Filter command. 

3. Move mouse to the Filter command. 

4. Select the command Filter. 

5. Click the drop down arrow next to the column you want to filter. 

6. Uncheck Select All 
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7. Then click the appropriated number under Select All. 

8. Then click OK command. 

Practice Exercise 11 

Using the example from the Computer Studies Students marks identify the steps you 
are going to Print Titles command to make row 1 and column A appear on every 
page. 

1.  Click the Page Layout tab. 

2.  Select the Print Titles command. 

3.  The Page Setup dialog box appears.  

4.   Click on the rows you want to appear on each printed page. The Rows to 
 repeat at top dialog box $1:$1. 

5.  Repeat for Columns to repeat at left, $A$B 

6.  Click OK. You can go to Print Preview to see how each page will look when 
 printed. 

 

Practice Exercise  12 
A. Print a Workbook 

1. Open the Workbook containing the Grade 10 Computer Studies students‘ 
marks. 

2. Go to File.  

3. Left Click, move mouse to the Print. 

4. Select print in the pop- up menu. 

5. Select printer that is connected to your computer. 

6. Select All, number of copies one. 

7. Click OK command. 

8. Pick up your print out of Grade 10 marks.   

 

 
 
 

End of Topic 2. 

Now Do Exercise 2 in Assignment Book 1 Then Go to Topic 3. 
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TOPIC 3 

  
 
 
 
 

SPREADSHEET 2 
 
 
 
 

 

LESSON 13: Adding Numbers in Various Cells 

LESSON 14: Subtracting Numbers in Various Cells 

LESSON 15: Multiplying Numbers in Various Cells 

LESSON 16: Dividing Two Numbers 

LESSON 17: Using Auto Sum 

LESSON 18: Copying Data or Formula 
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TOPIC 3: FORMULA 
___________________________________________________________________ 
 
In this topic you will learn about the concepts of using formula in Excel. Excel can be 
used to calculate and analyze numerical information. However, you will need to know 
how to write formulas to maximize Excel's capabilities. A formula is an equation that 
performs a calculation using values in the worksheet.  

Formulas are powerful tools in spreadsheets which can save you hours of work. 
Functions are routines that are built into the Excel spreadsheet, in other words, there 
is not much you need to do to set them up and make the work. Formulas, on the 
other hand, are defined by the user to know what you are doing and set everything 
up yourself. Formulas will often include the built-in functions as part of the formula. 
Both functions and formulas accomplish the same task. They tell Excel to do some 
kind of more or less complex calculation for you. In this topic it will show how to 
create formulas using mathematical operators such as the addition, subtraction, 
multiplication, and division signs. 

In this topic, you will study about the following: 

Lesson 13 discusses on adding numbers in various cells. You will enumerate the 
steps in adding numbers in various cells and to perform addition of numbers in 
various cells. 

Lesson 14 focuses on subtracting numbers in various cells. You will enumerate the 
steps in subtracting numbers in various cells and to perform subtraction of numbers 
in various cells. 

Lesson 15 elaborates on multiplying numbers in various cells. You will enumerate 
the steps in multiplying numbers in various cells and to perform multiplication of 
numbers in various cells. 

Lesson 16 explains on dividing two numbers. You will enumerate the steps in 
dividing numbers in various cells and to perform division of numbers in various cells. 

Lesson 17 expounds on the uses of Auto Sum. You will discuss the steps in using 
the Auto Sum, to use Auto sum and to enumerate the importance of using the Auto 
Sum. 

Lesson 18 emphasizes on copying data or formula. You will enumerate the steps in 
copying data or formula, to make copying of data or formula from various cells and 
enumerate the importance of copying data or formula in an Excel sheet. 

By the end of Topic 3, you should be able to compute and use various formulas for 
the given data in Spreadsheet. 
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Lesson 13: Adding Numbers in Various Cells 
___________________________________________________________________ 
 
 
 
 
 
 
 
 
 
___________________________________________________________________ 

 Calculations in Excel  
Although calculations are one of the main uses for spreadsheets, Excel can do most 
of the hard work for you by using a formula. When you enter a formula into a cell in a 
spreadsheet, Excel will calculate the Answer and display the Answer in that cell. 
Please refer to our Grade 9 workbook Design and Technology-Computing, 
Spreadsheet1 in Lesson 8, page 72 for Creating Simple Formulas. It was briefly 
discussed in Lesson 8 of this unit as well. You defined formula as an equation that 
performs a calculation. Like calculator, Excel can execute formulas that add, 
subtract, multiply and divide. One of the most useful features of Excel is its ability to 
calculate using the cell address to represent the value in a cell. This is called cell 
reference. 

SUM is one of many Excel built-in functions. It Adds Up or Totals the series of 
additions to produce the required result. You will look at other built-in functions in a 
moment. 

There are a few rules to remember when creating a spreadsheet formula.  

1. A formula always begin with an equal sign ( = ). It is not enough to type 1+1 
 in Excel because what will appear in the cell is ―1+1‖. You must begin the 
 equation with an equal sign, or =1+1. This holds true for any formula, simple 
 or complicated, that adds, subtracts, multiplies or divides. 

 As soon as you begin a cell with a (=) Excel will know that you are creating a 
 formula.  

2.  A formula will follow the order of operations Parenthesis, Exponential, 
Multiplication, Division, Addition and Subtraction (PEMDAS). Generally if there 
is more than one part to a formula, the calculations will work from left to right 
but any part of the formula in brackets will be calculated first. Indices or 
exponential will be left. Multiplication and division will be next. Addition and 
subtraction will be calculated last.  

 P  Parenthesis ( )  
 E  Exponential or Indices ^  
 M Multiplication *  
 D  Division /  

 

 

 

Welcome to Lesson 13 of Unit 3. In Lesson 12, you learned to 
use the Print Dialogue Box and to print a worksheet box. 

In this lesson, you will be able to enumerate the process of 
adding numbers in various cells and to calculate numbers 
using the sum in various cells 
 

     Your Aims: 
 identify the steps in adding numbers in various 

cells 
 add numbers in various cells 
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A  Addition +  
 S  Subtraction –  
  

A mnemonic that can help you remember this is Please Excuse My Dear Aunt 
 Sally (P.E.M.D.A.S). 

3.  A formula can refer to other cells in the spreadsheet using cell references.  

4.  If any part of the formula is referring to text, the text must be enclosed in 
 quotation marks “  ”.  

5.  The cells referred to in a formula cannot include the cell the Answer will be in. 
 This will cause a circular reference error.  

Now let us try to type the following data into our Spreadsheet. 

For example, at the end of a semester, you will want to calculate a total point value 
for each student. To do this, you can program the spreadsheet to carry out a formula 
on the values in the cells that contain the students‘ scores (Column I in our 
spreadsheet). 
 

 
 
You can have the spreadsheet add up the numbers in a set of cells. Or you can have 
the spreadsheet tell you the average score in a range of cells, and so on. You can 
also have the system copy a formula into other cells. 

Let us try a few things along these lines now. 

Creating a formula 
Let us enter a formula and see what it does.  

1. Select cell I12, click Function formula fx                 in the Ribbon. 

2. Choose SUM for addition. 

3. Click OK. 
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4. After clicking OK, the Function Arguments will apper and show us the cell 
 references that need to be added. Since D12 to H12 are the cell refences that 
 you need to add, then just click OK. 
 
 

 

  
 
 
 
 
 
 
 
 
 
 
   

 
   =SUM(D12:H12), no spaces in between the characters 

The colon (:) indicates the range of 
cells, in this case from D12 to H12. 

2 

3 
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After clicking OK from the Function Arguments. 
 
The "=" symbol at the beginning is a clue to the system that what follows is a function 
or formula. So remember this: 
 
All Spreadsheet functions or formulas begin with the equal (=) sign. 
 
Or 
 
There are still other ways to type the formula. 
 
1. From the formula bar you can type the formula manually as long as you know 
 cells that you are adding with. Position your active cell to your Total which is 
the  I12. 
 
2. Type the formula to the formula bar =(D12+E12+F12+G12+H12) or 
 =D12+E12+F12+G12+H12,  you can remove the parenthesis since you only 
 have single equation to make. 

 

 
 

3.  Then click the Accept button (  ) or the Enter key. 
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 Note:  Click the Accept button ( ) when you are sure all is you‘ll (or press one of the 
other keys(arrow keys), Enter/Enter key, Tab key which accept data into the spreadsheet). 
 

 
 

 
   
  

 
 

 
After clicking (). 

 
Or 
 
1. You can type the numbers or the data you typed in your formula. 

 =12+14+28+98+3 or you can use the parenthesis by =(12+14+28+98+3) 

 

2. Click the Accept button (  ) or the Enter key. 

 The disadvantage of typing the data or numbers as your formula is you cannot 
 change the given data. Once you type it as your formula then you cannot 
 change it, or else if you change the data, the Total will still be the same. Try to 
 change  
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          the data in cell reference D12 from 12 to 20 and observe that the Total will not 
 change. 

 

 Therefore, using the cell references in creating your formula is the correct way 
 to add the data correctly. It changes for the Total when you change or edit the 
 data in the cell reference.  Now, let us proceed to I13 to get the Total for the 
 next student, Excel provides a neat tool to duplicate the contents of cells into 
 a set of adjacent cells. Assume you will have just ten students in the 
 class. You are going to duplicate the formula that is in cell I12 into the other 
 nine cells below it. As before, Excel will automatically adjust the cell addresses 
 so that they are appropriate (relative) to each student's record. Select cell I12, 
 if it is not already selected. 

 

 

 
 
 
Filling down (copying the formula into the rest of the TOTAL column) 
1. Use the mouse pointer to grab hold of the small black Fill handle in the lower 
 right corner of cell I12. 

 
The Fill Handle. 

 Notice that the mouse cursor changes from . 

The small square at the bottom right of the active cell is the Fill Handle, which is used 
to copy the contents of a cell into a range of adjacent cells. For instance, if you want 
to have series of numbers from 1 – 10. Here in this example, you want to have the 
Total from L12 to L121. Here are the steps: 
 

No automatic 
changes from the 
Total 

The cell‘s 
Fill handle 

                     Relative References 
The system is copying the formula in cell I12 to cell I13 in 

relation to ("relative to") cell I12. In other words, just as the formula in 
I12 sums the values stored in cells D12 through H12, so the formula 
copied to cell I13 will sum the values relative to cells D13 through. 
H13.  
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Drag the small black Fill handle down to highlight all the cells from cell I12 to  cell 
I21. Notice that the set of cells from I12 through I21 are now selected as a  block on 
the screen. 

 

 

You can also do the formula to get for the Total one at a time for practice but do not 
do it more often. One of the advantages of using Excel is not a consuming time 
software program wherein you can use some shortcuts to lessen your burdens in 
creating formula.  

Save your work with the filename Grade Report. 
 

Activity: 

 Answer the following.  

A. Write down three possible addition formulas for the given data to get the 
Total. 

 

a. _________________________________________________________________ 

b. _________________________________________________________________ 

c. __________________________________________________________________ 

d.  Total ________________________ 

___________________________________________________________________ 
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B. Write down the formula using fx to compute for the Total in Area 1, Area 2 

and Area3. 

 

a.  Formula: 
 ______________________________________________________________ 

Total for Area 1 ________________________________ 

b.  Formula: 
 ______________________________________________________________ 

Total for Area 2 ________________________________ 

c.  Formula: 
 ______________________________________________________________ 

Total for Area 3 ________________________________ 

Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your Answer. Make sure you do the necessary corrections before moving on to 
the next part of this lesson. 
 

 
Summary 
You have come to the end of Lesson 13. In this lesson, you learned 
to identify the steps in adding numbers and to add numbers in 
various cells. 

 

 

 

 

 

 

NOW DO PRACTICAL EXERCISE 13 ON THE NEXT PAGE. 
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Practical Exercise  13 

___________________________________________________________________ 

A. Write the steps on how to use the function formula fx in creating 
 formula. 

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________ 

 
B. Compute for the Total using the function formula fx. 

 

 
 

CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 3. 

 

Answers to Activity 

A. Write down three possible formulas for the given data to get the Total. (In any 
 order) 

a. =SUM(A3:G3) 

b. =(A3+B3+C3+D3+E3+F3+G3) 

c. =(15+23+56+54+31+22+54) 

d. Total is 255 
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B.    Write the formula using fx to compute for the Total in Area 1, Area 2 and 
 Area3. 

a. Formula: =SUM(B4:B6) 

 Total for Area 1 150 

b. Formula: =SUM(C4:C6) 

 Total for Area 2 243 

c. Formula: =SUM(D4:D6) 

 Total for Area 3 174 
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     Your Aims: 
 identify the steps in subtracting numbers in 

various cells 
 subtract numbers in various cells 

 

 

Lesson 14: Subtracting Numbers in Various Cells 

___________________________________________________________________ 

 
 
 
 
 

 
 
 
 
 
___________________________________________________________________ 

Subtracting numbers in Various Cells 
Formulas are the heart of Excel. With huge list of built-in formula and functions, Excel 
stands out from other datasheet handling applications. Please refer to your Grade 9 
Lesson 14. Formulas are used for calculating and analysing data based on values in 
designated cells. It supports trigonometric, statistical and other functions. You can 
also create a new rule, or constraint to apply over your datasheet. This post covers 
writing formulas and applying conditional formatting on a basic level. 

You learned from Lesson 13 the steps in summing numbers and that the symbol for 
your addition is a plus ( + ). You can find it on top of number keys on your keyboard 
by pressing the Shift key and at the same time the equal sign (=). 

As you already learned the addition you will also follow the same approach for 
subtractions.  

   
Note: Remember to always put your cursor in the cell where you want to put your Answer. 

 

As what you learned from addition which is the Sum you will use a different method 
which is the subtraction to get the difference between two numbers. 

IMSUB is also one of many Excel built-in functions. It subtracts the series of 
subtractions to produce the required result. You will look at other built-in functions in 
a moment. You will also follow the addition rules for subtraction.  

Remember, a formula must always begin with an equal sign ( = ).  

1. Before creating a formula, make sure that you are in your right cell reference.  

 

 

 

Welcome to Lesson 14 of Unit 3. In Lesson 13, you learned 
the steps in summing numbers. 
 
In this lesson, you will be able to enumerate the process of 
subtracting numbers in various cells and to calculate 
numbers using the subtraction in various cells 
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2. Type the given data into your blank worksheet. 

 
 

3. Compute for the Discounted Prices by subtracting columns B to columns C. 

4. As what you had for addition, you can also apply to subtraction. 

 You can try it manually and using the cell references involved. 

5. Type =(B3-C3) to cell reference D3 to get the Discounted Prices. 

Or 

1. Use the function formula fx. Click fx from Insert Function and choose IMSUB 
 to subtract columns B and columns C. Or, if you cannot find it in your Insert 
 function, type IMSUB.  

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
2. If the function you want to use is in a selection menu, then just highlight it and 
 click OK. 
 
 
 
 
 
 
 

The Insert Function is found by selecting fx. 

To type the 
mathematical 

functions you want 
to use. 

1 

2 
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         And this will be shown on to your screen. 

 

 
 
3. Type the first cell reference to subtract in Inumber1, B3. 

4. Type the second cell reference to subtract with B3 in Inumber2, C3. 

5. Click OK if you are sure for your cell references. 

 

 
Arrow showing Function Argument. 

After typing the cell references, you can also see the data to the right of the 
Function Arguments and the Answer. Function argument shows you the 
function and reference that is being used. Here, the function used was IMSUB 
and the argument is enclosed in the parenthesis (B3, C3). 

 

 
 
 The Answer you saw from the Function Arguments and the Answer that 
 shown to D3 are the same. 

6. Use the Fill Handle to drag and drop to complete the Answers for Discounted 
 Prices. 

6 
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After using the drag and drop for Fill Handle. 

 
7.  Save your work with the filename ITEMS. 

Or, using ALL instead of most recently used. 
___________________________________________________________________ 

 
 Activities:  
 
Answer the following. 
 

 
 1. Write the steps on how to use the fx or formula function (IMSUB) to 
 subtract: 43 which is in cell reference A2 and 23 which is in cell 
 reference B2. Write your Answer to cell reference C3. 
 
___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________ 

 
2.  Write the steps on how to get the difference from the given data below. 
 Use this ( ─ ) symbol to calculate for your Answer. 
 

  
 
___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________ 

Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your Answer. Make sure you do the necessary corrections before moving on to 
the next part of this lesson. 
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___________________________________________________________________ 

 
Summary 
You have come to the end of Lesson 14. In this lesson, you 
learned to identify the steps in subtracting numbers and to 
subtract numbers in various cells. 
 

___________________________________________________________________ 
 

 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

NOW DO PRACTICAL EXERCISE 14 ON THE NEXT PAGE. 
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Practical Exercise  14 
___________________________________________________________________ 
1. Type this in your Excel Spreadsheet and compute for the Answers using the 
 formula function fx. 

 

 
 

2. In order to get the Net Pay Salary Per Year first, you must add all the 
 deductions (tax, medicare, social security and housing) and deduct it from the 
 Annual Salary.Compute for the folllowing: 

1) Get the Net Pay 

2) Add all the deduction 

 

 
 

  
 

 
CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 3. 

Answers to Activity 
 
1. Steps using the formula functions to subtract two numbers: 
 
a. Click the fx function from the formula bar. 

b. Choose and click IMSUB from the Insert Function. 

c. Click OK. 
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d.   Type the cell references that need to be subtracted from the Function 
 Arguments. 

 Inumber1 A2 

 Inumber2 B2 

e. Click OK. 

 
 

2. Steps on how to calculate the difference using the minus ( - ) symbol.  
 
a. Position your active cell to B3 to write your Answer. 

b. Place and click your mouse to the Formula Bar. 

c. Type =B1-B2. 

d. Press Enter key to get the Answer. 
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Lesson 15: Multiplying Numbers in Various Cells 

___________________________________________________________________ 
 
 
 
 
 

 
 
 
 
 
___________________________________________________________________ 

Multiplying in Various Cells 

The symbol for our multiplication is an asterisk (*). You can find it on top of THE 
number keys on your keyboard. Press the Shift key and at the same time the number 
8 key to get the asterisk or press the asterisk key of your keyboard. Please refer to 
your Grade 9 Topic 3, Lesson 15. 

As you already learned the addition and the subtraction, you will also follow the same 
approach for multiplication. 

Creating multiplication formulas is very similar to addition and subtraction formulas. 
To multiply two formula cells, the formula, B2 and B3, you would need to insert a 
multiplication operator which is the asterisk symbol (*) between them, =B2*B3. 

 

Please review your Grade 9 Design and Technology – Computing, Spreadsheet 1 on 
Topic 3, Lesson 15, and use simple formula for multiplication. In this lesson, you will 
use the formula function fx to get the product of two numbers. 

The same steps and applications for addition and subtraction can be applied for 
multiplication. But, instead of using Sum and IMSUB, you will use Product from the 
Insert Function of formula. 

Welcome to Lesson 15 of Unit 3. In Lesson 14, you learned 
the steps in subtracting numbers. 
 
In this lesson you, will be able to enumerate the process of 
multiplying numbers in various cells and to calculate 
numbers using the multiplication in various cells 
      Your Aims: 

 identify the steps in multiplying numbers in 
various cells 

 multiply numbers in various cells 
 

 

Formula =B2*B3 multiplies 
cell B2 by the cell B3 
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To compute for the Product. 

Try re-do this practice exercise on page 144 by changing the percentage deductions.  

 

1.   Start getting the percentage for the Tax which is 7%. Click the active cell 
 where to place your Answer (C6).  

2.    The first cell that you need to get the product is cell reference B6 multiplied by 
 7%. Click function formula fx and from the Insert function of the formula 
 choose Product. 

3.   PRODUCT is to multiply two numbers from the given cells. Choose Product 
 from the Insert Function. 

4.     Click OK.  

 

2 

1 
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5.    After clicking OK, Excel will show you the Function Arguments for Product. 
 The Excel will suggest and show you the cell reference to be multiplied. 
 Since B6 is the correct cell reference for Number1, then you can press Enter 
 key. Number2 will show to ask for the next cell entry. Since you need to 
 multiply B6 to 7%, then you can type 7% to Number2 box as shown below 

 

6.     Click OK. 

 
The result after clicking OK from the Function Arguments. 

4 

3 
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7.       Use the drag and drop (Fill handle) to get the Tax deductions from B6 to B10. 

 

 

 

 

 

 

 

The result after the drag and drop for the Tax. 
 

8.      Apply the same steps to get the percentage for the Medicare, Social Security 
  and Housing by following steps 1 to 7. 

 
The result after multiplying the percentage. 

9.     From Lesson 13, add cell references C6 to F6 to get the Total Deductions for 
  cell reference G6. Apply the drag and drop to get the rest of the Answers. 

10.    From Lesson 14, subtract cell references B6 to G6 to get the difference for cell 
  reference H6 for the Net Pay Salary Per Year. 

 
The complete result for the Net Pay Salary Per Year. 
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Activity 1:   Answer the following. 
 
 
1.  Give three formulas to solve the Product for the following given data.   

   

 

a. 
___________________________________________________________________ 

b. 
___________________________________________________________________ 

c. 
___________________________________________________________________ 

2.      Complete the Table, write the formula to obtain the product of B3 and C3. 

 

 

Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your Answer. Make sure you do the necessary corrections before moving on to 
the next part of this lesson. 
___________________________________________________________________ 

 
Summary 
You have come to the end of Lesson 15. In this lesson, you 
learned to identify the steps in multiplying numbers and to 
multiply numbers in various cells. 
 

___________________________________________________________________ 
 

 
 

 

NOW DO PRACTICAL EXERCISE 15 ON THE NEXT PAGE. 
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Practical Exercise  15 
___________________________________________________________________ 

The Toyota Motors Japan will export the following types of cars to different 
countries listed below for every month.  

1. Open a new Excel and type in the following data. 

 

2.   Insert a column on every brand of car and title it as Total. 

3. Compute for the Total number of cars to be exported by Toyota Motors Japan 
for one year.  

 
CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 3. 

Answers to Activity 

 
1.         Three formulas to solve for the Product.    

a.        =PRODUCT(B2:C2) or =PRODUCT(B2,C2) 

b.        =(B2*C2) 

c.        =(35*65) 

2.   The formula using the formula function fx is =PRODUCT(B3:C3) or     
=PRODUCT(B3,C3) 

Note: Do not forget to use the drag and drop from cell reference D4 after 
getting the first product. 



GR10 D&T-COMPUTING U3                                    149                   TOPIC 3 LESSON 16 
 
Lesson 16: Dividing Numbers in Various Cells 
___________________________________________________________________ 
 
 
 
 
 

 
 
 
 
 

___________________________________________________________________ 

Dividing Numbers in Various Cells 
In division, it is similar to multiplication. Review your Grade 9 Design and Technology 
Computing, Spreadsheet 1, Topic 3, Lesson 16. It is about dividing two numbers. In 
the expression A / B = C, A is called the dividend or numerator, B the divisor or 
denominator and the result C is called the quotient. 

Your mathematical operator for division is the slash symbol (/). In division, it 
describes two distinct but related settings. Partitioning involves taking a set of size A 
and forming B groups that are equal in size. The size of each group formed, C is the 
quotient of A and B. Even though you can use numbers directly in your division 
formula, it is much better to use the references or addresses of the cells containing 
your data. If you use the cell references rather than the actual data, later, if you 
need to change the data in either cell, the results of the formula will update 
automatically without having to rewrite the formula again.  

Example: 

                        A = 10                 B = 5            C, is the Quotient 

 

Now, take the following steps on how to divide two numbers. 

1.       As what you did from the previous (addition, subtraction and multiplication) you 
 need to type the data into your blank Spreadsheet. 

2.        Type the given data. 

 

Welcome to Lesson 16 of Unit 3. In Lesson 15, you learned 
the steps in multiplying numbers. 
 
In this lesson, you will be able to enumerate the process of 
dividing numbers in various cells and to calculate numbers 
using the division in various cells 
 

 

     Your aims: 
 identify the steps in dividing numbers in 

various cells 
 divide numbers in various cells 
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The number of Girl Scouts collected empty plastic bottles to donate to 5 
 schools who are in need to make these empty plastic bottles for their big 
 project to make the new invention called new plastic bottles walls that can 
 save more money to make walls for the classrooms. Compute for the empty 
 plastic bottles that the school needed to create for their school‘s walls. 

 

3.    Use the formula function fx to get the quotient. If this is your first time to use 
 this method and you couldn‘t find it in your Insert Function, type Quotient on 
 the Search for a Function and click Go. The word Quotient will appear and it is 
 now ready for use. 

 

4.     Make sure that you place your active cell to the cell where you put your 
 quotient. Suppose you will use cell reference C5 to print for the quotient.  

5.      Click OK. 

3 

4 

1 
2 
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6.     The Function Arguments for the Insert Function will appear.  

 Type the Numerator which is B5 and your denominator which is 5 for the five 
 schools. 

 

 As you can see after typing the cell reference to the Numerator, the value of 
 B5 appears to the right side of the Function Arguments, as well as the 
 denominator and the quotient.  

7.      Click OK. 

8.     Therefore, each school will receive 22447 empty plastic bottles from the Girl 
 Scout. 
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Activity 1:   Answer the following.      

 
1. Write TRUE if the Answer is correct and write FALSE if the statement is 

wrong. 
 
a.        The other name for dividend is called the numerator.  __________ 

b.        The other name for the divisor is called the denominator.  __________ 

c.        The result or the Answer for this division is  called the quotient.  __________ 

d.        The mathematical operator for division is called the asterisk.  __________ 

e.        In division, it describes two distinct but related settings.  __________ 

f.       Using the cell reference rather than the actual data is much better to update 
 automatically the value without having rewriting the formula again.   
                           __________ 

2.         Number the given Insert Function accordingly.      
  

 

 

 

 

 

 

 

 

 

 

Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your Answer. Make sure you do the necessary corrections before moving on to 
the next part of this lesson. 

Summary 

You have come to the end of Lesson 16. In this lesson, you learned 
to identify the steps in dividing numbers and to divide numbers in 
various cells. 

___________________________________________________________________ 
 NOW DO PRACTICAL EXERCISE 16 ON THE NEXT PAGE. 
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Practical Exercise  16 

___________________________________________________________________ 

A.  Compute for the quotient: 
 
a.     There were 550 students in NCD who will take part in the inauguration of the 

new Stadium in Port Moresby. The government will provide 25 seater buses to 
collect the students from their respective schools to bring them to the new 
Stadium. Solve on how many buses needed to collect the students. 

 
          A4 = 550          B4 = 25           C4 = Answer 
 
b.      Mr. Brown bought 3,587 acres of land to given to his seven children. Compute       

for the quotient on how many acres of land he can give to his children. 
 
 c.     The Rotary Club of Port Moresby brought 880 pieces of blankets, 440 sacks of 
 rice, 2000 bottled water and 250 boxes of tin fish to the affected area of the 
 typhoon. There were about 250 families waiting for the Rotary for their 
 donations. Compute on how many blankets, sacks of rice, bottled water and 
 boxes of tin fish will be given for each family. 
 
___________________________________________________________________ 
 

 
CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 3. 

 
Answers to Activity 
 
1. 
 
a.        TRUE 
 
b.        TRUE 
 
c.        TRUE 
 

d.     FALSE, slash (/) is correct 
 Answer and not asterisk 
 
e.        TRUE 
 
f.         TRUE 

 
2. 

 
 

 

 

 

2 1 

3

3 

4 
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Lesson 17: Using Auto Sum 

___________________________________________________________________ 

 

 
 
 
 

 
 
 
___________________________________________________________________ 

The Auto Sum 

Auto Sum  is a shortcut for the SUM function. As you take a look at your Grade 
9 Design and Technology – Computing, Spreadsheet 1, Lesson 17 on page 163, a  
function in a Spreadsheet program inserts a formula in the selected cell that adds 
the numbers in the column. It sets the range of cells by looking for numeric data 
above the selected cell. 

The importance of the Auto Sum tabulation tool is; it is used to quickly add numbers 
in consecutive cells. 

A function is a predefined formula that performs calculations using specific values in 
a particular order. While you may think of formulas as being short mathematical 
equations, like 2 + 2 or F2 * C2, they can actually be very lengthy and involve 
complex mathematical calculations.  One of the key benefits of functions is that they 
can save you time since you do not have to write the formula yourself. For example, 
you could use an Excel function called Average to quickly find the average of a 
range of numbers or the Sum function to find the sum of a cell range. 
 

In this lesson, you will learn how to use basic functions such as SUM and AVG, use 
functions with more than one argument, and how to access the other Excel 2010 
functions. 
 
The Parts of a Function 
Each function has a specific order, called syntax, which must be strictly followed for 
the function to work correctly. 
 
Syntax Order: 
 
1. All functions begin with the = sign.  

2. After the = sign, define the function name (e.g., Sum).  

 

Welcome to Lesson 17 of Unit 3. In Lesson 16 you learned the 
steps in dividing numbers. 
 
In this lesson, you will be able to enumerate the process the 
steps in using the Auto Sum and the importance of the Auto 
Sum 
 

 

     Your aims: 
 identify the steps in quickly adding consecutive list 

of numbers 
 identify the importance of using the Auto Sum 
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3.   Then, there will be an argument. An argument is the cell range or cell    

references that are enclosed by parentheses. If there is more than one 
argument, separate each by a comma.  

4. An example of a function with one argument that adds a range of cells, A3 
 through A9: 
 

 
 
 An example of a function with more than one argument that calculates the 
 sum of two cell ranges: 
 

 
 
Excel literally has hundreds of different functions to assist with your calculations. 
Building formulas can be difficult and time-consuming. Excel's functions can save you 
a lot of time and headaches. 

 

Excel's Different Functions 

There are many different functions in Excel 2010. Some of the more common 
functions include: 

Statistical Functions: 

SUM - summation adds a range of cells together. 

AVERAGE - average calculates the average of a range of cells. 

COUNT - counts the number of chosen data in a range of cells. 

MAX - identifies the largest number in a range of cells. 

MIN - identifies the smallest number in a range of cells. 
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Start to type this given data and value to use the following functions. 

 

1. Start to compute for the TOTAL, using the Auto SUM. Position your 
 active cell to cell reference F7 to compute for the TOTAL for the first student. 

2. Click  Auto Sum, drop down arrow to choose function name.  

3. Select SUM to compute for the TOTAL.  

 

4. As soon as you click the Sum, the cells will have these marching ants‘ lines to 
 suggest if those are the correct values to be added. 
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5. Since cell references B7 to E7 are the correct cells, just press the  Enter Key. 
 The first sum will appear to F7. 

 

6. Continue for the TOTAL by using the drag and drop. 

7. Compute for the Average by using the drop down arrow again for the Auto 
 Sum and select the Average this time. 

 

8. Click Average. 

9. Since you need to get the Average from the TOTAL which is in cell reference 
 F7, you need to edit the argument by changing the argument to F7. Click the 
 Enter Key and you will have the first Average in G7; continue to get the 
 Average using the drag and drop. 

Drag and drop 
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10. In cell reference B15, you need to get the number of students by clicking the 
 Auto Sum and click Count Numbers. 

  

11. Position your active cell to cell reference B15. Click the Auto Sum again and 
 click Count Numbers. 

 

12. Next, you will be to get the Highest on every test the students take. Position 
 your active cell to cell reference B16; click the Auto Sum again and click 
 MAX. 
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13.  Since for this Highest (Max) you need to get the highest score for the test, you 
 need to change the argument to B7:B13 for the seven students‘ cell 
 references. 

 

14.  Press the Enter key after you change the argument.  Use the drag and drop to 
 get highest from Test 1 to Average. 

 

15. 

 Apply the same technique for the Lowest by clicking the MIN from the Auto 
 Sum. 
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The result using the Auto Sum. 

16. Save your file with the filename AUTOSUM. 

In addition to Auto Sum you can also use the different  function names: 

Date and Time functions: 

DATE - Converts a serial number to a day of the month 

Day of Week 

DAYS360 - Calculates the number of days between two dates based on a 360-day 
year 

TIME - Returns the serial number of a particular time 

HOUR - Converts a serial number to an hour 

MINUTE - Converts a serial number to a minute 

TODAY - Returns the serial number of today's date 

MONTH - Converts a serial number to a month 

YEAR - Converts a serial number to a year 

You do not have to memorize the functions but you should have an idea of what each 
can do for you. 

In addition to your formula functions, you also have: 

The Equation Editor 
 
The Equation Editor       is new in Excel 2010 and is designed to create a 
mathematical equation as a graphical object.  

The Equation Editor in Excel 2010 is difficult to navigate at first. The second time I 
tried creating an equation, it got slightly easier, and the third time with the same 
equation seemed to almost get the hang of it. The trick was to just type the equation 
in and let the Editor do its thing in rearranging what you‘re typing. On the Equation 
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Tools Ribbon is two helpful selections: Professional and Linear. Playing around with 
these will help you understand how the Editor can manipulate simple equations. 

Advanced equations will take some time to figure out, but the editor should handle 
most anything you can throw at it. 

Entering an Equation 
To enter an equation with the Equation Editor, go to the Insert tab on the Ribbon, and 
click Equation. This gives you a text box with the words ―Type equation here.‖ You 
will also notice two additional menu tabs on the Ribbon: Equation Tools, which 
becomes active, and Drawing Tools. 

 

There are varied Symbols readily available for insertion on the Equation Tools 
Ribbon tab. There are also several drop-down menu items that can expand to show 
even more symbols for things like: Fraction, Script, Radical, Integral, Large Operator, 
Bracket, Function, Accent, Limit and Log, Operator, and Matrix.  
 

 
Activity 1: Answer the following. 

 

1.  Give the five Statistical Functions and explain. 

a. 

___________________________________________________________________

__________________________________________________________________ 
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b 

___________________________________________________________________

__________________________________________________________________ 

c.  

___________________________________________________________________ 

___________________________________________________________________ 

d. 

___________________________________________________________________

___________________________________________________________________ 

e. 

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________ 

2. Name the five Statistical Functions. 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your Answer. Make sure you do the necessary corrections before moving on to 
the next part of this lesson. 

Summary 
You have come to the end of Lesson 17. In this lesson, you learned to 
identify the steps in using the Auto Sum and the importance of the 
Auto Sum. 

 

 
NOW DO PRACTICAL EXERCISE 17 ON THE NEXT PAGE. 

1. 

2. 

3. 

4. 

5. 
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Practical Exercise 17 

___________________________________________________________________ 
1. Write three steps on how to use the Statistical functions 
 
a. SUM 
___________________________________________________________________

___________________________________________________________________ 

b. Average 

___________________________________________________________________

___________________________________________________________________ 

c. Count Numbers 

___________________________________________________________________

___________________________________________________________________ 

d. MAX 

___________________________________________________________________

___________________________________________________________________ 

e. MIN 

___________________________________________________________________

___________________________________________________________________ 

___________________________________________________________________ 
 

 
CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 3. 
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Answers to Activity 

1. 
 
a. SUM - summation adds a range of cells together. 

b. AVERAGE - average calculates the average of a range of cells. 

c. COUNT - counts the number of chosen data in a range of cells. 

d. MAX - identifies the largest number in a range of cells. 

e. MIN - identifies the smallest number in a range of cells. 

2.  

1. SUM 

2. AVERAGE 

3. COUNT 

4. MAX 

5. MIN 
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Lesson 18: Copying Data or Formula 
___________________________________________________________________ 
 
 
 
 
 

 
 
 
 
 
 
___________________________________________________________________ 

Copying Formula 
From your Grade 9 Design and Technology – Computing, Spreadsheet, Lesson 18 
you learned about Copying. When setting up a Spreadsheet. It is useful to be able to 
copy formulas from one place in the sheet to another. The formula may need to be 
copied to a different page of the workbook. Copied formulas can save time and you 
are sure that your formula is accurate. Sometimes, the formula needs to refer to 
different field ranges based on the page that it is on. 

Since you already discussed from your Grade on how to copy using the ribbon, you 
will have the other way around to copy using the Mini Toolbar. 

Copying using the Mini Toolbar 
By clicking the right button of your mouse, you can see and use the menus you want 
to work with your Excel. 
 
1. Type the following in your Excel Spreadsheet.  

 

 
 
 
 
 
 
 
 
 

2. Highlight cell reference A2. 
 
3. Click the right button of your mouse. 
 

 Welcome to Lesson 18 of Unit 3. In Lesson 17, you learned 
the steps in quickly adding consecutive list of numbers using 
the Auto Sum. 
 
In this lesson, you will be able to enumerate the steps in 
copying data or formula, the importance of copying data or 
formula in an Excel sheet. 
 

 

     Your Aims: 
 identify the steps in copying and pasting text, 

numbers or formulas 
 identify the importance of copying data or 

formula 
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4. After clicking Copy, you will see that A2 will change from hightlighted line to 
 marching ants line, meaning the Excel is ready to move your text into another 
 cell reference. Click the right button of your mouse again to see the Mini 
 Toolbar and this time, you click Paste to the destination you want to copy the 
 text. Suppose you will copy the text to C2. 

5. After clicking the right button of your mouse the Paste options will appear. 

 

 
The Paste Options. 

Paste (P): This option will paste the text to the destination cell that you 
assigned. 
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Values (V): This option will paste the numbers to the destination cell 
that you assigned. 

  

Formulas (F:)This option will paste the formulas to the destination cell 
that you assigned. 

 

                                 

Transpose (T)       Formatting (R)        Paste Link (N) 

 
The Paste Special Options. 

6. You will choose Paste (P) since you are copying a text but make sure you are 
 positioning your cell reference to the target cell where you want to transfer 
 your text. 

 

Remember, when you click Paste (P) using the Mini Tool Bar the text will 
automatically transferr but the original text that you copy will still have the marching 
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ants lines. In order to remove the marching ants lines click the left button of your 

mouse.  

Do the same to A4, A6 and A8, and transfer the files in to column C. 

 
The result after using the Copy / Paste (P). 

Copy / Paste Numbers using the Mini Toolbar 
Follow the steps below on how to copy or paste numbers using the Mini Toolbar. 

1.  Copy the given numbers into your Spreadsheet. 

 

2. You will apply the steps you have for the Copy / Paste (P) for the text for these 
 numbers, but you will change the clipboard from Paste (P) to Values (V). 

3. Transfer all these numbers from cell references A2 to A4. Highlight the three 
 cells and click Copy from the Mini Toolbar. 
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4. After clicking the Copy Command, the three cells to be copied will be changed 
to marching ant lines. Click again the right button and choose Values (V) to 
the clipboard to transfer the numbers to column B. 

 

 How about if you will copy the formula? 

 It is possible for you to copy and paste formulas in order for you not to re-type 
 the formula to the other cells. Type the following numbers into our 
 Spreadsheet. 

 

 Apply the complex formula for your given data. 

 Simple formulas have one mathematical operation, such as 5+5. Complex 
 formulas have more than one mathematical operation, such as 5+5-2. When 
 there is more than one operation in a formula, the order of operations tells 
 you which operation to calculate first. In order to use Excel to calculate 
 complex formulas, you will need to understand the order of operations. Please 
 refer to Lesson 13 to review for your order of operations. 

 Suppose Part 1 will be multiplied to Part 2 and be added to Part 3.  

 =23*45+85 means that the Excel will multiply it first and add later. Can you 
 remember the mathematical order of operations? The PEMDAS 

  Parenthesis 

  Exponential 

  Multiplication 

  Division 

  Addition 

  Subtraction
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5. Do your first formula for row 4. Go to formula bar to compute for the product in 
 cell references A4 and B4 and for the Total. 

 
After typing complex formula. 

6. Press Enter Key or press () to confirm that your formula is correct. But do 
 not worry Excel will suggest and tell you if your formula is not correct or you 
 miss something in your formula. 

 
After clicking Enter Key to confirm the formula. 

7. Use the drag and drop to get the Answer1 for rows 5 and 6. 

 
After using the drag and drop to copy the Answers for rows 5 and 6 

8. Type Answer2 to column E, cell reference E2. 

9. Copy the Formula from D4 to E4. 
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10.  Click the Formulas (F) from the Paste options to confirm it. 

 

11. As you notice, Answer2 copies the formula but adjusts the cells to columns 
 B, C, and D and not column A. You can make some corrections manually 
 according to what you want and need. 

12.  Use the drag and drop to get the Answers for rows 5 and 6. 
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Activity 1: Answer the following. 

 

1.  Give the Six Mathematical Order of Operations in Excel (write in order). 

a. __________________________________________ 

b. __________________________________________ 

c. __________________________________________ 

d. __________________________________________ 

e. __________________________________________ 

f. __________________________________________ 

2. Name the Six Paste Options 

 

1. ___________________________________________ 

2. ___________________________________________ 

3. ___________________________________________ 

4. ___________________________________________ 

5. ___________________________________________ 

6. ___________________________________________ 

 

Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your Answer. Make sure you do the necessary corrections before moving on to 
the next part of this lesson. 

 

Summary 
You have come to the end of Lesson 18. In this lesson you learned 
to identify the steps in copying data or formula and the importance 
of copying data or formula in an Excel sheet. 
 

___________________________________________________________________ 

1 2 3 4 5 6 

NOW DO PRACTICAL EXERCISE 18 ON THE NEXT PAGE. 
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Practice Exercise  18 

___________________________________________________________________ 

Type the given data into your worksheet and use the Copy and Paste commands. 

 

1. Copy Column A to B using the Copy / Paste commands in a Mini Tool bar. 

2. Copy C4 to C8 to column D rows 4 to 8. 

3. Add columns C and E and place your TOTAL in column F. 

___________________________________________________________________ 

 
CHECK YOUR WORK. ANSWERS ARE AT THE END OF TOPIC 3. 

 

Answers to Activity 
1. 

a. Parenthesis 

b. Exponential 

c. Multiplication 

d. Division 

e. Addition 

f. Subtraction 

2. The Paste Options 

  Paste (P)  Values (V) Formulas (F) 

 

   

 

           Transpose (T)       Formatting (R)      Paste Link (N)
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Answers to Practical Exercises 

__________________________________________________________________ 

Practical Exercise 13 

A.   

1. Place your active cell to the corresponding cell reference that need to compute 
 for the Total. 

2. Click function formula fx.  

3. Choose SUM to add the cell references. 

4. Click OK from the Insert function. 

5. Type the cell references to add or just click OK if the cell reference that is 
 shown is correct from the Function arguments. 

B. 

 
 
 
 
 
 
 

Practical Exercise 14 
 
1.  

 

 
 
2.  
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Practical Exercise        15 

Insert one column on every brand of the car and type the Title for the Product which 
will be multiplied by 12 (one year). 

Use the drag and drop method to get the Product for every country. 

 

 

Practice Exercise 16 

a.  There were 550 students in NCD who will take part in the inauguration of the 
 new Stadium in Port Moresby. The government will provide 25 seater buses to 
 collect the students from their respective schools to bring them to the new 
 Stadium. Solve on how many buses needed to collect the students. 
 
          A4 = 550          B4 = 25           C4 = Answer 
 

 

b. Mr. Brown bought 3,587 acres of land to given to his seven children. Compute 
 for the quotient on how many acres of land he can give to his children. 
 

 
 
c.       The Rotary Club of Port Moresby brought 880 pieces of blankets, 500 sacks of 
 rice, 2000 bottled water and 250 boxes of tin fish to the affected area of the 
 typhoon. There were about 250 families waiting for the Rotary for their 
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donations. Compute on how many blankets, sacks of rice, bottled water and 
boxes of tin fish will be given for each family. 

 
 

 
 

Answer to Practice  17 
 
a. SUM 

1. Click the Auto Sum function 

2. Select SUM, and press the Enter Key. 

3. Check if the cell references given were correct. Press the Enter Key to 
 confirm. 

b. AVERAGE 

 1. Click the Auto Sum function 

 2. Select AVERAGE, and press the Enter Key. 

 3. Check if the cell references given were correct. Press the Enter Key to 
  confirm. 

c. COUNT 

 1. Click the Auto Sum function 

 2. Select COUNT, and press the Enter Key. 

 3. Check if the cell references given were correct. Press the Enter Key to 
  confirm. 

d. MAX 

 1. Click the Auto Sum function 

 2. Select MAX, and press the Enter Key. 
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3.       Check if the cell references given were correct. Press the Enter Key to       

confirm. 

e. MIN 

 1. Click the Auto Sum function 

 2. Select MIN, and press the Enter Key. 

 3. Check if the cell references given were correct. Press the Enter Key to 
  confirm. 
 
 

Practical Exercise 18 

 
 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

End of Topic 3. 

Now Do Exercise 3 in Assignment Book 3 Then Go to Topic 4. 
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  TOPIC 4 
 
 
 
 
 

SPREADSHEET 2 
 
 
 
 

 

LESSON 19: Creating a Chart from a Set of Data 

LESSON 20: Applying Different Styles of Chart 

LESSON 21: Applying Chart Lay Outs 

LESSON 22: Chart Components and Controls 

LESSON 23: Formatting Data Series (axis titles, colours 
and backgrounds) 

LESSON 24: Formatting Data Series (legends and labels) 

 
 
 
 

 

 

 

 

 

 



GR10 D&T-COMPUTING U3           180                   TOPIC INTRODUCTION 
 
TOPIC 4: GRAPHICAL REPRESENTATION OF DATA 

___________________________________________________________________ 

Today you are in danger of being overwhelmed by too much data which is the raw 
material of information. Charts are graphic, colorful, eye-catching, and mind-enriching 
which for thousands of years, has been a powerful way to convey what would 
otherwise be complex information.  

The Office Excel 2010 spreadsheet makes it easy to create dozens of different types 
of charts. You can create a chart from information gathered in almost of any 
spreadsheet. It is not an exaggeration to say that your ability to take advantage of 
Excel‘s charting capability will make you a more effective spreadsheet user. 

In this topic you will learn about the concepts of using chart in an Excel. A 
spreadsheet user can take advantage of charts that are based on the numbers 
stored in its rows and columns of cells. Charts enable the user to visualize the data. 
"A picture," as they say, "is worth a thousand words." By the same token, a well-
designed chart can help you make sense of a thousand numbers. Charts are also 
useful when you need to increase the impact of any oral or written presentation. 

The following will be studied: 

Lesson 19 creates a chart from a set of data. You will list down the steps in creating 
a chart from a set of data and to create chart from the given data. 

Lesson 20 applies different styles of chart. You will discuss the steps in applying 
different styles of charts in an Excel sheet, to use different chart styles and to discuss 
the importance of applying different styles of charts. 

Lesson 21 applies chart lay outs. You will discuss the different chart lay outs, to list 
down the steps in applying charts lay outs in an Excel sheet, to use and apply the 
different chart lay outs and to discuss the importance of applying chart lay outs. 

Lesson 22 uses chart components and controls. You will list the steps in using chart 
components and controls, the use of chart components and controls and to discuss 
the importance of using chart components and controls in an Excel sheet. 

Lesson 23 formats data series (Axis Titles, Colors, and Backgrounds). You will 
enumerate the steps in formatting data series, to format axis titles, colors and 
backgrounds and to discuss the importance of formatting data series in an Excel. 

Lesson 24 formats data series (legends and labels). You will enumerate the steps in 
formatting legends and labels in an Excel sheet to format legends and labels and to 
discuss the importance of formatting legends and labels in an Excel sheet. 

By the end of Topic 4, you should be able to know how to create a chart from a set of 
data, to apply different styles of chart, apply chart lay outs, to use chart components 
and controls, to format data series (axis titles, colours and backgrounds) and to 
format data series (legends and labels). 
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Lesson 19: Creating a Chart from a Set of Data 

___________________________________________________________________ 

 
 
 
 
 
 
 
 
 
______________________________________________________________________ 

Creating a chart 
Once a table has set up, the information in the table can easily be turned into one of 
several different chart types. These include:  

• Column and bar graphs  

• Line graphs  

• Pie charts  

Creating a chart in Excel involves following the steps below:  

1.  Select the data to be included in the chart.  

2.  The selection should include table headings. Excel can use headings as labels 
 on the chart.  

3.  The selection should not include totals.  

4.  Begin the chart wizard which will prompt you for details about the chart.  

5.  Customize the completed chart.  

The values represented in a chart are called a data series or a data set. In the chart 
you are about to create, numbers in the given days ranges (A, B, C, etc.) will be 
represented by bars. The chart will have a title and a legend with names descriptive 
of the data series. Most charts, except pie charts, have axes, which are the 
perpendicular lines along which the data are plotted or displayed. The Y axis is the 
vertical axis (running from top to bottom). The X axis is the horizontal axis (running 
from left to right). To create a chart in Excel, you must first designate the set of cells 
in the spreadsheet that you want included in the chart. This is called the chart range. 
Select the Chart Range now. Follow the steps on the next page to select a chart 
range. 

 

 

Welcome to Lesson 19 of Unit 3. In Lesson 18, you learned to 
copy data or formula and the importance of copying data or 
formula in an Excel sheet. 

In this lesson, you will be able to enumerate the steps in 
creating a chart from a set of data and to create chart from a 
given data set. 
 
       Your Aim: 

 identify the steps in creating a chart from a set of 
data 
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1. Select by dragging and highlighting, cells A1 through F2. 

 

 
 

 
                       To drag cells A1 through F2 
 
 Check out each of the 7 categories of charts. 
 
2. In the Insert Ribbon  Charts Group, click on the Column charts icon and 
 look at the 19 different types of Column Charts you can make. 
 

 
The Column Charts 

 

2 
1 

Y 
Axis 

X Axis 
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Please review our Design and Technology – Computing for Grade 9, Spreadsheet 1 
on Lesson 23 about Creating a Graph with Chart Wizard. 
 
3. Click on the Line charts icon and look at the 7 different types of Line Charts 
 you can make. 

 

 
The Line Charts. 

 
4. Click on the Pie charts icon and look at the 6 different types of Pie Charts you 
 can make. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Pie Charts. 
 
 

5. Click on the Bar charts icon and look at the 15 different types of Bar Charts 
 you can make. 
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The Bar Charts. 
 
6. Click on the Area charts icon and look at the 6 different types of Area Charts 
 you can make. 

 

 
The Area Charts. 

 
7. Click on the Scatter charts icon and look at the 5 different types of Scatter 
 Charts you can make. 
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The Scatter Charts. 

 
8. Click on the Other charts icon and look at the 15 different types of Charts you 
 can make. 

 

 
The Other Charts. 

 
Begin to type your data into your blank worksheet. 
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No matter what type of chart or graph you are creating, the first step in creating an 
Excel chart is always to enter the data into the worksheet.  

When entering the data, it helps to keep a few simple rules in mind: 

 a. Do not leave blank rows and columns when entering your data. If you 
 do leave a blank row, it will make it harder to use the Excel Chart 
 Wizard. While it is possible to include individual rows or columns, it 
 makes creating the chart a bit trickier than if the data  is altogether. 

 b. Enter your data in columns whenever possible. When laying out 
 your spreadsheet, list the names describing the data in one column 
 and, to the right, the data itself. If there is more than one data 
 series, list them one after the other in columns  with the title for each 
 data series at the top. 

Steps in Creating a Chart 
Follow the steps below on how to create a chart in Microsoft Excel. 
1. Click and hold down the left mouse button over one corner cell of your 
 spreadsheet data. 
2. Drag the mouse pointer over the data to select it. 

 
Note: Be sure to include any column and row titles that you want to 
include in the Chart. 
 

 Highlight the block of cells from A3 to B12, which includes the column titles, 
 Location and January. 
 

Do not leave blank 
rows and columns 

http://spreadsheets.about.com/od/uvw/g/worksheet_def.htm
http://spreadsheets.about.com/od/glossary/g/row_definition.htm
http://spreadsheets.about.com/od/c/g/Column_defined.htm
http://spreadsheets.about.com/od/c/g/chart_wiz_def.htm
http://spreadsheets.about.com/od/c/g/chart_wiz_def.htm
http://spreadsheets.about.com/od/d/g/data_definition.htm
http://spreadsheets.about.com/od/s/g/spreadsheet_def.htm
http://spreadsheets.about.com/od/d/g/data_definition.htm
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   Note: If you want to create charts that are a bit more exotic, choose 
   the Custom Types tab at the top of the Chart Type dialog box. 

 
3. Choose Insert  Chart from the menu. 

 
     The Insert Menu. 

4. Pick a Chart on the Standard Tab. 

5. Pick a Chart type from the left panel  

6. Pick a chart sub-type from the right panel   

 
 
 
 
For our data 
(On the Standard Chart Types tab) 

7. Choose the Column chart type in the left hand pane. 

8. Choose the Clustered Column chart sub-type in the right hand pane.  

9. Click Enter. 

 

http://spreadsheets.about.com/od/c/g/chart_def.htm
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10. Save your work with filename Country. 
___________________________________________________________________ 

Activity 1: Name the following Standard symbols for creating Charts. 

 

 

  
 
 

 
 
1. ____________________________________________________ 
 
2. ____________________________________________________ 

A preview of the 
Chart for January. 

 

1   2 3 4 5 6 7 

7 

8 
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3. ____________________________________________________ 
 
4. ____________________________________________________ 
 
5. ____________________________________________________ 
 
6. ____________________________________________________ 
 
7. ____________________________________________________ 
 
 
Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your Answer. Make sure you do the necessary corrections before moving on to 
the next part of this lesson. 
___________________________________________________________________ 

 
Summary 
You have come to the end of Lesson 19. In this lesson, you 
learned to enumerate the steps in creating charts from a set of 
data. 
 

___________________________________________________________________ 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NOW DO PRACTICE EXERCISE 19 ON THE NEXT PAGE. 
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CHECK YOUR WORK. ANSYOURS ARE AT THE END OF TOPIC 4. 
 

 

Practice Exercise  19 

___________________________________________________________________ 

A. Write T if the sentence is correct and F if it is false. 
 
1. The values represented in a chart are called a data series or a data set.  
          __________ 

2. The Y axis is the vertical axis (running from top to bottom).  __________ 

3. The X axis is the horizontal axis (running from left to right).  __________ 

4. Chart range is the set of cells in the spreadsheet that you want to include in 
 the chart.         __________ 

5. Column chart has 19 different types of Charts.    __________ 

6. Line chart has 6 different types of Charts.    __________ 

7. Do not leave blank rows and columns when entering your data. If you do leave 
 a blank row, it will make it harder to use the Excel Chart Wizard.  __________ 

8. The first step in creating an Excel chart is always to enter the data into the 
 worksheet.         __________ 

9. Other charts have 17 different types of Charts.    __________ 

10. Most charts, except pie charts, have axes, which are the perpendicular lines 
 along which the data are plotted or displayed.    __________ 

 

B. Write steps on how to create a Chart. 

1. ______________________________________________________________ 

2. ______________________________________________________________ 

3. ______________________________________________________________ 

4. ______________________________________________________________ 

5. ______________________________________________________________ 

6. ______________________________________________________________ 

7. ______________________________________________________________ 

8. ______________________________________________________________ 

9. ______________________________________________________________ 

 

http://spreadsheets.about.com/od/glossary/g/row_definition.htm
http://spreadsheets.about.com/od/c/g/Column_defined.htm
http://spreadsheets.about.com/od/c/g/chart_wiz_def.htm
http://spreadsheets.about.com/od/uvw/g/worksheet_def.htm
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Answers to Activity 
 
1. Column Chart 

2. Line Chart 

3. Pie Chart 

4. Bar Chart 

5. Area Chart 

6. Scatter Chart 

7. Other Charts 
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Lesson 20: Applying Different Styles of Chart 

___________________________________________________________________ 

 
 
 
 
 

 
 
 
 
 
 
 
____________________________________________________________________ 

Charts and Graphs 
The Excel charting capability 
Today, you are in danger of being overwhelmed by a superabundance of data—the 
raw material of information. Charts—graphic, colorful, eye-catching, mind enriching—
have, for thousands of years, have been a powerful way to convey what would 
otherwise be complex information. The Office Excel 2010 spreadsheet makes it easy 
to create dozens of different types of charts. You can create a chart from information 
gathered in most of any spreadsheet. It is not an exaggeration to say that your ability 
to take advantage of Excel‘s charting capability will make you a more effective 
student. 

Creating a Column chart 
The values represented in a chart are called a data series or a data set. In the chart 
you are about to create, the number of students in the various grade ranges (A, B, C, 
etc.) will be represented by bars. The chart will have a title and a legend with names 
descriptive of the data series. Most charts, except pie charts, have axes, which are 
the perpendicular lines along which the data are plotted or displayed. The Y axis is 
the vertical axis (running from top to bottom). The X axis is the horizontal axis 
(running from left to right). To create a chart in Excel, you must first designate the set 
of cells in the spreadsheet that you want included in the chart. This is called the chart 
range.  

Charts and graphs are a great way of representing your data. Microsoft Excel 2010 
offers almost every chart type and makes it easier to draw them so that your data can 
quickly be understood in a graphical format. In this lesson, you will learn what each 
chart and graph represents and the additional functionality that you might not have 
heard about.  

1. Make sure that there are some data in your Excel sheet and that  your Excel 
 sheet does not contain any blank cells between the different  columns. Please 
 refer to our Lesson 19 and follow the steps.

 

 

Welcome to Lesson 20 of Unit 3. In Lesson 19, you learned 
the steps in creating a chart. 

In this lesson, you will be able to enumerate the different 
styles of charts, the steps in applying different styles of 
charts in an Excel sheet and to discuss the importance of 
applying different styles of charts 
      Your Aims: 

 identify the different styles of charts 
 identify the steps in applying the different 

styles of chart 

 identify the importance of applying different 
styles of chart 
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2. Click the Insert menu and choose the chart type that you wish to draw. 

 

 
The data in your Excel sheet will be organized as a chart. 

3. Once the chart is drawn, it becomes very easy to change the attributes: Right 
 click the chart and you will see the options for changing chart types, data and 
 other formatting. 
 

 
 
 
 
 
 
 
The charts or graph type will depend on the data for which you are going to plot the 
chart. The most commonly used types include Column Chart, Line Graphs, Pie Chart, 
Bar Graph, Area Chart, Scatter Graphs, Stock Chart and Surface Chart among many 
others. Let us discuss these chart types and the situations in which a specific chart 
type is used. 

The Column Chart 
The Column chart is one of the most commonly used chart type and is used to show 
the changes in data over a period of time or illustrate comparisons among items. As 
you discussed earlier, the steps on how to choose a certain chart by clicking the 
Insert Menu and choose Column Chart as your practice chart. 
 

 
The Column Chart Menu. 
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After clicking the Column chart menu, varieties of column chart designs will appear. 

 
 
 
 
 

   Sample of the Column Chart. 

 
 
 
 

The types column chart. 
 

The Line Graphs 
Line Graphs are mainly used to plot changes in data over time.  

 

 
The Line Chart Menu. 

 
The types Line chart. 
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The best example of this chart type can be the weekly change in temperature. 
 

 
   The Line Graph. 

The Pie Chart 
The pie Chart is very useful when you wish to emphasize on a significant element in 
the data. It represents data in the form of pie. 

 

 
 
 
 
 
 
 

The Pie Chart Menu. 
 

 
 
 
 
 
 
 
 
 
 
 
 

 The Pie Chart. 
 
 
 
 
 
 
 
 
 
 

                        The types of Pie chart. 
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The Bar Graph 
A bar illustrates comparisons among individual items. 
 

 
 
 
 
 
 
 

The Bar graph menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

  Sample of a Bar Graph. 

 
 
 
 
 
 
 
 
 
 
 

                        The types of Bar graph. 
 

The Area Chart 
An area chart diplays the magnitude of change over time. 

 
 
 

 

 

The Area Menu. 

 
 
 



GR10 D&T-COMPUTING U3           197       TOPIC 4 LESSON 20  
 

 
               Sample of an Area Chart. 

 
 
 

 
     The types of Area chart. 
 
The Scatter Graphs 
The Scatter Graph and Line Chart are almost similar, but the Scatter Graph is 
displayed with a scribble line whereas the Line Graph uses connected lines to display 
data. 

 
 
 
 
 
 
 
 

The Scatter menu. 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

         Sample of a Scatter Graph. 

 
 
 
 
 

The types of Scatter chart. 
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The Surface Charts 
A surface chart comes in handy if you are to determine the optimum combination 
between two sets of data. The Surface chart is under the Other Charts Menu. 
 

 
 
 
 
 

The Other charts menu. 
 

 

Sample of a Surface Chart under the Other Charts menu. 

 

 

 

 

The different charts under the Other Charts Menu. 

The Chart Plot Area 
The area that is covered by a specific chart is called the Chart Plot Area. By default 
Excel draws charts according to the default configuration, but it is very easy to edit 
the plot area. Simply right click the chart and choose the Format Plot Area option. 
Now you will see a dialogue box which lets you see the chart‘s fill style, borders, Glow 
and Soft Edges, and 3-D effects. 
 
 

  
 

 
 
 

 

 

 
   
          

The Format Plot area.
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Activity 1: Match Column A to Column B. 
 
  
 

 Column A      Column B 
 

__________1.    a. Line Graph 
 

_________2.               b. Pie Graph 
 

_________3 .    c. Column Chart 
 

_________4 .    d. Surface Chart 
 

_________5 .    e. Scatter Graph 

_________6 .    f. Area Chart 
 

_________7.               g. Bar Graph 
 
 
Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your Answer. Make sure you do the necessary corrections before moving on to 
the next part of this lesson. 
___________________________________________________________________ 

 
Summary 
You have come to the end of Lesson 20. In this lesson, you learned 
to identify different styles of charts and identify the importance of 
applying different styles of chart. 

___________________________________________________________________ 

NOW DO PRACTICE EXERCISE 20 ON THE NEXT PAGE. 
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CHECK YOUR WORK. ANSYOURS ARE AT THE END OF TOPIC 4. 
 

 

Practice Exercise 20 
__________________________________________________________________ 

A. Write the correct names for the given charts. 
 Column   Line   Pie   Bar   
 Area   Scatter  Other Charts 
 

1.   ______________________ 
 

2.     _________________________ 
 

3.     _________________________ 
 

4.    _________________________ 
 

5.    _________________________ 
 

6.    ________________________ 
 

7.    ________________________ 

 
 

 

Answers to Activity 

1. c 
 
2. e 
 
3. d 
 
4. g 

 
5. b 
 
6. a 

7. f 
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Lesson 21: Applying Chart Lay Outs 

___________________________________________________________________ 

 
 
 
 
 

 
 
 
 
 
 

 

___________________________________________________________________ 

The Chart Tools 

You can easily change the Style of your chart. If you cannot see the Styles, click 
anywhere on your chart to select it, and you should see the Ribbon change.  

 

The Chart Lay Outs 
You can also change the Lay out of your chart in the same way. Locate the Chart 
Layout panel on the Design tab of the Excel 2010 Ribbon bar. Chart Lay out will bring 
life to our chart by choosing the different lay out design. 

1. As mentioned earlier, highlight the columns and data that you want to 
 make a chart and from the Ribbon bar, choose Insert Menu for your chart. 

 

Welcome to Lesson 21 of Unit 3. In Lesson 20, you learned 
different styles of charts; identify the steps applying the 
different styles of chart and the importance of applying 
different styles of chart. 

In this lesson, you will be able to discuss the different chart 
lay outs, enumerate the steps in applying chart lay outs in an 
Excel sheet and the importance of applying chart lay outs. 
 

     Your Aims: 
 identify the different lay outs of charts 
 identify the steps in applying chart lay outs 

 identify the importance of applying chart lay 
outs 

 

 

1. Click the Chart. 

 

2 
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To start to make a new Chart. 

 
2. Choose Column Menu from the Insert Menu and for this January Chart you 
 will use 2-D Column which is the Clustered Column. 
 
3. Click Enter or click the left button of your mouse to see the result for your 
chart. 
 

 
The Column Menu for creating a Chart. 

 
 
 

1 

2 
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The Design Layout 
Choosing from any of this Design Layout will give you variety of colours to choose for 
your Column chart. Design Layout will give us the different colour aspect of the chart. 
Try to click each of the design and you will see the change of the color for the chart. 

 

 
The January Chart using the 2-D Column Chart. 

 

 
 
The Lay out menu 
Follow the steps below on how to use the Lay out menu. 

 

 
The Lay out menu. 

 
 
 

1.  
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3.       Clicking the drop down arrow of the Chart Title from the Lay out menu will 
 change the title of your chart. 
 
2.  Try clicking the three options and you will see the different format design in 
 your chart. 

 

 
 
 
 
 
 

The Axis Titles menu. 

3.  Click the drop down arrow of Axis Titles menu. 
 

 
 The Primary Horizontal Axis Title for the Axis Title menu. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Primary Vertical Axis.  
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Title from the Axis Titles menu. 
 

For the Primary Vertical Axis Title, the vertical axis title will appear. Try clicking the 
different options and you will notice the different styles for the vertical axis title. 

The Legend Menu 
For the Legend Menu, this will change the appearance of the Legend title. Try 
clicking the Legend menu and you will see the different styles to choose for your 
chart. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Legend Menu. 
 
The Data Labels 
For the Data Labels, it is important to put the data labels in your chart to know the 
different values of the chart. 
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The Data Labels menu. 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Sample Data Labels menu. 
 

The Data Table menu 
The Data Table menu is another option for you to choose if you do not want the Data 
Labels menu in your chart lay out. The Data Table will show us the data you hve for 
your chart. You have two options to choose from the Data Table menu. 
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The Data Table Menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Sample Data Table.  
 

The Axes Menu 
For the Axes menu of the Lay out, you have two options to choose, either vertical 
axis or horizontal axis. These will give you a chart that will change the axis title either 
from your left going to your right of the chart. Display axis with numbers either in 
thousands, millions or billions. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                                                                                                                                                                                                                                             
The Axes menu. 
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     The Primary Horizontal Axis menu .    The Primary Vertical Axis menu. 
 

The Gridlines 
The Gridlines menu will give you lines as a background in your chart. 

 

  The Gridlines menu.            The Primary Horizontal Gridlines menu. 
 

 
The Primary Vertical Gridlines. 



GR10 D&T- COMPUTING U3           209       TOPIC 4 LESSON 21  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

         Sample chart using Gridlines.  
 

The Chart Layouts 
By choosing the Chart Tools for your chart, you can also see that the Ribbon Bar will 
change. 

 

From the Chart Layouts of the Chart Tools, you can choose variety of styles for your 
chart by clicking the options and clicking the down arrow for more chart layouts. 

 

 
The 11 options to choose for the chart styles. 

By clicking the chart options will automatically change chart styles of our chart too. 
Try to choose one of the styles and see your chart. 
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For Line Chart, the same steps and procedures apply as what you have for the 
Column Chart. 

 

 

 

 

 

 

 
Activity 1. Answer the questions. 
 

 

1. Write the steps on how to create a chart using the Chart Layout. 

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

___________________________________________________________________

__________________________________________________________________ 

2. Fill in the correct Answers on the spaces provided. 

a. From the Ribbon bar you can choose _______________ for the chart. 

b. If the chart will overlap the data in our Excel worksheet, you can move the 
 chart using the _______________. 

c. You can also place your chart in a different worksheet. Right click  anywhere 
 on your chart. Click the right button of your mouse and you see the  options to 
 select to _______________. 

d. If you want your chart in a new worksheet, select the first option. Then 
 delete the text "_______________" from the textbox, and then type a 
 name of your own.  
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 e.    You can resize a chart, and any elements on it, by moving your mouse 
 over the sizing handles. For the chart itself, the sizing handles are the 
 _______________in Excel 2010. 

Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your Answers. Make sure you do the necessary corrections before moving on 
to the next part of this lesson. 
___________________________________________________________________ 

 
Summary 
You have come to the end of Lesson 21. In this lesson, you 
learned to identify the different layout of charts, the steps in 
applying chart layouts and the importance of applying chart 
layouts. 

___________________________________________________________________ 
 

 

 

 

 

 

 

NOW DO PRACTICE EXERCISE 21 ON THE NEXT PAGE. 
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CHECK YOUR WORK. ANSYOURS ARE AT THE END OF TOPIC 4. 
 

 

Practice Exercise  21 

___________________________________________________________________ 

A. Using the 11 options of the Chart Layouts (Column) options, show your 
 charts for January, April, July and October. Highlight your worksheet 
 data from A3 through E12. You should have 11 different charts for this 
 practice exercise. 

 

 
 

Answers to Activity 

1.  

a. Highlight the data to create the chart.  

b. Choose Insert Menu from the Ribbon.  

c. Choose the Column Chart from the Charts menu options.  

d. Chart will appear after clicking the right button of the mouse or the Enter key. 

d. Click anywhere on your chart to select. 

e. Choose Column menu from the Chart Tools. 

f. Choose any chart styles from the 11 options of the Chart Layouts. 
 
2.  
 
a. Insert More 
 
b. Mouse 
 
c. Move Chart 
 
d. Chart1 
 
e. Dots around the edges of the chart 
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Lesson 22: Using Chart Components and Controls 
___________________________________________________________________ 
 
 
 
 
 

 
 
 
 
 

 

 

 

___________________________________________________________________ 

To Move and Resize a Chart 
You might see that your chart from the previous lesson is covering your data. Your 
chart is overlapping the data. The importance of the chart components and controls 
is to move the chart from different locations to avoid overlapping the data and other 
charts. Follow the steps below on how to move and resize a chart. 

To Move a Chart 
Follow the steps below on how to move a chart: 
 
1.  To move it, hold your mouse over the chart until your cursor changes shape. 
 

 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
Welcome to Lesson 22 of Unit 3. In Lesson 21, you learned 
to identify the different lay outs of charts, identify the steps in 
applying chart lay outs and the importance of applying chart 
lay outs. 

In this lesson, you will be able to list the use of chart 
components and controls, uses of chart components and 
controls and the importance of using the chart components 
and controls. 

     Your Aims: 
 identify chart components and controls 
 identify the steps in using chart components 

and controls 

 determine the importance of using chart 
components and controls. 
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2.  Press and hold down the mouse button when your cursor looks like this,      
 and then drag your chart to a new location. In the image below, you have 
 placed the chart below the data. 

 

3.  You can also place your chart in a different worksheet. To do this in Excel 
 2010, right click anywhere on your chart. Click the right button of your mouse 
 and you see the options to select to Move Chart. 

 
To move Chart. 

 Click the Move Chart option and this will appear on your worksheet. 
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4.  If you want your chart in a new worksheet, select the first option.  

5.  Delete the text "Chart1" from the textbox, and then type a name of your 
 own.  

 If you look along the bottom of Excel, you'll see Sheet1, Sheet2, and Sheet3. 
 Your data is in Sheet1. If you click the drop down list to the right of Object in 
 on the dialogue box above, you will see the other worksheets you have open.  

6.  You can select one from the list and click OK. But for this first chart, leave it in 
 Sheet1. 

To Resize an Excel Chart 
Follow the steps below on how to resize your chart: 
 
1.  You can resize a chart, and any elements on it, by moving your mouse over 
 the sizing handles. For the chart itself, the sizing handles are the dots around 
 the edges of the chart in Excel 2010. 

 

2.  When your mouse changes shape to a double-headed arrow, hold down your 
 left mouse button. Then drag to a new location. You can resize using the 
 corners, or the edges. 

The Chart Tools Menu 
Most charts, except pie charts, have axes, which are the perpendicular lines along 
which the data are plotted or displayed. The Y axis is the vertical axis (running from 
top to bottom). The X axis is the horizontal axis (running from left to right). 
 
To create a chart in Excel, you must first designate the set of cells in the spreadsheet 
that you want included in the chart. This is called the chart range. After this, follow 
the steps below to create a chart. 
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The Column Chart Styles. 

1.  Click the arrow down to the right of the Chart Lay Outs panels to see the 
 available Design you can choose from. 

 
The Drop Down Arrow for the Column Chart Styles. 

 

2.  Next to Design Menu is the Lay Out Menu of the Chart. 

 

 The Lay Out menu is a bit big for this page, so you split it into six. But the 
 chart  Lay Out panel is split into a number of different sections and allows you 
 to change the information in the chart. 

1. Click the Chart. 

2 
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 For all versions of Excel, the first thing you may want to do is to give your 
 chart a name. 

 To change the name of your chart in Excel 2010, locate the Properties panel 
 on the Layout menu. 

 

3.  Highlight the default name in the text box and type a new name. 

 

4.  If you click away from your chart, and the click back on it, you will notice the 
 name of the chart change. 
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5. For Axes, there are two menus to choose from the Axes and the   Gridlines. 
The Axes can change the format layout of each axis whilst the Gridlines will 
turn the gridlines of your chart on and off. Try to click an option on this menu 
and watch what happens to your chart. 

 

 
 

 
The Primary Horizontal Axis for Axes Menu Options. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Primary Vertical Axis for Axes Menu Options. 

6.  For Analysis, the Trendline and the Error Bars are the two highlighted. This 
 is to add either a Trendline or an Error Bars to the chart. Try to click an option 
 on the menu and watch what happens to your chart. Click the undo        button 
 if you are not satisfied with the outcome. 
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The Result of your Chart after using the Lay Outs Options 

 

 
Activity 1. Answer the following. 

 

1. Name the five options for the Labels options from the Layout Menu of the 
 Chart Tools. 

a. _____________________________________ 

b. _____________________________________ 

c. _____________________________________ 

d. _____________________________________ 
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e.         _____________________________________ 

2. Change your Chart by using the Axis Title for the horizontal and vertical title of 
 your Chart. 

a. For the horizontal title (World Cities), click the Primary Horizontal Axis 
 Title Options, click the Pattern Fill and choose the Foreground Color 
 (orange) and the Background Color (Green). Choose Large Checker Board 
 from the Pattern Fill. 

b. For the vertical title (Average Precipitation), click the Primary Vertical 
 Axis Title, choose Horizontal Title. 

Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your Answers. Make sure you do the necessary corrections before moving on 
to the next part of this lesson. 
___________________________________________________________________ 

 
Summary 
You have come to the end of Lesson 22. In this lesson, you 
learned to identify the different chart components and controls, 
the steps in applying chart components and controls and the 
importance of chart components and controls. 

 
___________________________________________________________________ 
 

 

 

 

 

 

 

 

 

 

 

 

NOW DO PRACTICE EXERCISE 22 ON THE NEXT PAGE. 
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CHECK YOUR WORK. ANSYOURS ARE AT THE END OF TOPIC 4. 
 

 

Practice Exercise  22 

___________________________________________________________________ 

A. Using your data from January, April, July and October (A3 through E12). 
 Use the Bar Chart to create a chart and use Axes and Gridlines. 

 

 

 
 

 

 

Answer to Activity 

1.  The five option menu for the Label options for the Layout Menu of the 
 Chart Tools. 

a. Chart Title 

b. Axis Title 

c. Legend 

d. Data Labels 

e. Data Table 

2. Change the Chart by using the Axis Title for the horizontal and vertical 
 title of your Chart. 
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GR10 D&T- COMPUTING U3           223       TOPIC 4 LESSON 23  
 
Lesson 23: Formatting Data Series (Axis Titles, Colours and 
   Backgrounds) 
___________________________________________________________________ 
 
 
 
 
 

 
 
 
 
 
 

 

 

___________________________________________________________________ 

Axis Titles, Colours and Backgrounds 
From Lesson 19 you defined data series or data set as the values represented in a 
chart. In the chart you are about to create, numbers in the given days ranges (A, B, 
C, etc.) will be represented by bars. 

It is important to learn how to format axis titles, apply colour and background to a 
chart as this will define more accurately all the data that is being plotted. It will 
highlight the importance of each part of the chart as emphasis will be shown with 
proper application of colours and backgrounds. 

The chart will have a title and a legend with names descriptive of the data series. 
Most charts, except pie charts, have axes, which are the perpendicular lines along 
which the data are plotted or displayed. The Y axis is the vertical axis (running from 
top to bottom). The X axis is the horizontal axis (running from left to right). To create 
a chart in Excel, you must first designate the set of cells in the spreadsheet that you 
want included in the chart. This is called the chart range. Select the Chart Range 
now. 

 
 
 
 
 
 
 
The next item on the Labels panel is the Axis Title. Click down the arrow to see 
options. 

 
Welcome to Lesson 23 of Unit 3. In Lesson 22, you learned to 
identify the chart components and controls, identify the steps 
in using chart components and controls and the importance of 
using chart components and controls. 

In this lesson, you will be able to enumerate the steps in 
formatting data series, format axis title, colours and 
backgrounds and the importance of formatting data series in 
an Excel sheet. 

     Your Aims: 
 define data series 
 identify the steps in formatting axis titles, 

colours and backgrounds 
 determine the importance of formatting axis 

titles, colours and backgrounds 
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At the moment, your chart has no Axis Title. It only ha s cities running across the 
bottom. Someone looking at the chart will not know what the cities represent. Here is 
what your chart looks like at the moment. 

 

To add an Axis Title 
Follow the steps below on how to add an axis title: 

1.  Click on Primary Horizontal Axis Title from the sub menu 

2.   Click Title Below Axis. 

 

 

 

 

 

 

 After clicking the  Title Below Axis or Primary Horizontal, a new title will be 
 added to the chart. 

3 2 1 
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3.  Highlight the default text, and type your own Title. Type World Cities. 

 

4.  Click away from the chart to see what it looks like. 

 

 Now, you have some explanation for what the numbers represent. You can 
 add a Vertical Axis, as well.  

5.  Click on the Primary Vertical Axis Title. Type Average Precipitation. 

 

 

 

 

 

 

 

 
Result after typing the Title. 
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Axis Colours and Backgrounds 
From Axis Title Menu Options, you can format your title by changing colours and 
backgrounds.  
 
Click  More Options at the very end of the menu options. If you are working with 
Axis Title, drag your mouse to the last menu options and choose More Options. You 
can format the data series either by title, legends, data labels, axes, gridlines and plot 
area. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
There are many options to choose for this More Options menu. The first option is the 
Fill, wherein you can format your data by changing the colours and backgrounds.  
 
Follow the steps below on how to format your data by using Fill: 
 
1. Click Axis Title. 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
2. Highlight the Axis Title and type Different Cities. 
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3.  You can format this axis title by clicking Pattern Fill from the More Options. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 There are two options to choose from, the Foreground Colour and the 
 Background Colour.  
 
 

 
 
 
 

 
 
 
 
 
 
 
 
 
 

 
4.  Try to click all the Fill options to see how it works with your title.  
 
5.  Click Close if you are done. 
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Activity 1: Name the “More Options”. Write your Answers on the 
spaces provided. 
 

 
 

 
 
 

a. _______________________ 
 
b. _______________________ 
 
c. _______________________ 
 

d. _______________________ 
 
e. _______________________ 
 
f. _______________________ 

 
Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your Answers. Make sure you do the necessary corrections before moving on 
to the next part of this lesson. 
___________________________________________________________________ 

Summary 
You have come to the end of Lesson 23. In this lesson, you 
learned to define data series, identify the steps in formatting axis 
titles, colours and backgrounds and the importance of formatting 
axis titles, colours and backgrounds. 
 

___________________________________________________________________ 
 

 
 

 
 
 
 
 
 
 

NOW DO PRACTICE EXERCISE 23 ON THE NEXT PAGE. 
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CHECK YOUR WORK. ANSYOURS ARE AT THE END OF TOPIC 4. 
 

 

Practice Exercise  23 
___________________________________________________________________ 

A. From your given Excel worksheet, you already have your practice for the 
 month of January. Make 3 charts for April, July and October. Follow the 
 steps for the Lay Outs. 

 

___________________________________________________________________ 

 
 

Answers to Activity 
 
1. 
 
a. No fill 
 
b. Solid fill 
 
c. Gradient fill 
 
d. Picture or texture fill 
 
e. Pattern fill 
 
f. Automatic 
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Lesson 24: Formatting Data Series (Legends and Labels) 

___________________________________________________________________ 

 
 
 
 
 

 
 
 
 
 
 

 

___________________________________________________________________ 

Legend and Labels 
Legend and labels are equally important in formatting your chart as these will identify 
the identity of what the chart is all about. 

The Labels panel on the Lay Out menu lets you format the titles and legends on your 
chart, while the Legend panels represent the sub title of the chart from the given 
data of the Excel. Follow the steps below on how to use the Legends and Labels:  

 

 

 

 

 

The Labels Panel. 

 

1.  Click each item on the menu in turn to see what they do.  

2.  Then click More Title Options. The following dialogue box will appear.

 

Welcome to Lesson 24 of Unit 3. In Lesson 23, you learned 
to define data series, identify the steps in formatting axis 
titles, colours and backgrounds and the importance of 
formatting axis titles, colours and backgrounds. 

In this lesson, you will be able to enumerate the steps in 
formatting legends and labels, format legends and labels and 
the importance of formatting legends and labels. 

     Your Aims 
 identify the steps in formatting legends and 

labels 
 determine the importance of formatting 

legends and labels 
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 As you can see, there are options to change the Fill, Line Style, Shadow, 3-D 
 Format and Alignment. Play around with the options on the dialogue box to 
 see what they do. The only thing you are changing here is the Chart Title.  

3.  Click Close when you are done.  

4.  If you do not like what you see, click the undo   arrow at the top of the 
 Excel. 

The Chart Legend 
The Chart Legend enables the user to provide legend to the chart to signify what the 
data present in the chart. Continuing the steps from your previous lesson, do the next 
steps to change and add legends. 
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At the moment, your Legend is on the right of the Chart. But you can move this.  

5.  Click the Legend item on the Layout panel to see the various options. 

 

6.  Click an option on the menu and watch what happens to your legend. You 
 should see it move around the chart. Suppose you will choose Show Legend 
 At Bottom, this will appear in your chart. 

  

 A Data Label is information overlaid on the chart bars. Since in our chart it 
 does not have an over laid data, you can apply and put the data label on it. 
 Here is the illustration on how the Data Label works. 

 

 Put the values for each city by clicking the Outside End. 
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 You can also see the options if you click More Data Label Options from the 
 menu.  
 
 A Data Table is to add a Data Table in your chart. You have three options for 
 this menu.           

 

 

 

 

 

 

1.  Click an option on the menu and watch what happens to your chart.  

2.  Click the undo  button if you are not satisfied with the outcome. 

___________________________________________________________________ 

Activity 1:  Choose January and April for the chart. Use Line chart,                  
create a title by typing Only for Two Months, use Legend option and 
click Show legend on Top. 
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Thank you for completing this activity. Now, you may go to the end of this lesson to 
check your answers. Make sure you do the necessary corrections before moving on 
to the next part of this lesson. 
___________________________________________________________________ 

 
Summary 
You have come to the end of Lesson 24. In this lesson, you 
learned to identify the steps in formatting legends and labels and 
determined the importance of formatting legends and labels. 
 

___________________________________________________________________ 
 

 
 

     

 
 
 
 
 
 
 
 
 

NOW DO PRACTICE EXERCISE 24 ON THE NEXT PAGE. 
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CHECK YOUR WORK. ANSYOURS ARE AT THE END OF TOPIC 4. 
 

 

Practice Exercise  24 

___________________________________________________________________ 
 
A. Follow the instructions. 
 
1.  Type the following given data in Excel worksheet: 

 Cell - Data    

 A1 - The Cookie Shop 2012 Revenue from Sales 

 A2 - Peanut Butter    

 A3 - Chocolate Chip    

 A4 - Oatmeal Raisin    

 A5 - Lemon    

 B2 - 15,500    

 B3 - 27,589    

 B4 - 24,980    

 B5 - 14,768    

 
2. Use Pie chart to create your chart. Create a title by typing on Top the Cookie
 Shop 2012 Revenue Sales. Show your Legend at the bottom of the chart. 
 

 
 

Answers to Activity 
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Answers to Practice Exercises 

___________________________________________________________________ 
 
Practice Exercise 19 
 
A. True or False 
 
1. True     6. False, 7 
 
2. True     7. True 
 
3. True     8. True 
 
4. True     9. False, 15 
 
5. True     10. True 
 
B. Steps in creating a Chart 
 
1. Click and hold down the left mouse button over one corner cell of your 
 spreadsheet data. 
 
2. Drag the mouse pointer over the data to select it. Highlight the block of cells 
 from which includes the column titles. 

 

3. Choose Insert, Chart from the menu. 
 

4. Pick a Chart on the Standard Tab. 
 
5. Pick a Chart type from the left panel.  
 
6. Pick a chart sub-type from the right panel. 
 
7. Choose the Column chart type from the Standard Chart Types in the left hand 
 +pane. 
 
8. Choose the Clustered Column chart sub-type in the right hand pane.  
 
9. Click Enter. 
 
 
Practice Exercise 20 
 
1. Column 
 
2. Scatter 
 
3. Line 
 
4. Pie 

 
5. Bar 
 
6. Other Charts 
 
7. Area 
 

 

http://spreadsheets.about.com/od/s/g/spreadsheet_def.htm
http://spreadsheets.about.com/od/d/g/data_definition.htm
http://spreadsheets.about.com/od/c/g/chart_def.htm
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Practice Exercise  21 
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Practice Exercise  22 

Possible Answer for this Practice Exercise using the Axes and Gridlines. 

 

 

Practice Exercise  23 

For April 
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For July 

 

For October 
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Practice Exercise  24 
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GLOSSARY 

3-D reference 
A reference to a range that spans two or more worksheets in a workbook. 
3-D walls and floor 
The areas surrounding many 3-D chart types that give dimension and boundaries to 
the chart. Two walls and one floor are displayed within the plot area. 
Activate 
To make a chart sheet or worksheet the active, or selected sheet. The sheet that you 
activate determines which tabs are displayed. To activate a sheet, click the tab for 
the sheet in the workbook. 
Active Cell 
The selected cell in which data is entered when you begin typing. Only one cell is 
active at a time. The active cell is bounded by a heavy border. 
Active Sheet 
The sheet that you're working on in a workbook. The name on the tab of the active 
sheet is bold. 
Address 
The path to an object, document, file, page, or other destination. An address can be 
a URL (Youb address) or a UNC path (network address), and can include a specific 
location within a file, such as a Word bookmark or an Excel cell range. 
Alternate Startup Folder 
A folder in addition to the XLStart folder that contains workbooks or other files that 
you want to be opened automatically when you start Excel and templates that you 
want to be available when you create new workbooks. 
Argument 
The values that a function uses to perform operations or calculations. The type of 
argument a function uses is specific to the function. Common arguments that are 
used within functions include numbers, text, cell references, and names. 
Array 
Used to build single formulas that produce multiple results or that operate on a group 
of arguments that are arranged in rows and columns. An array range shares a 
common formula; an array constant is a group of constants used as an argument. 
Array Formula 
A formula that performs multiple calculations on one or more sets of values, and then 
returns either a single result or multiple results. Array formulas are enclosed between 
braces { } and are entered by pressing CTRL+SHIFT+ENTER. 
Associated Pivot table Report 
The PivotTable report that supplies the source data to the PivotChart report. It is 
created automatically when you create a new PivotChart report. When you change 
the layout of either report, the other also changes. 
Auto Format 
A built-in collection of cell formats (such as font size, patterns, and alignment) that 
you can apply to a range of data. Excel determines the levels of summary and detail 
in the selected range and applies the formats accordingly. 
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Axis 
A line bordering the chart plot area used as a frame of reference for measurement. 
The y axis is usually the vertical axis and contains data. The x-axis is usually the 
horizontal axis and contains categories. 
Base Address 
The relative path that Excel uses for the destination address when you insert a 
hyperlink. This can be an Internet address (URL), a path to a folder on your hard 
drive, or a path to a folder on a network. 
Border 
A decorative line that can be applied to worksheet cells or objects, such as charts, 
pictures, or text boxes. Borders distinguish, emphasize, or group items. 
Calculated Column 
In an Excel table, a calculated column uses a single formula that adjusts for each 
row. It automatically expands to include additional rows so that the formula is 
immediately extended to those rows. 
Calculated Field (Database) 
A field in the result set of a query that displays the result of an expression rather than 
data from a database. 
Calculated Field (Pivottable Report) 
A field in a PivotTable report or PivotChart report that uses a formula you create. 
Calculated fields can perform calculations by using the contents of other fields in the 
PivotTable report or PivotChart report. 
Calculated Item 
An item within a PivotTable field or PivotChart field that uses a formula you create. 
Calculated items can perform calculations by using the contents of other items within 
the same field of the PivotTable report or PivotChart report. 
Category Axis 
A chart axis that represents the category for each data point. It displays arbitrary text 
values like Qtr1, Qtr2, and Qtr3. It cannot display scaled numerical values. 
Category Field 
A field that's displayed in the category area of the PivotChart report. Items in a 
category field appear as the labels on the category axis. 
Cell 
A box formed by the intersection of a row and column in a worksheet or a table, in 
which you enter information. 
Cell Reference 
The set of coordinates that a cell occupies on a worksheet. For example, the 
reference of the cell that appears at the intersection of column B and row 3 is B3. 
Certifying Authority 
A commercial organization, or a group within a company, that uses tools such as 
Microsoft Certificate Server to provide digital certificates that software developers can 
use to sign macros and users can use to sign documents. 
Change History 
In a shared workbook, information that is maintained about changes made in past 
editing sessions. The information includes the name of the person who made each 
change, when the change was made, and what data was changed. 
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Chart Area 
The entire chart and all its elements. 
Chart Sheet 
A sheet in a workbook that contains only a chart. A chart sheet is beneficial when you 
want to view a chart or a PivotChart report separately from worksheet data or a 
PivotTable report. 
Column Field 
A field that's assigned a column orientation in a PivotTable report. Items associated 
with a column field are displayed as column labels. 
Column Heading 
The shaded area at the top of each Data pane column that contains the field name. 
Column Heading 
The lettered or numbered gray area at the top of each column. Click the column 
heading to select an entire column. To increase or decrease the width of a column, 
drag the line to the right of the column heading. 
Comparison Criteria 
A set of search conditions that is used to find data. Comparison criteria can be a 
series of characters that you want to match, such as "Northwind Traders," or an 
expression, such as ">300." 
Comparison Operator 
A sign that is used in comparison criteria to compare two values. The six standards 
are = Equal to, > Greater than, < Less than, >= Greater than or equal to, <= Less 
than or equal to, and <> Not equal to. 
Conditional Format 
A format, such as cell shading or font colour, that Excel automatically applies to cells 
if a specified condition is true. 
Consolidation Table 
The table of combined results that appears in the destination area. Excel creates the 
consolidation table by applying the summary function that you select to the source 
area values that you specify. 
Constant 
A value that is not calculated. For example, the number 210 and the text "Quarterly 
Earnings" are constants. An expression, or a value resulting from an expression, is 
not a constant. 
Constraints 
The limitations placed on a Solver problem. You can apply constraints to adjustable 
cells, the target cell, or other cells that are directly or indirectly related to the target 
cell. 
Copy Area 
The cells that you copy when you want to paste data into another location. After you 
copy cells, a moving border appears around them to indicate that they've been 
copied. 
Criteria 
Conditions you specify to limit which records are included in the result set of a query. 
For example, the following criterion selects records for which the value for the Order 
Amount field is greater than 30,000: Order Amount > 30000. 
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Criteria Pane 
The area of the window that displays the criteria used to limit the records included in 
the result set of your query. 
Current Region 
The block of filled-in cells that includes the currently selected cell or cells. The region 
extends in all directions to the first empty row or column. 
Custom Calculation 
A method of summarizing values in the data area of a PivotTable report by using the 
values in other cells in the data area. Use the Show data as list on the PivotTable 
Field dialogue for a data field to create custom calculations. 
Data Form 
A dialogue box that displays one complete record at a time. You can use data forms 
to add, change, locate, and delete records. 
Data Label 
A label that provides additional information about a data marker, which represents a 
single data point or value that originates from a datasheet cell. 
Data Marker 
A bar, area, dot, slice, or other symbol in a chart that represents a single data point 
or value that originates from a datasheet cell. Related data markers in a chart 
constitute a data series. 
Data Pane 
The area of the window that displays the result set of your query. 
Data Points 
Individual values that are plotted in a chart. Related data points make up a data 
series. Data points are represented by bars, columns, lines, slices, dots, and other 
shapes. These shapes are called data markers. 
Data Region 
A range of cells that contains data and that is bounded by empty cells or datasheet 
borders. 
Data Series 
Related data points that are plotted in a chart and originate from datasheet rows or 
columns. Each data series in a chart has a unique colour or pattern. You can plot one 
or more data series in a chart. Pie charts have only one data series. 
Data Series 
Related data points that are plotted in a chart. Each data series in a chart has a 
unique colour or pattern and is represented in the chart legend. You can plot one or 
more data series in a chart. Pie charts have only one data series. 
Data Source 
A stored set of "source" information used to connect to a database. A data source 
can include the name and location of the database server, the name of the database 
driver, and information that the database needs when you log on. 
Data Source Driver 
A program file used to connect to a specific database. Each database program or 
management system requires a different driver. 
Data Table 
A range of cells that shows the results of substituting different values in one or more 
formulas. There are two types of data tables: one-input tables and two-input tables. 
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Data Table in Charts 
A grid that can be added to some charts and contains the numeric data used to 
create the chart. The data table usually is attached to the horizontal axis of the chart 
and replaces the tick-mark labels on the horizontal axis. 
Data Validation 
An Excel feature that you can use to define restrictions on what data can or should 
be entered in a cell, and to display messages that prompt users for correct entries 
and notify users about incorrect entries. 
Database 
A collection of data related to a particular subject or purpose. Within a database, 
information about a particular entity, such as an employee or order, is categorized 
into tables, records, and fields. 
DDE Conversation 
The interaction between two applications that are communicating and exchanging 
data through special functions and code known as dynamic data exchange (DDE). 
Default Startup Workbook 
The new, unsaved workbook that's displayed when you start Excel. The default 
startup workbook is displayed only if you haven't included other workbooks in the 
XLStart folder. 
Default Workbook Template 
The Book.xlt template that you create to change the default format of new 
workbooks. Excel uses the template to create a blank workbook when you start Excel 
or create a new workbook without specifying a template. 
Default Worksheet Template 
The Sheet.xlt template that you create to change the default format of new 
worksheets. Excel uses the template to create a blank worksheet when you add a 
new worksheet to a workbook. 
Dependents 
Cells that contain formulas that refer to other cells. For example, if cell D10 contains 
the formula =B5, cell D10 is a dependent of cell B5. 
Destination Area 
The range of cells that you select to hold the summarized data in a consolidation. 
The destination area can be on the same worksheet as the source data or on a 
different worksheet. A worksheet can contain only one consolidation. 
Detail Data 
For automatic subtotals and worksheet outlines, the subtotal rows or columns that 
are totalled by summary data. Detail data is typically adjacent to and either above or 
to the left of the summary data. 
Drop Lines 
In line and area charts, lines that extend from a data point to the category (x) axis. 
Useful in area charts to clarify where one data marker ends and the next begins. 
Drop-Down List Box 
A control on a menu, toolbar, or dialogue box that displays a list of options when you 
click the small arrow next to the list box. 
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Embedded Chart 
A chart that is placed on a worksheet rather than on a separate chart sheet. 
Embedded charts are beneficial when you want to view or print a chart or a 
PivotChart report with its source data or other information in a worksheet. 
Error Bars 
Usually used in statistical or scientific data. Error bars show potential error or degree 
of uncertainty relative to each data marker in a series. 
Excel add-in 
Components that can be installed on your computer to add commands and functions 
to Excel. These add-in programs are specific to Excel. Other add-in programs that 
are available for Excel or Office are Component Object Model (COM) add-ins. 
Excel table 
Formerly known as an Excel list, you can create, format, and expand an Excel table 
to organize the data on your worksheet. 
Expression 
A combination of operators, field names, functions, literals, and constants that 
evaluates to a single value. Expressions can specify criteria (such as Order 
Amount>10000) or perform calculations on field values (such as Price*Quantity). 
External Data 
Data that is stored in a database, such as Access, dBASE, or SQL Server, that is 
separate from Query and the program from which you start Query. 
External Data 
Data that is stored outside of Excel. Examples include databases created in Access, 
dBASE, SQL Server, or on a Youb server. 
External Data Range 
A range of data that is brought into a worksheet but that originates outside of Excel, 
such as in a database or text file. In Excel, you can format the data or use it in 
calculations as you would in any other data. 
External Reference 
A reference to a cell or range on a sheet in another Excel workbook, or a reference to 
a defined name in another workbook. 
Field (database) 
A category of information, such as last name or order amount, that is stored in a 
table. When Query displays a result set in its Data pane, a field is represented as a 
column. 
Field (pivot table report) 
In a PivotTable or PivotChart report, a category of data that's derived from a field in 
the source data. PivotTable reports have row, column, page, and data fields. 
PivotChart reports have series, category, page, and data fields. 
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Fill Handle 
The small black square in the lower-right corner of the selection. When you point to 
the fill handle, the pointer changes to a black cross. 
Filter 
To display only the rows in a list that satisfy the conditions you specify. You use the 
AutoFilter command to display rows that match one or more specific values, 
calculated values, or conditions. 
Font 
A graphic design applied to all numerals, symbols, and alphabetic characters. Also 
called type or typeface. Arial and Courier New are examples of fonts. Fonts usually 
come in different sizes, such as 10 point, and various styles, such as bold. 
Formula 
A sequence of values, cell references, names, functions, or operators in a cell that 
together produce a new value. A formula always begins with an equal sign (=). 
Formula Bar 
A bar at the top of the Excel window that you use to enter or edit values or formulas 
in cells or charts. Displays the constant value or formula stored in the active cell. 
Formula Palette 
A tool that helps you create or edit a formula and also provides information about 
functions and their arguments. 
Function (Microsoft Query) 
An expression that returns a value based on the results of a calculation. Query 
assumes that data sources support the Avg, Count, Max, Min, and Sum functions. 
Some data sources may not support all of these, or may support additional functions. 
Function (Office Excel) 
A prewritten formula that takes a value or values, performs an operation, and returns 
a value or values. Use functions to simplify and shorten formulas on a worksheet, 
especially those that perform lengthy or complex calculations. 
Goal Seek 
A method to find a specific value for a cell by adjusting the value of one other cell. 
When goal seeking, Excel varies the value in a cell that you specify until a formula 
that's dependent on that cell returns the result you want. 
Grid 
A set of intersecting lines used to align objects. 
Gridlines in Charts 
Lines you can add to a chart that make it easier to view and evaluate data. Gridlines 
extend from the tick marks on an axis across the plot area. 
Group 
In an outline or PivotTable report, one or more detail rows or columns that are 
adjacent and subordinate to a summary row or column. 
High-Low Lines 
In 2-D line charts, lines that extend from the highest to the Lowest value in each 
category. High-low lines are often used in stock charts. 
History worksheet 
A separate worksheet that lists changes being tracked in a shared workbook, 
including the name of the person who made the change, when and where it was 
made, what data was deleted or replaced, and how conflicts were resolved. 
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Identifier 
A field name used in an expression. For example, Order Amount is the identifier (field 
name) for a field that contains order amounts. You can use an expression (such as 
Price*Quantity) in place of an identifier. 
Implicit Intersection 
A reference to a range of cells, instead of a single cell, that is calculated like a single 
cell. If cell C10 contains the formula =B5:B15*5, Excel multiplies the value in cell B10 
by 5 because cells B10 and C10 are in the same row. 
Index 
A database component that speeds up searching for data. When a table has an 
index, data in the table can be found by looking it up in the index. 
Inner Join 
In Query, default type of join between two tables where only the records that have 
the same values in the joined fields are selected. The two matching records from 
each table are combined and displayed as one record in the result set. 
Input Cell 
The cell in which each input value from a data table is substituted. Any cell on a 
worksheet can be the input cell. Although the input cell does not need to be part of 
the data table, the formulas in data tables must refer to the input cell. 
Insert Row 
In an Excel table, a special row that facilitates data entry. The Insert row is indicated 
by an asterisk. 
Internet Explorer 
A Youb browser that interprets HTML files, formats them into Youb pages, and 
displays them to the user. You can download Internet Explorer from the Microsoft 
Youb site at http://www.microsoft.com. 
Item 
A subcategory of a field in PivotTable and PivotChart reports. For instance, the field 
"Month" could have items such as "January," "February," and so on. 
Iteration 
Repeated calculation of a worksheet until a specific numeric condition is met. 
Join 
A connection between multiple tables where records from related fields that match 
are combined and shown as one record. Records that don't match may be included 
or excluded, depending on the type of join. 
Join Line 
In Query, a line that connects fields between two tables and shows Query how the 
data is related. The type of join indicates which records are selected for the query's 
result set. 
Join line 
In Query, a line that connects fields between two tables and shows how the data is 
related. The type of join indicates which records are selected for the query's result 
set. 
Justify 
To adjust horizontal spacing so that text is aligned evenly along both the left and right 
margins. Justifying text creates a smooth edge on both sides. 
 

http://www.microsoft.com/
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Legend 
A box that identifies the patterns or colours that are assigned to the data series or 
categories in a chart. 
Legend Keys 
Symbols in legends that show the patterns and colours assigned to the data series 
(or categories) in a chart. Legend keys appear to the left of legend entries. 
Formatting a legend key also formats the data marker that's associated with it. 
Locked Field or Record 
The condition of a record, field, or other object in a database that permits it to be 
viewed but not changed (read-only) in Query. 
Mapped Range 
A range in an XML list that has been linked to an element in an XML map. 
Matrix 
A rectangular array of values or a range of cells that is combined with other arrays or 
ranges to produce multiple sums or products. Excel has predefined matrix functions 
that can produce the sums or products. 
Merged Cell 
A single cell that is created by combining two or more selected cells. The cell 
reference for a merged cell is the upper-left cell in the original selected range. 
Microsoft Excel control 
A native Excel control other than an ActiveX control. 
Microsoft Visual Basic Help 
To get help for Visual Basic in Excel, on the Developer tab, in the Code group, click 
Visual Basic, and then under the Help menu, click Microsoft Visual Basic Help. 
Moving Average 
A sequence of averages computed from parts of a data series. In a chart, a moving 
average smooth the fluctuations in data, thus showing the pattern or trend more 
clearly. 
Moving Border 
An animated border that appears around a worksheet range that has been cut or 
copied. To cancel a moving border, press ESC. 
Multiple-Level Category Labels 
Category labels in a chart that, based on worksheet data, are automatically displayed 
on more than one line in a hierarchy. For example, the heading Produce might 
appear above a row with headings Tofu, Apples, and Pears. 
Name 
A word or string of characters that represents a cell, range of cells, formula, or 
constant value. Use easy-to-understand names, such as Products, to refer to hard to 
understand ranges, such as Sales!C20:C30. 
Name box 
Box at left end of the formula bar that identifies the selected cell, chart item, or 
drawing object. To name a cell or range, type the name in the Name box and press 
ENTER. To move to and select a named cell, click its name in the Name box. 
Non-adjacent selection 
A selection of two or more cells or ranges that don't touch each other. When plotting 
non-adjacent selections in a chart, make sure that the combined selections form a 
rectangular shape. 
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Non-OLAP source data 
Underlying data for a PivotTable or PivotChart report that comes from a source other 
than an OLAP database. These sources include relational databases, tables on 
Excel worksheets, and text file databases. 
ObjectLink 
An OLE data format that describes a linked object, identifying the class, document 
name, and name of an object. Each of these data items is a null-terminated string. 
Offline Cube File 
A file you create on your hard disk or a network share to store OLAP source data for 
a PivotTable or PivotChart report. Offline cube files allow you to keep working when 
you are not connected to the OLAP server. 
OLAP 
A database technology that has been optimized for querying and reporting, instead of 
processing transactions. OLAP data is organized hierarchically and stored in cubes 
instead of tables. 
OLAP provider 
A set of software that provides access to a particular type of OLAP database. This 
software can include a data source driver and other client software that is necessary 
to connect to a database. 
Operand 
Items on either side of an operator in a formula. In Excel, operands can be values, 
cell references, names, labels, and functions. 
Operator 
A sign or symbol that specifies the type of calculation to perform within an 
expression. There are mathematical, comparison, logical, and reference operators. 
Outer join 
In Query, a join where all records from one table are selected, even if there are no 
matching records in another table. Records that match are combined and shown as 
one. Records that don't have matches in the other table are shown empty. 
Outer Join 
Join in which all records from one table are selected, even if there are no matching 
records in another table. Records that match are combined and shown as one. 
Records that don't have matches in the other table are shown as empty. 
Outline 
Worksheet data in which rows or columns of detail data are grouped so that you can 
create summary reports. The outline can summarize either an entire worksheet or a 
selected portion of it. 
Outline Data 
The data that is contained within a worksheet outline. Outline data includes both the 
summary and detail rows or columns of an outline. 
Outline Symbols 
Symbols that you use to change the view of an outlined worksheet. You can show or 
hide detailed data by pressing the plus sign, minus sign, and the numbers 1, 2, 3, or 
4, indicating the outline level. 
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OwnerLink 
An OLE data format that describes an embedded object, identifying the class, 
document name, and name of an object. Each of these data items is a null-
terminated string. 
Page Break 
Divider that breaks a worksheet into separate pages for printing. Excel inserts 
automatic page breaks based on the paper size, margin settings, scaling options, 
and the positions of any manual page breaks that you insert. 
Page Break Preview 
Worksheet view that displays the areas to be printed and the locations of page 
breaks. The area to be printed is displayed in white, automatic page breaks appear 
as dashed lines, and manual page breaks appear as solid lines. 
Parameter 
In Excel, you can add, change, or remove parameters to specify cells that are 
editable in the viewable worksheet data of Excel Services. When you save the 
workbook, the changes are automatically reflected on the server. 
Parameter Query 
A type of query that, when you run it, prompts for values (criteria) to use to select the 
records for the result set so that the same query can be used to retrieve different 
result sets. 
Password 
A way to protect your worksheet or workbook. When you protect worksheet or 
workbook elements with a password, it is very important that you remember that 
password. Without it, there is no way to unprotect the workbook or worksheet. You 
should always use strong passwords that combine uppercase and lowercase letters, 
numbers, and symbols. Youak passwords don't mix these elements. Strong 
password: Y6dh!et5. Youak password: House27. Use a strong password that you 
can remember so that you don't have to write it down. 
Paste Area 
The target destination for data that's been cut or copied by using the Office 
Clipboard. 
Pivot Area 
The worksheet area into which you drag PivotTable or PivotChart fields to change 
the layout of the report. On a new report, dashed blue outlines indicate the pivot area 
on the worksheet. 
PivotChart category field 
A field that is assigned a category orientation in a PivotChart report. In a chart, 
categories usually appear on the x-axis, or horizontal axis, of the chart. 
PivotChart report 
A chart that provides interactive analysis of data, like a PivotTable report. You can 
change views of data, see different levels of detail, or reorganize the chart layout by 
dragging fields and by showing or hiding items in fields. 
PivotChart Series Field 
A field that is assigned a series orientation in a PivotChart report. In a chart, series 
are represented in the legend. 
PivotTable Data 
In a PivotTable report, the summarized data that's calculated from the data fields of a 
source list or table. 
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PivotTable grand totals 
Total values for all cells in a row or all cells in a column of a PivotTable report. Values 
in a grand total row or column are calculated by using the same summary function 
used in the data area of the PivotTable report. 
PivotTable list 
A Microsoft Office Youb Component that allows you to create a structure similar to an 
Excel PivotTable report. Users can view the PivotTable list in a Youb browser and 
change its layout in a manner similar to an Excel PivotTable report. 
PivotTable report 
An interactive, cross-tabulated Excel report that summarizes and analyses data, such 
as database records, from various sources, including ones that are external to Excel. 
PivotTable report 
An interactive, cross-tabulated Excel report that summarizes and analyses data, such 
as database records, from various sources including ones external to Excel. 
PivotTable subtotal 
A row or column that uses a summary function to display the total of detail items in a 
PivotTable field. 
Plot Area 
In a 2-D chart, the area bounded by the axes, including all data series. In a 3-D chart, 
the area bounded by the axes, including the data series, category names, tick-mark 
labels, and axis titles. 
Point 
A unit of measurement equal to 1/72 of an inch. 
Precedents 
Cells that are referred to by a formula in another cell. For example, if cell D10 
contains the formula =B5, cell B5 is a precedent to cell D10. 
Primary Key 
One or more fields that uniquely identify each record in a table. In the same way that 
a license plate number identifies a car, the primary key uniquely identifies a record. 
Print Area 
One or more ranges of cells that you designate to print when you don't want to print 
the entire worksheet. If a worksheet includes a print area, only the print area is 
printed. 
Print Titles 
Row or column labels that are printed at the top of or on the left side of every page 
on a printed worksheet. 
Property Fields 
Independent attributes associated with items, or members, in an OLAP cube. For 
example, if city items have size and population properties stored in the server cube, a 
PivotTable report can display the size and population of each city. 
Protect 
To make settings for a worksheet or workbook that prevent users from viewing or 
gaining access to the specified worksheet or workbook elements. 
Report Filter 
A field that's used to filter a subset of data in a PivotTable or PivotChart report into 
one page for further layout and analysis. You can either display a summary of all 
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items in a report filter, or display one item at a time, which filters out the data for all 
other items. 
Query 
In Query or Access, a means of finding the records that Answer a particular question 
you ask about the data stored in a database. 
Query Channel 
You use a query channel in a DDE conversation between the destination application 
and a specific query (for example, Query1) in Query. To use a query channel, you 
must have already opened the query window using a system channel. 
Query Design 
All elements included in the Query window, such as tables, criteria, the order in which 
fields are arranged, and so on. The design also specifies whether Auto Query is 
turned on, and whether you can edit the source data. 
Range 
Two or more cells on a sheet. The cells in a range can be adjacent or non-adjacent. 
Read-only 
A setting that allows a file to be read or copied but not changed or saved. 
Record 
A collection of information about a particular person, place, event, or thing. When 
Query displays a result set in the Data pane, a record is represented as a row. 
Refresh (External Data Range) 
To update data from an external data source. Each time you refresh data, you see 
the most recent version of the information in the database, including any changes 
that were made to the data. 
Refresh (pivot table report) 
To update the contents of a PivotTable or PivotChart report to reflect changes to the 
underlying source data. If the report is based on external data, refreshing runs the 
underlying query to retrieve new or changed data. 
Regression Analysis 
A form of statistical analysis used for forecasting. Regression analysis estimates the 
relationship between variables so that a given variable can be predicted from one or 
more other variables. 
Relative Reference 
In a formula, the address of a cell based on the relative position of the cell that 
contains the formula and the cell referred to. If you copy the formula, the reference 
automatically adjusts. A relative reference takes the form A1. 
Remote Reference 
A reference to data stored in a document from another program. 
Report Template 
An Excel template (.xlt file) that includes one or more queries or PivotTable reports 
that are based on external data. When you save a report template, Excel saves the 
query definition but doesn't store the queried data in the template. 
Result Set 
The set of records returned when you run a query. You can see the result set of a 
query in Query, or you can return a result set to an Excel worksheet for further 
analysis. 
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Row Heading 
The numbered gray area to the left of each row. Click the row heading to select an 
entire row. To increase or decrease the height of a row, drag the line below the row 
heading. 
Row Label 
A field that's assigned a row orientation in a PivotTable report.  
R-squared value 
A number from 0 to 1 that reveals how closely the estimated values for the trendline 
correspond to your actual data. A trendline is most reliable when its R-squared value 
is at or near 1. Also known as the coefficient of determination. 
Scenario 
A named set of input values that you can substitute in a worksheet model. 
Scroll Lock 
With scroll lock turned on, the arrow keys scroll the active sheet rather than make a 
different cell active. To turn scroll lock off or on, press the SCROLL LOCK key. 
Section 
Any combination of a worksheet, view, and scenario that you choose when you 
create a report. A report can contain several sections. 
Select 
To highlight a cell or range of cells on a worksheet. The selected cells will be affected 
by the next command or action. 
Select All button 
The gray rectangle in the upper-left corner of a datasheet where the row and column 
headings meet. Click this button to select all cells on a datasheet. 
Series Axis 
A chart axis that represents the depth dimension in a true 3-D chart. It displays the 
series names as arbitrary text values; it cannot display scaled numerical values. 
Series Field 
A field that's displayed in the series area of a PivotChart report. Items in a series field 
are listed in the legend and provide the names of the individual data series. 
Series Lines 
In 2-D stacked bar and column charts, lines that connect the data markers in each 
data series that are used to emphasize the difference in measurement between each 
series. 
Shared Workbook 
A workbook set up to allow multiple users on a network to view and make changes at 
the same time. Each user who saves the workbook sees the changes made by other 
users. 
Single-mapped cell 
A cell that has been linked to a non-repeating element in an XML map. 
Sort Order 
A way to arrange data based on value or data type. You can sort data alphabetically, 
numerically, or by date. Sort orders use an ascending (1 to 9, A to Z) or descending 
(9 to 1, Z to A) order. 
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Source Areas 
The cell ranges that you consolidate in the destination area you specify. Source 
areas can be on any worksheet in a workbook, in other open or closed workbooks, or 
on Lotus 1-2-3 worksheets. 
Source Data 
The list or table that's used to create a PivotTable or PivotChart report. Source data 
can be taken from an Excel table or range, an external database or cube, or another 
PivotTable report. 
SQL 
A language used to retrieve, update, and manage data. When you create a query, 
Query uses SQL to build the corresponding SQL SELECT statement. If you know 
SQL, you can view or change the SQL SELECT statement. 
Standard Font 
The default text font for worksheets. The standard font determines the default font for 
the Normal cell style. 
Summary Data 
For automatic subtotals and worksheet outlines, all rows or columns that summarize 
detail data. Summary data usually is adjacent to and below the detail data. 
Summary Function 
A type of calculation that combines source data in a PivotTable report or a 
consolidation table, or when you are inserting automatic subtotals in a list or 
database. Examples of summary functions include Sum, Count, and Average. 
System Channel 
Used in a DDE conversation between applications to get information about the 
system, such as the current connections, open queries, and the status of the 
destination application. 
Table Pane 
The area of the Query window that displays the tables in a query. Each table displays 
the fields from which you can retrieve data. 
Template 
A workbook that you create and use as the basis for other similar workbooks. You 
can create templates for workbooks and worksheets. The default template for 
workbooks is called Book.xlt. The default template for worksheets is called Sheet.xlt. 
Text Box 
A rectangular object on a worksheet or chart, in which you can type text. 
Tick Marks and Tick-Mark Labels 
Tick marks are small lines of measurement, similar to divisions on a ruler, which 
intersect an axis. Tick-mark labels identify the categories, values, or series in the 
chart. 
Titles in Charts 
Descriptive text that is automatically aligned to an axis or centered at the top of a 
chart. 
Total Row 
A special row in an Excel table that provides a selection of aggregate functions useful 
for working with numerical data. 
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Totals 
One of the five calculation types Query defines for you: Sum, Avg, Count, Min, and 
Max. 
Tracer Arrows 
Arrows that show the relationship between the active cell and its related cells. Tracer 
arrows are blue when pointing from a cell that provides data to another cell, and red if 
a cell contains an error value, such as #DIV/0!. 
Trendline 
A graphic representation of trends in data series, such as a line sloping upward to 
represent increased sales over a period of months. Trendlines are used for the study 
of problems of prediction, also called regression analysis. 
Trendline Label 
Optional text for a trendline, including either the regression equation or the R-
squared value, or both. A trendline label can be formatted and moved; it cannot be 
sized. 
Up-Down Bars 
In line charts with multiple data series, bars that indicate the difference between data 
points in the first and last series. 
Value 
The text, date, number, or logical input that completes a condition that a field must 
meet for searching or filtering. For example, the field Author with the condition 
<b>equals</b> must include a value, such as <b>John</b>, to be complete. 
Value Axis 
A chart axis that displays scaled numerical values. 
Values Area 
The part of a PivotTable report that contains summary data. Values in each cell of 
the values area represent a summary of data from the source records or rows. 
Value Field 
A field from a source list, table, or database that contains data that is summarized in 
a PivotTable report or PivotChart report. A value field usually contains numeric data, 
such as statistics or sales amounts. 
Vertexes 
Black, square, drag gable points that appear at the ends and intersections of lines or 
curves in certain AutoShapes (such as freeforms, scribbles, and curves) when you 
edit points on the AutoShape. 
View 
A set of display and print settings that you can name and apply to a workbook. You 
can create more than one view of the same workbook without saving separate copies 
of the workbook. 
Youb query 
A query that retrieves data stored on your intranet or the Internet. 
What-if analysis 
A process of changing the values in cells to see how those changes affect the 
outcome of formulas on the worksheet. For example, varying the interest rate that is 
used in an amortization table to determine the amount of the payments. 
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Workbook 
A spreadsheet program file that you create in Excel. A workbook contains 
worksheets of rows and columns in which you can enter and calculate data. 
Worksheet 
The primary document that you use in Excel to store and work with data. Also called 
a spreadsheet. A worksheet consists of cells that are organized into columns and 
rows; a worksheet is always stored in a workbook. 
Workspace file 
A file that saves display information about open workbooks, so that you can later 
resume work with the same window sizes, print areas, screen magnification, and 
display settings. A workspace file doesn't contain the workbooks themselves. 
World Wide Youb 
A system for navigating the Internet or through a collection of workbooks and other 
Office documents connected by hyperlinks and located on a network share, a 
company intranet or the Internet. When you use a Youb browser, the Youb appears 
as a collection of text, pictures, sounds, and digital movies. 
Wrap 
In text, to break a line of text automatically on reaching a margin or object and 
continue the text on a new line. 
XML 
Extensible Markup Language (XML): A condensed form of Standard Generalized 
Markup Language (SGML) that enables developers to create customized tags that 
offer flexibility in organizing and presenting information. 


